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PREFACE 
 

 

odern advancements and developments in the field of computer have brought the world into 

new era. Computer has emerged as a powerful tool that is continuously transforming the shape 

of our working methodologies and day-to-day services. There is hardly any sphere of life left 

now, in which computers are not being used. Be it any area of operations, computer knowledge 

is must. This is the reason, why most of the education institutions have introduced computer as a subject in 

their course curriculum. Board of Technical Education (B.T.E.) UP (Lucknow) suggests study of 

Computer Applications in first year of all polytechnic branches.  

This book is specially written for first year polytechnic students of all those polytechnic institutions, 

which are affiliated to UP Board of Technical Education. It is exactly as per syllabus suggested by 

B.T.E. and takes care of all the subjects, topics and practical assignments mentioned therein. However, at 

some places, sequence of the topics has been slightly changed with the objective of explaining the topics in 

gradual manner and making the learning easy. Readers will definitely appreciate this change, when they go 

through the book. 

The language of the book is very easy and never becomes barrier in learning. We have followed American 

English pattern in this book. Some of the spellings like colour, centre etc. may appear as color, center etc. 

They are wrong as per British pattern but are correct in American pattern. We are sure that students and 

teachers will appreciate this change because software packages mentioned in the syllabus also follow the 

same language pattern.  

This book titled, "Computer Application For Engineering" comprises of 13 chapters. Each chapter 

explains the subject in detail and interesting manner. To make the explanation more meaningful, lots of 

examples and figures have been included in each chapter. This aspect has emerged as main strength of the 

book. 

At the end of each chapter, a question bank, titled "Exercises" is there. All the questions put together, cover 

all important aspects of the topic. Solving these questions correctly, on self-knowledge basis, will generate 

confidence and ensure good marks in the examination.  

After exercises, practical assignments are given for computer lab sessions. Each lab assignment includes 

step-by-step instructions for doing practical on computer. Following these instructions, students will be 

able to complete a mini project. They will learn practical aspects of computer applications and will sharpen 

their skills by completing the given assignments. 

We are sure that this book will serve as perfect teaching guide for the teachers and good reference book for 

the students.  It is expected that they will take full advantage of our knowledge and experience.  

Although enough care has been taken to make the book error free but some mistakes may have gone 

unnoticed.  Feedbacks and suggestions in this regard, on our address, will be highly appreciated. 

 

 

Rajiv Khanna   

 

M
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Introduction To Computer 

INTRODUCTION 

Computer is electronic equipment. It is mainly used for automating manual tasks. Using 

computer you can perform tasks quickly, effectively and in error free manner. Be it any 

organization, office, factory or institution, you can find people making use of computer 

there. In offices, computers are used for preparing 

letters, documents and reports. In hotels, computers 

are used for advance booking of rooms, preparing 

bills and providing enquiry services. In railways, 

computers are used for rail reservation, printing of 

tickets and preparation of reservation charts. Doctors 

use computers for diagnosing illness and treatment of 

deceases. Architects use them for map designing and 

city planning.  In meteorology department, computers 

are used for weather forecasting. In short you can say 

that there is hardly any sphere of life left now, in 

which computers are not being used. What computer 

is, what are its main units, how does it function are 

the issues, which are described in this chapter. 

BLOCK DIAGRAM OF COMPUTER 

As you know, computer is an electronic device, it 

comprises of many units. These units work in 

coordination with each other to perform the given task. 

Block diagram of computer is shown in figure 1.1. 

Refer this figure and note that computer comprises of 

following units: 

1. Input Unit 

2. Output Unit 

1 CHAPTER 

Memory

Secondary 
Storage
 Unit 

Processor

Output
  Unit

Control
Unit

ALU

(Random Access  Memory)

RAM

ROM
(Read Only Memory)

Input
Unit

    

Figure 1.1 
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3. Input/Output Unit 

4. Central Processing Unit 

 (a)  Memory Unit 

 (b)  ALU  

 (c)  Control Unit 

Physically these units exist in the form of electronic devices in computer. Each unit 

performs its own function, in co-ordination with other devices and thus computer performs 

the given task. What is the role of each unit and in what form do they physically exist, is 

explained below. 

INPUT UNITS 

The role of input unit in computer is to provide means for supplying data or instructions to 

the computer. In other words, you can say that what you supply to the computer for 

processing is supplied through input unit. For example, if you wish to calculate simple 

interest on Rs. 10,000, @ 7% for 5 years then the data 10,000, 7, 5% etc. and the 

instructions for calculating the simple interest will have to be given to the computer, 

through input unit. 

All those devices, using which input is provided to the computer are termed as input units. 

Following are few commonly used input units that can 

be found attached with almost every computer. 

Keyboard 

Keyboard consists of many keys. Keys have alphabets, 

numbers, characters or words written on them. 

Keyboard is illustrated in figure 1.2. 

When keyboard is connected to the computer, a 

blinking sign (| or −) appears on the monitor. This sign 

is called cursor. When you press an alphabet or number 

key, the character written on the key gets typed at 

current cursor position and the cursor moves forward. 

Keys  

Keys of the keyboard are broadly classified into following categories: 

� Alphabet keys 

� Number keys 

� Special character keys 

� Function keys  

� Cursor keys 

� Action keys 

 
Figure 1.2 
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Alphabet Keys 

Alphabet keys have alphabets, from A to Z, written on them. By pressing these keys, you can 

type alphabets, words, sentences etc. in lower case. For example, when you press 'A' key, 'a' 

gets typed. To type the alphabet in upper case, you need to press Shift key along with the 

alphabet key. For example, if you press 'A' key along with Shift key, letter 'A' gets typed. 

Number Keys 

Number keys have digits, from 0 to 9, written on them. These keys are used for typing the 

numbers. Note that each number key also has a special character written just above the 

number. To type this character, you will have to press the number key along with the Shift 

key. For example, number 5 key has % sign marked on it. When you press number 5 key, 5 

will get typed. If you pres the same key, along with Shift key % sign will get typed. 

Special Character Keys 

Few keys of the keyboard have special characters like semicolon (;), comma (,), dot (.) etc. 

marked on them. Such keys are called special character keys. When you press special 

character key, character marked on it gets typed at current cursor position. 

Function Keys 
There are 12 function keys present on the keyboard. They are named as F1, F2, F3 …..F12. 

When you press these keys they perform special functions. 

Cursor Keys 

Four cursor keys are there on the keyboard. They are marked with arrows on them, pointing 

in four different directions. Using cursor keys, you can move the cursor from one place to 

another.   

Action Keys 

Keyboard has many action keys. When you press an action key, a special event takes place. 

Most commonly used action keys of the keyboard are described below.  

Caps Lock Key  

When you press this key, capital lock becomes on. When you press an alphabet key, while 

capital lock is on, the letter written on it gets typed in upper case. 

Shift Key  

Shift key is always pressed along with other keys. When you press this key along with 

number key then the symbol written on upper part of the key gets typed. When you press 

Shift key along with alphabet key then the alphabet gets typed in upper case.  

Enter Key   

Enter key is used to start a new line. When you press this key; cursor comes to the next 

line. Whatever you type now, gets typed in the next line. 
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Space Bar   

This key is used to put blank spaces between the two characters.  

DEL Key  

This key is used to rub a character from current cursor position.  

Backspace Key   

This key removes one character from the left side of the cursor.  

Insert Key   

This key is used to insert characters in between the two characters, which have already 

been typed. 

Page Keys 

There are two page keys on the keyboard, named as PgDn (i.e. Page Down) and PgUp (i.e.  

Page Up).  When you press PgUp key, previous page gets displayed on the screen. When 

you press PgDn key, next page gets displayed on the screen. 

Tab Key   

This key is used for making the cursor jump in forward direction, by many places.  

ESC Key   
This key is called Escape key. Currently on-going activity gets cancelled when this key is 

pressed.  

Mouse 

Mouse is an input device.  It is shown in figure 1.3. It looks like a real mouse with few 

buttons placed on its back. When mouse is connected to the computer, an arrow sign 

appears on the monitor screen. This sign is called Mouse Pointer. 

                 
Figure 1.3 

When you move the mouse on plane surface, mouse pointer also moves in the same 

direction. Thus by moving the mouse, you can make the mouse pointer point to anything 

present on the screen. After pointing the mouse on any desired object, following actions 

can be performed: 

Mouse Pointer
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Clicking The Mouse 

Pressing the left button of the mouse and releasing it is called clicking the mouse.  

Double Clicking The Mouse 

Pressing the left button of the mouse twice, in quick succession, is called double clicking 

the mouse.  

Dragging The Mouse 

Moving the mouse, with its left button pressed is called dragging the mouse. 

Dropping 

Moving the finger away from the mouse after dragging it is called dropping.  

CD-ROM Drive 

CD is acronym for Compact Disk. It works as a medium for storing data or instructions. It 

looks like circular plastic disk. Huge amount of data can be stored on CD. For example, 

single CD can hold personal data of all the students studying in a college. 

CD-ROM drive is an input unit that reads data from CD. As the name indicates, CD-ROM 

(Compact Disk Read Only Memory) can only read the data from CD, it cannot write on it. 

CD and CD-ROM drive are shown in figure 1.4. 

 

 
Figure 1.4.  

OUTPUT UNIT 

The role of output unit is to show the result of processing. In other 

words, you can say that computer displays all the results on its 

output unit. For example, if you are calculating simple interest on 

computer, it will display the interest amount on its output unit. 

Following are few commonly used output units of computer.  

VDU 

VDU is acronym for Visual Display Unit. It looks like portable 

TV. VDU is illustrated in figure 1.5. It is primarily used for 

following two purposes: Figure 1.5 



 

 

6    Computer Application For Engineering 

� To display the contents that are being typed through keyboard. 

� To display the result of processing (output). 

Printer 

Printer is an output device. It prints the output on paper. Different types of printers print 

differently. Their quality and speed of printing differ from each other. Following are 

different types of printers, which are being commonly used these days: 

1. Dot Matrix Printer 

2. Inkjet Printer 

3. Laser Printer 

Dot Matrix Printers  

These printers are very versatile printers and drive their name "Dot Matrix" from the fact 

that they print the characters making dots. Pins of the printer print these dots so close to 

each other that the gap between them is hardly visible. Viewer gets an impression of full 

continuity. These printers are versatile printers and are capable of printing not only text, 

but up to some extent graphics also. They are relatively fast printers and their speed varies 

from 300 Character Per Second (CPS) to 600 CPS. 

Inkjet Printers   

For printing the characters and drawings, inkjet printers make use of colored inks. They use 

Cyan, Magenta, Yellow and Black inks. Using these four basic colors, inkjet printers generate 

all other colors. These printers are very popular due to their high quality and low cost.  

Laser Printers 

These are high quality, high speed and high cost printers. In such type of printers, printing 

is done, using laser beam and black magnetic powder, called Toner. Speed of these printers 

can range from 10 pages per minute to about 200 pages per minute. They cost much higher 

than dot matrix and inkjet printers. All the three types of printer are shown in figure 1.6. 

          
      Dot Matrix Printer     Inkjet Printer       Laser Printer 

Figure 1.6 

INPUT/OUTPUT UNITS 

As you know, input units provide means for supplying data or instructions to the computer, 

while output units provide mechanism for displaying the results. While making use of them 
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data, instructions or results involved in this process do not get retained permanently in 

computer. They get erased when computer is switched off. If you need them again, process 

has to be repeated. On contrary to this, Input/Output units serve the purpose of both i.e. 

input unit and output unit as well. They retain the data/result permanently. Whenever 

required, the data, instructions or results can be written on them. Later, as and when 

required, they can be read from there. 

All such units, which provide means for storing the data, instructions or results 

permanently, are called input/output units. Following types of Input/Output units are 

commonly used in computer. 

Floppy Drive 

Floppy drive is an Input/Output unit. It is basically an assembly, in which you put the 

floppy, close its door and then perform read / write operations on the floppy. For analogy, 

you can think of tape recorder’s cassette housing assembly, in which you put the cassette, 

close the door and then perform read / write operations on the cassette. Similarly you either 

write the data on the floppy or read the data from the floppy. Whatever you write on 

floppy, it gets permanently stored there, until you delete it yourself or mishandle the 

floppy. Floppy and floppy drive are shown in figure 1.7. 

                                

        Floppy                          Floppy Drive  

           (a)                                    (b) 

Figure 1.7  

Floppy is basically a data storage medium, on which you record the data or programs to 

read them later. Floppy consists of flexible plastic coated with magnetic material iron 

oxide. This plastic is enclosed in a thick black gasket cover, which protects it from heat, 

dust, sun etc. Most commonly used floppies are of 3 ½" size. 

Hard Disk 

Hard disk is another unit, which stores the data permanently in computer.  Externally it 

looks like a box and remains fixed within computer chassis. Its internal composition is 

shown in figure 1.8.  

Refer this figure and note that hard disk consists of multiple dish like units, on which the 

data is stored. These dishes are called platters. Each platter has a corresponding read-write 

head.  
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Read-write heads write the data or instructions on the platters. Thus they get permanently 

stored there.  

Note that floppy and hard disk both are 

used for storing data but the capacity of 

the hard disk is generally many times 

more than that of a floppy. Floppy is a 

removable storage medium while hard 

disk is a fixed medium.   

CD-Writer 

CD writer is another Input/Output 

device, which stores data, instructions, 

results etc. permanently on medium 

called CD-R and CD-R/W. 

CD-R 

CD-R is acronym for Compact- Disk 

Readable. It resembles CD, on which data can be written. Data is written on CD-R through a 

device called CD Writer. CD-R looks like CD but its internal composition remains different. But 

note that data can only be written once on CD-R but not again and again. 

CD-R/W 

CD-R/W is acronym for Compact Disk Re-Writeable. It looks similar to CD-R but data can 

be written multiple times on it. If you wish, you could write data on it, read data from it 

and erase the data as many times as required. CD-Writer and CD-R are shown in figure 1.9. 

           

                               CD-R          CD-R/W         CD-Writer   

Figure 1.9 

Magnetic Tape Drive 

Magnetic tape drive is another input/output unit, which is used for storing the data 

permanently. It accesses the data sequentially. Using this unit, data is recorded on magnetic 

tapes. Magnetic tape drive in its appearance looks like older spool based tape records. Its 

block diagram is illustrated in figure 1.10. 

In magnetic tape drive, magnetic tape from feeder spool passes below the Read/Write head 

and remains tied in other spool. 

 
Figure 1.8 
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When magnetic tape drive is switched on and instructions for writing the data are given, the 

spool on the right hand side rotates. Thus the tape moves forward. Read/Write head records 

the data on moving tape. 

To record the data properly on tape, it is necessary that 

magnetic tape should always remain in stretched 

position. While the spools move or stop, tape should not 

get loose. If it so happens, data will not get recorded 

properly and will produce garbage, when read. Generally 

two techniques are used to keep the tape stretched. They 

are as follows: 

1. Tension arm 

2. Vacuum column. 

In tension arm technique, tape is kept stretched, with the help of mechanical arms while in 

vacuum column technique tape is kept stretched by creating vacuum. Those tape drives, 

which use tension arm technique, are called tension arm tape drives. Those tape drives, 

which use vacuum technique, are called vacuum column tape drives. 

Magnetic Tape 

Magnetic tape is a medium to record the data.  Generally it is 12.5 mm. to 25 mm wide and 

500 meters to 1200 meters in length. It is made of magnetic material coated plastic. When 

the tape passes below read/write head, it creates magnetic waves and writes data on the 

tape. Note that data does not get continuously written on the tape. It gets recorded in 

blocks. There remains a gap (blank space) between the two blocks. This block is called 

Inter Block Gap or IBG in short. The way data gets stored on the tape, is illustrated in 

figure 1.11. 

 
 

Figure 1.11 

Magnetic Cartridge Tape Drive 

Like magnetic tape drive, magnetic cartridge tape drive is also 

an Input/Output unit, which records the data on tape. Cartridge 

tape drives are much smaller in size than magnetic tape drives. 

They do not store the data on spool tapes. They store it on 

cartridge tapes. Cartridge tape resembles small video tape that 

is used in handy cams. The shape of cartridge tape is shown in 

figure 1.12. 

Data Inter Block Gap (IBG) 

Read Write Head

Spool Spool  
Figure 1.10 

 

Figure 1.12 
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CENTRAL PROCESSING UNIT 

Refer figure 1.1 and note that three units viz. Memory, ALU and Control Unit put together 

are referred to as Central Processing Unit or CPU in short. Role of each unit is explained 

below. 

Memory 

Memory holds data, instruction or results temporarily. For example, when you give 

instructions to the computer to compute simple interest on Rs. 10,000, @ 7% for 3 years, 

this data and instructions come into computer from any of the input or Input/output devices 

and get stored in memory. Similarly result (simple interest in this example) also gets stored 

in memory. In other words, you can say that the unit, which holds data, instructions or 

results in it, is called memory. 

Types Of Memory 

Depending upon the nature and behavior of memory, computer memories could be 

categorized into following categories: 

1. Primary Memory 

2. Cache Memory 

Characteristic behavior of each type of memory is described below. 

Primary Memory 

That memory, which is utilized by the computer for its internal functioning, is called 

primary memory. Since it plays an important role in internal functioning of computer hence 

it is often referred to as internal memory. Primary memory is further categorized into two 

categories: 

1. Read Only Memory (ROM) 

2. Random Access Memory (RAM) 

Read Only Memory (ROM) 

This memory by its nature is quite special. Computer cannot write data in it. Using special 

devices, such as ROM programmer, instructions are written in it. Once instructions are 

written in it, it is put inside the computer. As and when required, computer reads 

instructions from it. Since data can only be read from it hence it is called Read Only 

Memory or ROM in short. ROM physically exists in the form of blank electronic chip, in 

which programs or data are written, using special devices. Those ROMs, in which data 

once written, cannot be erased by any means are called Programmable Read Only Memory 

or PROM in short. Other type of ROM, in which data is written or erased, using ultraviolet 

rays is called Erasable Programmable Read Only Memory or EPROM in short. 

Random Access Memory 

In short, Random Access Memory is called RAM. It differs from ROM in nature. It 

provides both, reading and writing facilities. As and when required, computer writes data 
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or instructions in it and reads them whenever necessary. This is the reason why they are 

also called Read/Write memory. 

Note that whatever data or instructions are given to the computer for processing, computer 

writes them in RAM. As and when required, it reads them from there and processes them to 

generate the result. Computer first writes all the results in RAM and then whenever 

necessary, it transfers them to output unit. 

The data written in Random Access Memory remains there till the time computer power is 

on. As soon as the power goes off, data written in RAM gets erased. This is the reason why 

they are also called Temporary memory. 

Cache Memory 

In cache memory reading and writing operations take place at very fast speed but it costs 

very high. When it is introduced into computer, it increases its speed and cost also. For best 

cost-performance ratio, sufficient amount of cache memory (less then the size of RAM) is 

introduced in the computer, in between the processor and Random 

Access Memory, as shown in figure 1.13. 

First time, when computer requires data/instructions/results from RAM, 

it reads them from there. But at the same time, many more of them are 

read and put in cache memory. Next time, whenever computer requires 

something from RAM, it reads it from cache memory. Since the speed 

of cache memory is faster than RAM hence reading is done in much 

shorter time. When computer doesn't get the required item in cache 

memory, it goes back to RAM and reads it from there along with many 

more items. The whole mechanism of reading and writing, in 

computers, is implemented in such a way that most of the time required 

items are found in cache memory. On the other hand, if computer has to 

write the data in RAM, it writes it in cache memory, from where it is 

transferred to RAM. 

Thus cache memory improves the speed of computer. In short, it can be said that the 

memory, which is introduced in the computer with objective of increasing its speed, is 

called cache memory. 

ALU 

ALU is acronym for Arithmetic and Logic Unit. It performs arithmetic and logical 

calculations in computer. Recall that calculations like, addition, subtraction, multiplication 

division etc. fall into the category of arithmetic calculations. Operations like a>b, c>=d etc. 

are logical operations. In computer terminology, the activity of performing arithmetic and 

logical calculations is called processing. In other words it can be said that in computer 

ALU performs data processing. 

Control Unit 

While computer functions, data moves from one unit to another unit. For example, when 

you give input to computer, data and instructions move from input unit to memory. When 

Main Memory

Cache 
Memory

Processer

 
Figure 1.13. 
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data is processed, it moves from memory to ALU. Similarly when processing is over, 

results move from ALU to memory and memory to output unit. Now the question is which 

part of computer organizes data movement within the computer? Well, Control Unit is the 

main unit, which performs traffic police like task. It ensures movement of right data from 

right source, to right destination at right time so that all the units of computer perform their 

functions in coordination with each other. 

TYPES OF COMPUTERS  

Computers can be classified into various categories, on the basis of their sizes. When we 

say, size of the computer, it refers to multiple factors like, size of the memory, number of 

terminals that can be connected to the computer, size of the hard disk, type of processor 

used in the computer etc. Computers are generally classified into following categories:   

1.  Microcomputers 

2.  Minicomputers 

3.  Mainframe computers 

4.  Supercomputers 

Micro Computers 

Microcomputer is the smallest category of computers, in which single microchip is used for 

two basic units i.e. ALU and Control Unit. This microchip is often referred to as 

microprocessor. Microcomputers are further classified into following categories: 

1. Personal computers 

2. Laptop computers 

Personal Computers (PC) 

Computers that we commonly see these days in offices, hotels, restaurants etc. are 

examples of Personal Computer. In short they are 

called PC. Outward appearance of PC is shown in 

figure 1.14.  

PC mainly comprise of four units i.e. chassis (also 

called CPU box), keyboard, VDU and mouse. Only 

one person can work on it at a time. This is the 

reason why PCs are called single user computers.  

Originally PCs were designed and manufactured by 

IBM. Later, as they became popular, other 

manufacturers also started manufacturing similar type 

of computers called IBM clones.  

Laptop Computers 

Laptop computers also fall into the category of microcomputers. Their capabilities are same 

as that of a PC.  A laptop computer is shown in figure 1.15. 

 

Figure 1.14 
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Laptop computers look like a briefcase. Upper panel of the 

briefcase comprises of LCD screen. Lower panel contains 

keyboard and mouse arrangement. Other components and circuitry 

remains packed inside the briefcase.   

Laptop computers are deliberately designed to be light in weight. 

They run on chargeable battery, which resides inside. Due to their 

size, weight and independence from power (for two to three 

hours) people carry them while traveling in car, train or aeroplane 

and work on them.   

Minicomputers 

Minicomputers are relatively larger and faster computers. They support multi user 

environment. They are generally used for automating those applications, which are large in 

size, require fast processing capabilities and demand for resource sharing among multiple 

users. Main characteristics of Minicomputers are described below:  

1.  They are built, using high performance and high capability processors. 

2. Memory size, in such type of computers is generally very large.  

3.  They support multiple terminals connectivity, which may range from 2 to 128. 

4. Large capacity disks are used in multiple numbers so that the data and programs of     

all the users could be put on-line. 

5. They provide facility to connect multiple printers. 

6. They possess the capability of performing computer network related operations.   

Mainframes 

Mainframes fall into next higher category of computers. Their internal architecture and 

circuitry remains different from Minicomputers. They use specially designed proprietary 

circuits instead of just single microprocessor as their CPU. Their circuitry promotes higher 

connectivity, faster throughputs and large data processing capabilities.  

Due to proprietary circuitry, Mainframes become quite 

big in size and provide facility for connecting 

Minicomputers and microcomputers with them. Few 

characteristics of Mainframes are listed below:  

1. They possess the capability of addressing larger 

memory sizes than that of Minicomputers.  

2. They also support larger capacity disks like 

optical disks etc.  

3. Their terminal connectivity can go as high as 

256 or beyond. 

4. They possess large number of application libraries that provide great help to 

developers in developing useful applications. 

 
Figure 1.15 

Figure1.17 
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DEC 20, IBM 370 etc. are the examples of few mainframes. IBM (USA) is the largest 

manufacturer of Mainframes. 

Supercomputers 

Supercomputer is the largest category of computers. They use multiple CPUs for processing 

the data and executing the instructions. While performing a task through Supercomputer, the 

complete task gets divided into multiple independent 

tasks. Each CPU performs individual task and completes 

it in parallel. This methodology of processing is called 

parallel processing. 

Due to parallel processing, Supercomputers are capable 

of processing large volumes of data at very fast speed.  

They process multi million to few trillion commands 

per second. Applications like weather forecasting, 

nuclear weapon design, projection system modeling, 

aero modeling etc. which require tremendous 

processing capabilities, can be very well executed on 

Supercomputers. CRAY, XMP 24 and NEC 500 are 

few examples of Supercomputer. 

FEW IMPORTANT DEFINITIONS  

You are now familiar with computer, its devices and its nature. Following are few 

important definitions related to computer: 

Hardware 

The physical part of computer that can be seen or touched is called hardware. For example, 

keyboard, mouse, memory, ALU etc. are examples of hardware. 

Software 

Computer hardware cannot work on its own. It requires instructions for its functioning. 

Instructions that make the computer function are called software. 

Program 

All those instructions, which are written for performing a specific task are called program. 

For example, if you write 25 instructions for accepting principle amount, rate of interest 

and the year of deposit for calculating compound interest then these 25 instructions put 

together will be called program. 

Operating System 

All those programs, which put together activate the computer so that it becomes capable of 

performing input, output and processing functions are called operating system. Without 

operating system computer neither understands the instructions given by you nor it 

performs them. MS-DOS, Windows, Linux, UNIX etc. are few popular operating systems. 

Figure1.18 
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Booting 

The process of loading the operating system in computer's memory is called booting. Only 

after booting the computer, it becomes capable of accepting the data or commands and 

processing them. 

CHARACTERISTICS OF COMPUTER 

Following are the characteristics of computer: 

1. Computers are basically dumb devices. They cannot perform any function on their 

own. For doing anything on computer, you have to give instructions to them. 

Generally these instructions are written in computer language and are given from 

the keyboard. 

2. Computer performs the tasks according to the instructions provided by the user. In 

other words, you can say that the correctness of output depends upon the 

correctness of the data and the instructions provided by the user. For example, if 

you add two numbers 70 and 30, the result could be 40 in case you have given 

wrong instruction i.e. subtraction instead of addition. 

3. The speed, with which a computer performs a task is much faster than manual 

speed. As a result of which, computers are widely used for performing those tasks, 

in which speed is of prime importance. 

4. Computer can perform a task with the same speed for several days without getting 

tired. This is not possible in case of manual activities. Human beings get tired after 

sometime and the chances of making mistakes start getting high as the time passes 

by. So you can say that computers are capable of performing error free tasks 

efficiently for the duration, which is beyond human capabilities. 

 EXERCISES                      CHAPTER 1 

 

Short Type Questions 

A.  Select most appropriate answer for following questions: 

1. Which type of device, a computer is? 

 (a)  Mechanical (b)  Electrical    (c)  Magnetic (d)  Electronic 

2. Which part of computer stores data temporarily? 

 (a)  RAM  (b)  ALU   (c)  CU  (d)  CPU 

3. Which of the following device will be used for displaying the result? 

 (a)  Keyboard  (b)  ALU   (c)  VDU (d)  Mouse 

4. Which of the following can be used for storing the data permanently? 

 (a)  RAM  (b)  Hard disk  (c)  Mouse  (d)  VDU 
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5. Which of the following is an example of software? 

 (a) Mouse  (b)  Memory (c)  Operating System  (d)  Printer  

B.  Fill in the blanks: 

6. RAM is acronym for  ……........…………. ……….......………. ………..….........……….. 

7. ROM is acronym for …………........…….. ……….......………. ………..…........………… 

8. PROM is acronym for  ………...…… ………….....................……. ……………. ………. 

9. EPROM is acronym for  …………….....................……. ………………… …………. …. 

10. ALU is acronym for ……………....................................….. ……………. ……………… 

C.  State, true or false for following statements: 

11. Keyboard is the main input unit for computers. 

12. Floppy drive is an output device. 

13. Data, instructions or results can be permanently stored on hard disk. 

14. In computer, Control Unit performs all arithmetic and logical operations. 

15. ROM programmers are the special devices that are used for writing data in Random 
Access Memory. 

D. Differentiate between the following: 

16. Input and output units of computer. 

17. RAM and ROM. 

18. Secondary memory and cache memory. 

19. Tension arm tape drive and vacuum column tape drive. 

20. PROM and EPROM. 

Detailed Answer Type Questions 

E.  Answer the following questions in detail: 

21. What is computer? For what purpose it is used? 

22. Name any three places, where computers can be used? 

23. Draw a block diagram of computer and label its component. 

24. Describe the role of keyboard and mouse in computer? What are the fundamental 
similarity and differences between them? 

25. Name any two output devices. 

26. What is the role of memory in computer? Name any two medium, which serve the 
purpose of permanent memory. 

27. What do you understand by logical operations? Which part of computer performs 
arithmetic and logical operations? 

28. Describe the term hardware and software. What is program in relation to 
computers? 

29. What is operating system? Name any two operating systems. 

30. Describe the role of control unit in computer. 

  **** 



UNIT - I 

 

 

 

 

 

Number System   

INTRODUCTION 

The number system that we use in day-to-day life is called Decimal Number System. As you 

know, it makes use of 10 fundamental digits i.e. 0, 1, 2, 3, 4, 5, 6, 7, 8 and 9.  All the numbers in 

this number system are formed by the permutation and combination of these digits. All the 

calculations that we do in this number system are done on the basis of these 10 digits only. 

Although we follow decimal number system and we use computer to do calculations for us 

but computer doesn't make use of decimal number system. Internally it makes use of 

another number system, called binary number system. What is binary number system, 

which digits are used, as fundamental digits in this number system are the topics, which 

have been described in detail in this chapter. 

INTRODUCTION TO BINARY NUMBER SYSTEM 
Binary number system is the fundamental base of computers. It makes use of two digits only i.e. 0 

and 1. All other numbers in binary number system are formed using these digits. For example, 

101 is a binary number. Now the question is how to be sure that this is a binary number, not one 

hundred one of decimal number system? Well, to avoid the confusion, generally binary numbers 

are written within the bracket and 2 is written at the base of the closing bracket. For example, 

(101)2 is definitely a binary number. There is no confusion of any type now. For more familiarity 

with binary numbers, a table illustrating few initial numbers of binary number system and their 

equivalent decimal numbers is given below. 

Binary 

Number 

Decimal 

Number 

 Binary 

Number 

Decimal 

Number 

0 0  101 5 

1 1  110 6 

10 2  111 7 

11 3  1000 8 

100 4  1001 9 

2 CHAPTER 
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Refer above illustrated table and note that it illustrates equivalent binary numbers for 

fundamental digits of decimal number system. Now the question is how other numbers of 

decimal number system are represented in binary number system? Well, the process is quite 

simple and is described below. 

Conversion Of Decimal Number Into Binary Number 

A given decimal number can be converted into equivalent binary number by following 

method: 

1. Since binary number system makes use of only two digits hence divide the decimal 

number by 2. Write the quotient below the number and remainder on the right hand 

side. 

2. Now divide the quotient by 2 and repeat above-mentioned process till the time 

quotient becomes 0. 

3. Now arrange the remainders (x1, x2, x3 …. etc.) in reverse order (…. x3, x2, x1) 

The number thus obtained will be binary equivalent of given decimal number. To 

understand the procedure of conversion, consider following examples: 

Example -1  

Convert decimal number (231)10  into equivalent binary number. 

 

2 231  

2 115 1 

2 57 1 

2 28 1 

2 14 0 

2 7 0 

2 3 1 

2 1 1 

 0 1 

 

Thus above mentioned process yields: (231)10 = (11100111)2 

Number = (11100111)2 
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Example - 2 

Convert decimal number (109)10 to equivalent binary number. 

 

2 109  

2 54 1 

2 27 0 

2 13 1 

2 6 1 

2 3 0 

2 1 1 

 0 1 

Thus above mentioned process yields: (109)10 = (1101101)2 

You are now familiar with the process of converting integer decimal numbers (those 

numbers which do not include decimal point) into equivalent binary numbers. Now the 

question is how do you convert fractional numbers (that have decimal point in them) into 

equivalent binary numbers? Well, such conversions take place in three steps. In first step, 

integer part (i.e. number towards left of the decimal point) is converted into equivalent 

binary number (using procedure mentioned above). In second step, fractional part (i.e. 

number towards right hand side of the decimal point) of the number is converted to 

equivalent decimal number. In third step both the parts are put together. Procedure for 

converting fractional part into equivalent binary number is given below. 

1. Since binary number system consists of only two digits hence multiply fractional 

decimal part by 2. When you do so, integer part obtained on the left hand side of 

the decimal number will either be 1 or 0. Whatever you get, write it separately (say 

you write x1. Here x can either be 1 or 0).  

2. Now take the resultant fractional part and multiply it by 2 again. Repeat the 

process, as many times as number of digits are required on the right hand side of 

the binary point ( thus obtaining x2, x3, x4 etc.). For example, if 4 digits are 

required on the right hand side of the binary point, repeat above-mentioned process 

4 times. 

3. Arrange the digits that were written separately in the sequence, in which they were 

obtained (e.g. x1, x2, x3, and x4). The number thus obtained (x1x2x3x4) will be 

binary equivalent of given fractional decimal number. 

To understand the process of conversion of fractional decimal numbers into equivalent 

binary numbers, let's consider following example: 

Number = (1101101)2 
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Example -3 

Convert decimal number (0.862)10 to equivalent binary number. 

  0.862 × 2 = 1.724 1 

    .724 × 2 = 1.448 1 

    .448 × 2 = 0.896 0 

    .896 × 2 = 1.792 1 

    .792 × 2 = 1.584 1 

    .584 × 2 = 1.168 1 

Thus above mentioned process yields: (0.862)10 = (0.110111)2 

Example –4 

Convert decimal number (0.235)10 to equivalent binary number. 

  0.235 × 2 = 0.47 0 

    0.47 × 2 = 0.94  0 

    0.94 × 2 = 1.88  1 

    0.88 × 2 = 1.76  1 

Thus above mentioned process yields: (0.235)10 = (0.0011)2 

Example –5 

Convert decimal number (122.486)10 to equivalent binary number. 

First Step 

In first step, integer part of the number is taken:    

 

122 

61 

30 

15 

7 

3 

1 

 2 

2 

2 

2 

2 

2 

2 

  0 

Thus (122)10 = (1111010)2 

Number = (.110 111)2 

Number = (.0011)2 

0 

1 

0 

1 

1 

1 

1 

Number = (1111010)2 
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Second Step 

In second step, fractional part of the number is taken:      

  .486 × 2 = 0.972 0 

    .972 × 2 = 1.944 1 

    .944 × 2 = 1.888 1 

    .888 × 2 = 1.776 1 

Third Step 

Joining both the parts together will result in following number: 

(122.486)10 = (1111010.0111)2 

Converting Binary Numbers into Equivalent Decimal Numbers 

Positional values for different positions in binary number are illustrated below: 

 

....... 2
5
 2

4
 2

3
 2

2
 2

1
 2

0
 . 2

-1
 2

-2
 2

-3
 2

-4
 2

-5
 ..... 

 

 

Perform following steps to convert a binary number into equivalent decimal number: 

1. Multiply each digit of the number, by its positional value. 

2. Now add all the products to get the sum. 

The sum, thus obtained will be the equivalent decimal number of given binary number. 

To understand the procedure of conversion of binary numbers into equivalent decimal 

numbers, consider following examples: 

Example -6 

Convert binary number (110111)2 into equivalent decimal number. 

(110111)2  = (1×2
5
 + 1×2

4
+ 0×2

3
+ 1×2

2
+ 1×2

1
+1×2

0
) 10  

                 = (32+16+4+2+1)10 = (55)10 

Example -7 

Convert (1100110)2  into equivalent decimal number.  

(1100110)2  = (1×2
6
 + 1×2

5
+ 0×2

4
+ 0×2

3
+ 1×2

2
+1×2

1
+0×2

0
) 10  

                   = (64+32+4+2) 10 = (102) 10 

INTRODUCTION TO OCTAL NUMBER SYSTEM 

Octal number system makes use of eight fundamental digits i.e. 0, 1, 2, 3, 4, 5, 6 and 7. All 

Binary Point 

Number = (0.0111)2 
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other numbers in octal number system are formed using these digits. For example, 154 is an 

octal number. Now the question is how to be sure that this is an octal number, not one 

hundred fifty four of decimal number system? Well, to avoid the confusion, generally octal 

numbers are written within the bracket and 8 is written at the base of right bracket. For 

example, (154)8 is definitely an octal number. There is no confusion of any type now. For 

more familiarity with octal numbers, a table illustrating few initial numbers of octal 

number system and their equivalent decimal numbers is given below. 

Octal 

Number 

Decimal 

Number 

 Octal 

Number 

Decimal 

Number 

0 0  5 5 

1 1  6 6 

2 2  7 7 

3 3  10 8 

4 4  11 9 

Now the question is, how other numbers of decimal number system are represented in octal 

number system? Well, the process is quite similar to that of binary numbers and is 

described below. 

Conversion Of Decimal Number Into Octal Number 

A given decimal number can be converted into equivalent octal number by following 

method: 

1. Since octal number system makes use of 8 digits hence divide the decimal number 

by 8. Write the quotient below the number and remainder on the right hand side. 

2. Now divide the quotient by 8 and repeat above-mentioned process till the time 

quotient becomes 0. 

3. Now arrange the remainders (y1, y2, y3 …. etc.) in reverse order (…. y3, y2, y1) 

The number thus obtained will be octal equivalent of given decimal number. To understand 

the procedure of conversion, consider the following examples: 

Example -8  

Convert decimal number 231 into equivalent octal number. 

8 231  

8 28 7 

8 3 4 

 0 3 

Thus above mentioned process yields: (231)10 = (347)8 

Number = (347)8 
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Example -9 

Convert decimal number (109)10 to equivalent octal number. 

8 109  

8 13 5 

8 1 5 

 0 1 

Thus above mentioned process yields : (109)10 = (155)8 

Converting Octal Numbers Into Equivalent Decimal Numbers 

Positional values for different positions in octal number are shown below. 

....... 8
5
 8

4
 8

3
 8

2
 8

1
 8

0
 . 8

-1
 8

-2
 8

-3
 8

-4
 8

-5
 ..... 

 

 

Perform following steps to convert an octal number into equivalent decimal number: 

1. Multiply each digit of the number, by its positional value. 

2. Now add all the products to get the sum. 

The sum, thus obtained will be the equivalent decimal number for given octal number. 

To understand the procedure of conversion of octal number into equivalent decimal 

number, consider the following example: 

Example -10 

Convert octal number into equivalent decimal number. 

(125)8  =  (1 x 82  + 2 x 81   + 5 x 80 )10      =  (64 + 16 + 5) 10  = (85) 10   

INTRODUCTION TO HEXADECIMAL NUMBER SYSTEM 

Hexadecimal Number System makes use of 16 fundamental digits i.e. 0, 1, 2, 3, 4, 5, 6, 7, 

8, 9, A, B, C, D, E and F. All other numbers in hexadecimal number system are formed 

using these digits. For example, 275 is a hexadecimal number. Now the question is how to 

be sure that this is a hexadecimal number, not two hundred seventy five of decimal number 

system? Well, to avoid the confusion, generally Hexadecimal numbers are written within 

the bracket and 16 is written at the base of right bracket. For example, (275)16 is definitely 

an octal number. Similarly (14F)16 is also a hexadecimal number. There is no confusion of 

any type now. For more familiarity with hexadecimal numbers, a table illustrating few 

initial numbers of hexadecimal number system and their equivalent decimal numbers is 

given below. 

Number = (155)8 

 Octal Point 
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Hexadecimal   

Number 

Decimal 

Number 

 Hexadecimal 

Number 

Decimal 

Number 

0 0  8 8 

1 1  9 9 

2 2  A 10 

3 3  B 11 

4 4  C 12 

5 5  D 13 

6 6  E 14 

7 7  F 15 

Refer above illustrated table and note that it illustrates equivalent hexadecimal numbers for 

decimal digits and numbers. Conversion of decimal numbers into hexadecimal numbers and 

vice versa can be done by following the procedures mentioned in octal number system, but 

making use of 16 as base number, instead of 8.   

CONVERSION OF NUMBERS OF ONE NUMBER SYSTEM INTO 

ANOTHER NUMBER SYSTEM 

You are now familiar with the process of converting decimal numbers into equivalent 

binary, octal and hexadecimal numbers. You are also familiar with their reverse processes. 

Now the question is how to convert the numbers of binary, octal or hexadecimal number 

systems into equivalent numbers of each other number systems. Well, the methods are 

described below. 

Conversion Of Octal Numbers Into Binary Numbers 

Binary equivalents of octal digits, i.e. 0, 1, 2, 3, 4, 5, 6 and 7 are given in the following 

table. This table is used for converting octal numbers into equivalent binary numbers and 

vice versa.  

Binary Octal 

000 0 

001 1 

010 2 

011 3 

100 4 

101 5 

110 6 

111 7 
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To convert any octal number into binary number, take the least significant digit from the 

given octal number and write its binary equivalent, using above-mentioned table.  Take the 

next octal digit and write its equivalent binary number on the right hand side of the 

previous binary number. Repeat the process till most significant digit of the octal number is 

reached. The number obtained in this way will be the equivalent binary number of the 

given octal number. 

For example, (56)8 is an octal number. To convert this number into binary number, get the 

binary equivalent of 6 and 5 from above mentioned table and write them in same sequence.   

By doing so,  you   will get the number (101110)2. The process is illustrated below. 

(6)8=(110)2 and (5)8 = (101)2 

Thus  (56)8 = (110101)2 

Similarly equivalent of Octal (423)8 can be derived as follows: 

(4)8 = (100)2, (2)8 = (010)2  and (3)8 = (011)2 

Thus    (423)8 = (100010011)2 

Conversion Of Binary Numbers Into Octal Numbers 

Perform following steps to convert the binary number into octal number:  

1. Take the given binary number and count total number of digits in the number. If 

they are in multiples of 3, leave the number as such else add required number of 

zeros on the left hand side to make the total number of digits in multiples of 3. For 

example, if there are 4 digits in the given binary number, put two zeros on the left, 

so that total number of digits, now, become 6.    

2. Take three binary digits from right most place of the binary number.  

3. Write their octal equivalent digit, using above mentioned table. 

4. Take next three binary digits and write their octal equivalent in the same way, but 

on the left hand side of previously written number. 

5. Repeat the process till the left most digit of the given number is reached.  

6. The number thus formed will be octal equivalent of given binary number.  

Let's convert (101100)2 to equivalent octal number to get familiar with the method. The 

process of taking three binary digits and writing their octal equivalent, can be performed as 

follow:  

(100)2=(4)8 

(101)2=(5)8 

                Thus (101100)2=(54)8 

Let's take another example. Say you have to convert (1010111)2 to equivalent octal number.  

The process of converting this number into equivalent octal number can take place as 

mentioned below: 
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(1010111)2  =  (001010111)2 

(111)2    =  (7)8 

(010)2    =  (2)8 

  ( 001)2  =  (1)8 

  Thus (1 010 111)2     =  (127)8 

Conversion Of Hexadecimal Numbers Into Binary Numbers 

Binary equivalents of 16 fundamental hexadecimal digits are given in the following table. 

This table is used for converting binary numbers into equivalent hexadecimal numbers and 

vice versa. 

Hexadecimal Binary Hexadecimal Binary 

0 0000 8 1000 

1 0001 9 1001 

2 0010 A 1010 

3 0011 B 1011 

4 0100 C 1100 

5 0101 D 1101 

6 0110 E 1110 

7 0111 F 1111 

To convert any hexadecimal number into binary number, take the least significant digit 

from the given hexadecimal number and write its binary equivalent, using above mentioned 

table.  Take the next hexadecimal digit and write its equivalent binary number on the left 

hand side of the previous binary number. Repeat the process till you reach most significant 

digit of the hexadecimal number. The number obtained in this way will be binary 

equivalent number of the given hexadecimal number. 

For example, if (A6)16 is a hexadecimal number. To convert this number into binary 

number, get the Binary equivalent of 6 and A from above mentioned table and write them 

in same sequence.   In this way,   you   will get the number (10100110)2. Similarly (BCD)16  

will be equivalent to (101111001101)2  

Conversion Of Binary Numbers Into Hexadecimal Numbers 

Perform following steps to convert a binary number into hexadecimal number:  

1. Take the given binary number and count total number of digits in the number. If 

they are in multiples of 4, leave the number as such else add required number of 

zeros on the left hand side so as to make the total number of digits in multiples of 4.  

For example if there are 7 digits in the given binary number, put one zero on the 

left, so that total number of digits, now, become 8.    
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2. Take four binary digits from right most place of the binary number.  

3. Write their Hexadecimal equivalent digit, using above mentioned table. 

4. Take next four binary digits and write their hexadecimal equivalent in the same 

way, but on the left hand side of previously written number. 

5. Repeat the process till the left most digit of the given number is reached.  

The number thus formed will be hexadecimal equivalent of given binary number. To 

understand the procedure, let's convert (101101011)2 into equivalent hexadecimal number.  

(101101011)2   =  (000101101011)2    

(1011)2   =  (B)16 

(0110)2  =  (6)16 

  (0001)2 = (1)16 

(000101101011)2   = (16B)16 

Conversion Of Octal Number Into Hexadecimal Numbers 

You are already familiar with the process of converting octal numbers into binary numbers 

and binary numbers into equivalent hexadecimal numbers. Note that binary is common in 

both the conversions. To convert an octal number into hexadecimal number you can first 

convert the octal number into binary number and then binary number into equivalent 

hexadecimal number.  

Let's convert (175)8 into equivalent hexadecimal number to get familiar with the process. 

(175)8 can be converted to equivalent Binary number as follows: 

(5)8 = (101)2 

(7)8 = (111)2 

(1)8 = (001)2 

Thus (175)8 =  (001 111 101)2 

Now  (001 111 101)2 can be converted to equivalent Hexadecimal number as follows: 

(0 0111 1101)2  = (0111 1101)2   

(1101)2   = (D)16 

(0111)2  = (7)16 

Thus (175)8   will be equivalent to (7D)16 . 

Conversion Of Hexadecimal Numbers Into Octal Numbers 

You are already familiar with the process of converting Hexadecimal numbers into Binary 

numbers and Binary numbers into Octal numbers. Note that Binary is common in both the 

conversions. To convert a Hexadecimal number into Octal number you will have to first 

convert Hexadecimal number into Binary number and then Binary number into equivalent 

Octal number.  
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To get familiar with the process, let's convert (2B)16 to equivalent octal number. 

(2B)16   =  (00101011)2 

(00101011)2 =  (101011)2 

  (011)2 = (3)8 

(101)2   = (5)8 

Thus (2B)16 will be equivalent to (53)8 

ONE'S COMPLEMENT 
In computers, one's complement is used for representing negative numbers. 

When 0's in a binary number are replaced by 1s and 1s are replaced by 0s then the resultant 

number is said to be 1's complement of the number. For example, 1's complement of 

100110 will be 011001. Similarly 01011100's one's complement will be 10100011. 

TWO'S COMPLEMENT 
Two's Complement is another method of representing negative numbers in computer. Two's 

complement is achieved by adding 1 in one's complement. Few examples of Two's 

Complement are given below. 

Example -11 

Number=1011 

One's Complement = 0100 

Two's Complement = 0100 +1= 0101 = 101 

Example -12 

Number = 1100100 

One's Complement = 0011011 = 11011 

Two's Complement = 11011+1 = 1110 

BIT 

Computer stores all its data in the form of 0s and 1s. Digit 0 and 1 and called Bits. That 

means 0 is one bit and 1 is another bit. The data 1100 comprises of 4 bits. You can say that 

bit is the smallest storage unit of computer.  

BYTE  

8 bit put together form 1 byte. For example, 10101011 will occupy one byte space. 

WORD 

Number of bits that are used for representing a character within the computer are called 

word. Note that in most of the computers 8 bit are used to represent a character. Thus in 

those computers words comprises of one byte. 
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                   EXERCISES                      CHAPTER 2 

 

Short Type Questions 

A.  Select most appropriate answer for following questions: 

1. Which number system is used for representing numbers within the computer? 

 (a)  Decimal  (b)  Octal   (c)  Binary (d)  Hexadecimal 

2. Which of the following is a valid octal number? 

 (a)  (893)8 (b)  (125)8 (c)  (786)8 (d)  (679)8 

3. Which number system makes use of alphabets to represent numbers? 

 (a)  Decimal (b)  Octal  (c)  Binary (d)  Hexadecimal 

4. How many fundamental digits are used in binary number system? 

 (a)  0  (b)  1  (c)  2  (d)  10 

5. Which of the following is not a binary number? 

 (a) (10)2 (b)  (20)2 (c)  (11)2 (d)  (100)2   

B.  Fill in the blanks: 

6. The base of binary number system is ……………….……………….…………...……….. 

7. The base of octal number system is ………………..……………….……………...……… 

8. The base of hexadecimal number system is …………… ………. ………....…. ………. 

9. Binary equivalent of decimal (100)10 will be  ………………….………..……………. …. 

10. 1's complement of (110011)2 will be ………………..............…………….……………… 

C.  State, true or false for following statements: 

11. In our day-to-day functioning, we make use of binary number system. 

12. Computer makes use of binary number system for doing all calculations. 

13. Two's complement represents negative numbers in computer. 

14. Binary equivalent of (22)10 is (10110)2 

15. 1's complement of (1110)2 will be 1. 

D.  Answer the following questions in short: 

16. How many digits are used in binary number system? 

17. How many digits are used in hexadecimal number system? 

18. Write all basic digits of octal number system. 

19. Convert (55)10 into equivalent binary number. 

20. Convert (11)10 into equivalent decimal number. 
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Detailed Answer Type Questions 

E.  Answer the following questions in detail: 

21. Convert following binary numbers into equivalent decimal numbers. 

 (a)  (1011)2  (b)  (11100)2   (c)  (11001111)2   

22. Convert following decimal numbers into equivalent binary numbers. 

 (a)  (175)10  (b)  (575)10  (c)  (975.55)10  

23. Convert following octal numbers into equivalent decimal numbers. 

 (a)  (124)8  (b)  (246 )8  (c)  (357)8 

24. Convert following binary numbers into equivalent octal numbers. 

 (a)  (110011)2  (b)  (111000)2  (c)  (111)2   

25. Convert following octal numbers into equivalent binary numbers. 

 (a) (234)8  (b)  (126)8  (c)  (374)8  

26. Convert following binary numbers into equivalent hexadecimal numbers. 

 (a) (1100)2  (b)  (11001100)2 (c)  (1101111)2  

27. Convert following octal numbers into equivalent hexadecimal numbers. 

 (a)  (123)8  (b)  (4567)8  (c)  (6574)8 

28. Convert following hexadecimal numbers into equivalent octal numbers. 

 (a) (1F2)16  (b)  (2A6)16  (c)  (126)16 

29. What is one's complement? Explain by giving a suitable example. 

30. What is Two's complements? Explain by giving a suitable example. What is its 
purpose in computers? 

 

  **** 



UNIT - II 

 

 

 

 

 

MS-DOS Operating System  

INTRODUCTION 

A computer system is basically combination of hardware and software. For its functioning 
it requires different types of hardware devices, electronic components and various types of 
software. Operating system is one of the software, which computer uses for its internal 
functioning. What operating system is, what are its functions and what types of operating 
systems are commonly available for use are the issues that are described in this chapter. 

WHAT IS OPERATING SYSTEM 
Operating System is essential software that is required for a computer to become 
operational. It provides functionality to computer hardware so that electro-mechanical 
components of it perform read, write and processing functions as human beings do. 

Without operating system, computer cannot work. In the absence of operating system, 
neither input devices will be able to provide data to the computer nor memory will be able 
to store anything in it nor processor will be able to process the data nor output devices will 
be able to show the result. Managing computer's resources and making them work in 
coordination with each other is the responsibility of operating system. 

Any instruction given by the user to the computer to perform a function is actually carried 
out by operating system. It is the operating system, which on receiving instructions from 
the user invokes all internal units to perform their duties and workout the result. Details of 
operating system are described below. 

SIGNIFICANCE OF OPERATING SYSTEM 

Operating system is essential software, purpose of which is to activate the computer and: 

1. perform internal management functions 

2. provide services. 

Internal management functions are the functions that have to be essentially performed to 
make the computer work. For example, managing the processor, memory, devices, input / 
output functions, data etc. 

3 CHAPTER 
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Services are bunch of commands and utilities that 
operating system provides to its users to have better 
control over computer. Block diagram, showing the 
basic structure of operating system is shown in 
figure 3.1. It also depicts its purpose. 

EXAMPLES OF OPERATING 

SYSTEM 

To activate the computer and to perform different 
types of activities on computer, many operating 
systems are available these days. MS-DOS, 
Windows, Linux, UNIX etc. are few popular 
operating systems of modern time. Each operating 
system has its own advantages and disadvantages. 
As per its design and features each operating 
system offers its own style of working and commands. In this book, we will mainly 
describe MS-DOS and Windows operating systems. 

INTRODUCTION TO MS-DOS  

MS-DOS is one of the most popular, powerful and useful operating system. It was designed 
and developed in the initial days of Personal Computers (PC) by Microsoft Corporation of 
USA. Due to its versatility and ease of operations, it became quite popular, within short 
span of time. 

MS-DOS is Character User Interface (CUI) based operating system. To execute any 
command in MS-DOS, you need to know the command and its format. Any mistake in its 
spelling or format leads to error.   

MS-DOS not only activates computer resources and controls them but it also provides 
many commands for performing day-to-day tasks. Internal architecture of MS-DOS and its 
commands are explained in this chapter. 

CONSTITUTION OF MS-DOS 

MS-DOS is a modular operating system and comprises of 
many files. It utilizes these files as and when required. 
Following files put together constitute MS-DOS operating 
system:  

1. IO.SYS 

2. MSDOS.SYS 

3. COMMAND.COM 

4. Many external command files 

Basic architecture of MS-DOS operating system is shown in figure 3.2 and role of each file 
is explained below. 

 
Figure 3.2 

Figure 3.1 
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IO.SYS File 

This is one of the most fundamental files of MS-DOS. It gets loaded into computer's 
memory at the time of booting the system. It primarily activates basic input and output 
devices like keyboard, VDU etc. and makes them functional. 

MSDOS.SYS File   
This file is also one of the fundamental files of MS-DOS. It automatically gets loaded at 
the time of booting the operating system. It controls internal resources like memory, ALU, 
Control Unit etc. of computer. When it gets executed, memory, ALU, Control Unit etc. 
become functional. 

COMMAND.COM File 

This is the third fundamental file of MS-DOS operating system. It comprises of few 
frequently used MS-DOS commands. When you boot the system, it gets automatically 
loaded into computer's memory.  After booting the system, commands contained in it, 
remain present in main memory. This is the reason, why they are called internal commands. 
For example, DIR, COPY, TYPE, REN etc. are internal commands of MS-DOS and reside 
in COMMAND.COM file. 

To execute an internal command, you need to type the command from the keyboard in its 
recommended format. When you do so, it is directly read from the memory and executed. 
Role and function of each internal command are described later in this chapter. 

External Commands 

MS-DOS comprises of many external commands. Each command exists in the form of 
executable file and resides on the disk. For example, FORMAT, XCOPY etc. are the 
examples of external commands. They exist in the form of FORMAT.COM, XCOPY.EXE 
files respectively. 

To execute an external command, you need to type the name of the command from the 
keyboard and press Enter key. When you do so, computer reads the file from the disk, loads 
it into memory and executes it. When its execution is complete, it is removed from the 
memory. Role and functions of external commands are described later in this chapter. 

FILES AND FILE TYPES 

Whatever computer has to store on media like floppy hard disk or CD, it stores in the form 
of files. Whenever it has to make use of the contents, stored in the file, it accesses the file 
and reads them from it. In other words you can say that all read/write operations, in 
computer are done through files. Computer files can be broadly classified into two 
categories: 

1. Executable files  2.  Data files 

Executable files are basically command files, which when executed perform specific task. 
For example, DISKCOPY.COM is a command file, which copies the contents of a floppy 
on another floppy.  
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Data files are the files, which contain data, program or some information in them. 

Files are identified by their names. Each operating system follows a fixed file naming 
convention. All files of that operating system need to follow the convention. MS-DOS file 
naming convention is described below. 

FILE NAMING CONVENTION  
As per rules of MS-DOS operating system, file name comprises of two parts. First part is 
called primary name and second part is called extension. Both the parts remain separated 
from each other by a dot (.). Thus following pattern is used for naming the files: 

<Primary Name>.<Extension> 
For example, DELL.DAT is a valid file name. Here DELL is the primary name and DAT is 
extension. Following are the restrictions that are imposed by MS-DOS, on file names: 

1. Primary name can be at most 8 characters long. The name can either be written in 
upper case or lower case letters but operating system stores all the file names in 
upper case only. For example, file names like AMOUNT.DAT, Amount.Dat, 
amount.dat etc. will be treated as, same and will be stored as AMOUNT.DAT. 

2. Extension can be at most 3 characters long and can be given in lower case or upper 
case letters. It will also get stored in upper case. 

3. Mathematical signs like +,-,*,/ etc. can not be used in constituting the name. 

Following is the general format of MS-DOS file name: 

  XXXXXXXX . XXX 

 

    

 

Following are few valid file names: 

 DELL.COM, PLOT.DAT, MONTH12.BAK, YR.AS, RIGHT.DOC 

Wild Cards Are Their Usage 
As you know, each file is assigned a unique name. Thus when you refer a file by its name, 
single file is referenced. Wild card is a mechanism, using which you can refer a group of 
files.   

Wild cards are basically special characters that can be used while specifying a file name. 
These characters carry special meaning for computer. Following are the wild card 
characters and their meaning: 

1. The character "*"  denotes any character after this place. 

2. The character "?"   denotes any character at this place. 

To understand the concept of wild card character, assume that following files are present on 
the disk:  

dot 8 character of 

Primary name 

3 characters 

of Extension. 
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 1.  ABC.DAT  5.  WORK.DAT  9.    AXP.EXE 

 2. ADC.BAK  6.  WORK.BAK  10.  ART.WRK 

 3. A1.TXT  7.  MONEY.TXT 

 4.  S.BAK  8.  MY.FIL 

1. If you wish to refer all the files with extension .BAK, you can refer them by the 
name *.BAK 

2. If you wish to refer all those files, in which names start with A and have any 
extension, you can refer them by the name A*.*.  

3.  All file names starting with A, three characters long, ending with C and any 
extension, can be referred by the name A?C.*.   

CONCEPT OF DIRECTORY 

Directory can be conceptualized as special file, which 
can hold files and directories in it. Concept of 
directory is illustrated in figure 3.3. Refer this figure 
and note that D1 is a directory, which holds two files 
F1 and F2 in it. It also contains a directory D2 in it. 
D2 holds Files F3 and F4 in it.  
From this figure, it is quite clear that directories can 
be utilized for classified storage of files on the disk. 
For example, directory named LETTER could be 
utilized for storing all letters in it. Similarly the 
directory CPROGRAM could be used for storing all 
the programs written in C language. 

Concept Of Root Directory 

Root directory can be conceptualized as the top most directory, which holds other 
directories and files in it.  

Whenever you use any disk for the first time, root directory gets automatically created on 
it. Other files and directories that are created thereafter are created within root directory. In 
MS-DOS, root directory is denoted by back slash(\) sign. 

Concept Of Parent Directory 

Parent directory is the directory, in which you create another directory. For example, if 
directory D2 is created in directory D1 then D1 directory will be called parent directory of 
D2. Similarly if directory D3 is created in directory D2 then D2 will be the parent directory 
for D3. Parent directory is denoted by double dot (..) symbol. 

Current Directory 

Once you have directories within directory, you can always change your position from one 

Directory-D2 

Directory-D1 

File- F2 File- F1 

File- F3 File- F4 

Figure 3.3 
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directory to another directory. The directory within which you are currently placed is called 
current directory. For example, if you are currently placed in directory D1 then D1 will be 
called current directory. When you have moved from directory D1 to D3 then D3 will be 
the current directory. 

MS-DOS FILE SYSTEM 

The mechanism of arranging the files and directories on the disk is called file system. In 
MS-DOS, file system looks like an inverted tree. Root directory appears at the top of the 
tree. Other directories branch off from there and files act as leafs. 

Such a file arrangement is often referred to as Hierarchical File System. A hierarchical file 
system consisting of few files and directories is illustrated in figure 3.4. 

Root Directory (\)

Directory D1 Directory D2File F1

Directory D1.1 File F1.1 File F2.1 File F2.2 File F2.3
 

Figure 3.4  

Refer hierarchical file system illustrated in figure 3.4 and note that root directory is at the 
top of the tree. Root directory contains two directories D1, D2 and a file, named "File1" in 
it. D1 and D2 further contain subdirectories and files in them. Note that directories in MS-
DOS follow the same naming convention that files do. Generally the directories are 
assigned a name, which gives an indication of the type of files contained in them. For 
example, the name DOCUMENT could be used for storing document files in it. Similarly 
SALARY directory could be used for storing pay relates files.  

CONCEPT OF PATH 
Path of a file or directory is the list of directory names in descending sequence, starting 
from root and each directory name separated by a back slash (\), following which you reach 
to the desired file or directory. For example, refer figure 3.4. The path for file F1.1 will be 
\D1\F1.1. Similarly the path name for F2.2 file will be \D2\F2.2. Note that first backslash 
in the path name denotes root directory, while other backslashes serve the purpose of 
separators.   

You know that MS-DOS provides numerous internal and external commands for performing 
different tasks. To make use of these commands, it is necessary that computer should be booted 
with MS-DOS. The procedure of booting the computer is described below. 
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BOOTING COMPUTER USING MS-DOS 

To boot the computer, using MS-DOS, follow the following steps: 

1. Switch on the VDU. 

2. Switch on the power, using power switch present in computer cabinet. 

When you switch on the computer, it performs self-test. If self-test passes through 
correctly, operating system is read from the disk and loaded in computer's memory. 
Immediately after that following sign appears on VDU screen: 

C:\> 

Above mentioned sign is called system prompt. Different characters in system prompt 
signify different things. C: indicates that the system was booted from C drive. Character \ 
indicates that root is the current directory. The > sign is a terminator. Any thing written 
after this sign is treated as command. The dash sign is called cursor. It keeps blinking. It 
acts like tip of the pen. Whatever you type from the keyboard, gets typed at current cursor 
location and it shifts towards right. 

INTERNAL COMMANDS 

All those commands, which are part of COMMAND.COM file and remain resident in 
memory from the time of booting to the time of shutdown, are called internal commands. 
For example, DIR, COPY, EDIT, CLS, PROMPT, REN, DEL etc. are all, internal 
commands. Formats and functions or internal commands are described below. 

DIR Command 

DIR command is used for displaying the names of all the files residing on media like 
floppy hard disk, CD etc. In its simplest form, it can be executed in following format: 

C:\> DIR [Enter] 

This command will display the names of all the files present on C: disk, in the following 
format:  

Volume in drive C is RAMESH 

Volume Serial Number is 36F7-808 

Directory of C:\ 

COMMAND   COM 54,645 06-11-99 7:21a 

DATA    DAT 732 07-12-99 6:20p 

REPORT    DOC 3,210 05-05-98 5:40p 

DOIT    BAK 734 05-06-99 2:25a 

TOTAL    DAT 351 10-10-99 5:25p 

EXAM   LET 357 08-08-99 6:37p 

   6 file(s)                    60,029 bytes 

                 18, 376, 520 bytes free 

General format of DIR command is as follows: 

DIR [drive:] [file name] [/P] [/W] 
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Explanation of each notation used in above mentioned format is given below:   

drive   is the name of that drive, for which, the file names are to be displayed. For 
example, if "A:" drive name is specified then the names of all those files 
will be displayed, which are present on the floppy that is currently present 
in A: drive.  

file name  If file name  is specified then its presence  is reported. For example, if 
"DATA.JAN" file name is specified and if this file is not present in the 
drive then a message saying that this file is not present on the disk will be 
displayed. On the other hand if the file is present then its name will be 
displayed along with other details, confirming its presence on the disk.  

/P  It is an optional switch. If it is specified in the command, output of DIR 
command is displayed page wise. That means after displaying one screen of 
output, display halts and at the bottom of the screen, a message "Press any 
key to continue..." gets displayed. When you press a key, next screen gets 
displayed.  

/W It is an optional switch. It displays the file names, width wise, instead of 
one file name in one line. 

 /O   It is an optional switch. It sorts the output of DIR command.  

Following are few examples of DIR commands and their results:  

DIR Displays names of all the files, present in default drive. 

DIR A: Displays names of all the files, present in A: drive.  

DIR A: /P This command displays names of all the files, present in A: drive, 
page wise.  

DIR /W This command displays names of all the files, present in default 
drive, width wise i.e. 5 file names per line.  

DIR A.DAT It reports presence or absence of A.DAT file in default drive.  If it 
is found, its name along with other details is displayed else "No 
such file" message is displayed. 

DIR *.BAK Names of all those files are displayed, which have .BAK 
extension.  

DIR B*.DAT All those file names, which start with 'B' and have .DAT extension 
get displayed.  

DIR Z???.*/P All those file names, which are 4 characters long, start with Z and 
have any extension, get displayed, page wise. 

DIR AB??.DAT All those file names, which are 4 characters long, start with "AB" 
and have ". DAT" extension, get displayed.  
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EDIT Command  

EDIT command is used to create a text file and type text in it.  It is executed in the 
following format: 

EDIT [drive:] [file name] [Enter] 

Here, in this format, "drive:" is the name of that drive, on which the file is to be created 
and "file name" is the name, by which the file is to be created. For example, following 
command will create MYFILE.TXT file on default drive:  

EDIT MYFILE.TXT  [Enter] 

After execution of this command, following window will appear on the screen:  

 

Figure 3.5  

After getting the window on the screen, type the text as per instructions given in the 
following table:  

   Sr. No. Task Action  

1.  Type the text Use character keys of the keyboard to type 
the text. 

2.  Take the cursor to the Use arrow keys.  
  desired line and column. 

3.  Delete a word Take the cursor to the beginning of the 
word and press CTRL and T keys together. 

4.  Delete a line Take the cursor to the line, which is to be 
deleted and then press CTRL and Y keys 
together. 

5.  Insert text  Take the cursor to the place where text is to 
be inserted and start typing the text.  
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Sr. No. Task Action 

6.  Inserting a line  Take the cursor to the line, which is to be 
shifted below. After this, press Enter key. 

7.  Save the file  Press ALT and F keys together and then 
press S key. 

8.  Come out of EDIT Press ALT and F keys together and then 
press X key.  

TYPE Command 

TYPE command is used for displaying the contents of a file on VDU.  It is executed in the 
following format:  

TYPE <file name.> [Enter] 

Here, in this format, <file name> is the name of that file, contents of which are to be 
displayed on the screen. For example, if you wish to view the contents of MYFILE.TXT 
then following command is to be given:  

TYPE A:TEST [Enter] 

COPY Command 

COPY command is used to make a duplicate copy of a given file. It is executed in the 
following format:  

COPY <Source file name> <Destination file name>       [Enter] 

Here in this format, "Source file name" is the name of the file, which you wish to copy and 
"Destination file name" is the name of the file, in which the contents have to be copied. For 
example, if the contents of "MYFILE.TXT" file are to be copied in "MYFILE.BAK" then 
COPY command will have to be executed, as mentioned below:  

COPY MYFILE.DAT MYFILE.BAK 

General format of COPY command is as follows: 

COPY [/-y] [Source file] [+Source file] [+.........} [destination file] /V. 

Explanation of each notation used in above mentioned format is given below:   

/-Y It is an optional switch. It makes the COPY command interactive. That means if the 
destination file already exists, it displays a confirmation message.  

In above mentioned format, many source file names with + sign indicate that 
multiple files can be copied into one file so as to add them together.  

/V It is an optional switch. It makes COPY command, verify the contents after copying 
the file.  

To understand the usage of different switches in COPY command, consider below given 
commands:   

between two lines 
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COPY /-Y A:JAN.DAT C:JAN.BAK /V 

If file C:JAN.BAK file already exists on C: drive then following confirmation message will 
get displayed: 

Overwrite A:JAN.BAK (YES / NO / ALL) 

Against this message, if you opt for "YES", computer will overwrite on the existing, 
JAN.BAK file. If you opt for "NO" then the file will not be copied. "ALL" option will 
behave as "YES" option, when multiple files are copied. /V switch in the command will 
verify the contents of JAN.BAK file from the original file, after copying the file. Following 
command will add three files i.e. ONE.DAT, TWO.DAT and THREE.DAT into one file 
named ALL.DAT. 

COPY ONE.DAT+ TWO.DAT+ THREE.DAT  ALL.DAT 

REN Command 

REN command is used for renaming an existing file. General syntax for REN command is 
as follows: 

REN <Existing file name> <New file name>     [Enter] 

To understand the usage of REN command, consider the following examples:   

REN DATA.DAT  INFO.TXT  [Enter] 

This command will change the name of DATA.DAT file to INFO.TXT.  

REN *.NEW  *.OLD [Enter] 

This command will change all extension names, ".NEW" to ".OLD".  For example, 
JAN.NEW  file will be renamed as JAN.OLD. Similarly, TEST.NEW file will be renamed 
as TEST.OLD.       

DEL Command 
DEL command is used for removing a file from the disk. In its simplest form, it can be 
executed as follows: 

DEL  <File name>     [Enter] 

Here, in this format, "File name" is the name of the file along with drive reference, which is 
to be removed from the disk. To understand the usage of DEL command, consider the 
following examples:   

DEL  A:DATA.DAT       [Enter] 

This command will remove DATA.DAT file from A: drive. 

DEL *.*      [Enter] 

This command will remove all the files from the default drive. It is quite obvious that this 
command can be disastrous. So as a precautionary measure, whenever you make use of 
DEL *.* command, computer   displays following confirmation message and removes or 
doesn't remove files as per your confirmation: 
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All files in directory will be deleted ! 
  Are you sure (Y/N)? 

It you opt "Y", all the files are deleted else the command is ignored.  

General format of DEL command is as follows: 

DEL  <File name>  [/P] 

Here, in this format, /P is an optional switch. It makes DEL command interactive. That 
means before deleting the file, a confirmation message is displayed. As per the choice 
opted against this message, action is performed.   For example, following confirmation 
message will get displayed when you give DEL ABC.DAT /P: 

 ABC.DAT,       Delete  (Y/N) ? 

If you opt for "Y", file will get deleted. If you opt for "N" then file will remain intact.  

CD Or CHDIR Command 

CD is short form of Change Directory. It is used for moving from one directory to another 
directory. General format for CD command is as follows: 

CD <Directory name>       [Enter] 

Here, in this format, "Directory name" is the name of that directory, to which you wish to 
move. To understand the usage and functioning of CD command, consider the following 
examples: 

If current directory has a directory named SECOND in it and you wish to move to that 
directory, CD SECOND command will have to be given.  

If you wish to move to root directory, CD \ command will have to be given.  

If you wish to move to the parent directory, CD  .. command will have to be given.  

If you execute CD command, without any file name, the name of current directory gets 
displayed.     

MD Or MKDIR Command 

MD is short form of Make Directory. This command is used for creating a new directory. It 
is used in the following format:  

MD <Directory name>      [Enter] 

Here, in this format, "Directory name" is the name that is to be assigned to the newly 
created directory. For example, if you wish to make a new directory with the name 
"LETTERS", following command will have to be given:  

                MD LETTERS [Enter] 

Note that when you make a directory, it is made in the current directory. For example, if 
you are in root and execute above-mentioned command, LETTERS directory will be 
created in root. On the other hand, if you are in DOC directory and you execute that 
command, LETTERS directory will get created in DOC directory.  
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RD Or RMDIR Command 

RD is short form of Remove Directory. This command is used for removing the directory 
from the disk, provided it is blank. It is used in the following format:  

RD  <Directory name>      [Enter] 

Here, in this format, "Directory name" is the name of that directory, which is to be 
removed.  For example, if you wish to  remove  LETTERS directory, following command 
will have to be given:  

RD LETTERS [Enter] 

For example, it you wish to remove NEWS directory from the media then you can give the 
following command: 

RD  NEWS      [Enter] 

PROMPT Command 

PROMPT command is used for changing the system prompt. It is used in the following 
format:  

PROMPT String 

Here, in this format, "String" can either be few special-meaning characters or a simple 
message. For example, if "YourChoice" has to be set as system prompt then PROMPT 
YourChoice command will have to be given.  

Special meaning characters that can be used in PROMPT commands are listed in the 
following table:  

 Special Character   Their Effect 

 $Q   Equal Sign gets included 

 $T   System prompt changes to current time. 

 $D   System prompt changes to current date 

 $P   System prompt changes to current $ drive and path 

 $G   Greater than Sign 

 

For example, following command will change the system prompt to current drive, current 
directory name and a greater than sign: 

PROMPT  $P$G 

CLS Command 

This command erases all the contents, currently present on the screen and puts the system 
prompt in left hand upper corner of the screen. It is executed in the following format: 

CLS [Enter] 
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SYS Command 

SYS command is used to make a media, like floppy, hard disk etc. bootable. While making 
it bootable, it copies IO.SYS, MSDOS.SYS and COMMAND.COM files at specific 
location on the media.  Since these files are copied at specific location hence the media 
becomes bootable. On the other hand, if you copy these files to the media, using COPY 
command, media will not become bootable. SYS command is used in following format:    

SYS   <Drive name>         [Enter] 

Here, in this format, "Drive name" is the name of the drive that contains the media, which 
is to be made bootable. For example, if floppy in drive A: is to be made bootable, following 
command will have to be executed:  

SYS   A:         [Enter] 

LABEL Command 

Label is basically an identification name, which can be assigned to any media like floppy, 
hard disk etc. In MS-DOS, LABEL command is used for putting labels on the media. It is 
used in the following format:  

LABEL   <Drive name>          [Enter] 

Here, in this format, "Drive name" is the name of that drive, which holds the media, on 
which the label is to be marked. For example, if you wish to put the label on the floppy, 
present in A: drive, following command will have to be given:  

LABEL  A:        [Enter] 

This command will show the existing label and display the following message:  

Volume label      (11 characters ENTER for name) ? 

Here you need to type the identification name of the floppy, consisting of maximum 11 
characters. If you do not type the name and simply press Enter key then the existing 
volume label, will get deleted. 

VOL Command 

VOL command is used for displaying the label that has been put on the media. It is used in 
the following format: 

VOL   <drive name>       [Enter] 

Here, in this format, "Drive name" is the name of that drive, which holds the media, whose 
label is to be displayed. For example, if you wish to display the label of the floppy, which 
has been put in A: drive, following command will have to be given:  

VOL A: [Enter] 

Floppy's label will get displayed in the following format:  

Volume in drive   A: is   <Volume name> 
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EXTERNAL COMMAND 

All those commands of MS-DOS, which are not part of COMMAND.COM file and reside 
on the disk, in the form of executable files, fall into the category of external commands. 
For example, FORMAT, MOVE, MORE, TREE, DISKCOPY etc. are external commands.  
Functions and formats of these commands are described below.  

FORMAT Command 

Format command makes internal logical arrangement on the media like floppy, hard disk etc. 
to store the data. This arrangement is made by 
dividing the surface of the media into concentric 
circles and concentric circles into small segments, 
called sectors.  Internal logical format of a typical 
floppy is illustrated in figure 3.6. 

The floppy that we generally use is called 135 
TPI double sided high density 3.5" floppy. Data 
is recorded on both the sides of the floppy. Each 
side consists of 80 tracks and each track contains 
18 sectors in it. Each sector stores 512 bytes in it. 
Thus capacity of the floppy turns out to be 1.44 
MB. FORMAT command, in its simplest form 
can be executed as follows: 

FORMAT   [Drive name] 

Here, in this format, "Drive name" is the name of the drive that holds the media, which is to 
be formatted. For example, if you execute "FORMAT  A:" command, the floppy present in 
A: drive  will get formatted. After giving this command, computer will display the 
following message on the screen and wait for your intervention:  

Insert new diskette for drive A: 

and press ENTER when ready... 

Now you will have to put the floppy, which is to be formatted, in A: drive and press Enter 
key. When you do so, following message will be displayed on the screen: 

Checking existing disk format 

Saving UNFORMAT information 

After formatting the floppy, FORMAT command will display following message on the 
screen: 

Volume label (11 characters, ENTER for none) ? 

You can type any string of characters (not more than 11 characters) as label, against this 
message. At last, following message will get displayed:  

Format Complete 

Format another disk (Y/N) 

 
Figure 3.6 
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If you wish to format another disk, type "Y" else type any other character. Note that this 
was the simplest form of FORMAT command. The general format of FORMAT command 
is as follows: 

FORMAT   <drive name>   [Switch] 

Following switches can be used in FORMAT command:  

/S :  This switch makes the floppy bootable.  

/U :  Formats the floppy unconditionally.  

MOVE Command 

MOVE command, physically moves files and directories from one place to another. It is 
used in the following format: 

MOVE <Source file name>    <Destination directory>  

Here, in this format, "Source file" is the name of the file, which is to be moved from its 
current location to another directory. "Destination directory" is the name of that directory, 
in which the file is to be transferred. For example, if you wish to move SUM file into 
GTOTAL directory of root then following command will have to be given:  

MOVE SUM  \GTOTAL      [Enter] 
MOVE command can also be used for renaming the directories, as done in the following 
example:  

MOVE JAN   MONTH        [Enter] 

Above mentioned command will rename JAN directory to MONTH.  

TREE Command 

TREE command displays the file system, present on the disk, in graphical form. In its 
simplest form, it is executed in the following format:  

TREE        [Enter] 

A sample output of this command is illustrated in figure 3.7. 

Refer figure 3.7 and note the following points:  

1. Directory names that are at equal distance 
denote that these directories are at same 
hierarchical level, in the file system. For 
example, EXPENSE, BOOK and MONTH 
directories are subdirectories of ROOT and are 
at same level.  Similarly subdirectories like, 
SALARY, TOUR and WEEK are at equal level.  

2.  File names do not get displayed in the output.  

General format of TREE command is as follows: 

TREE  [ drive: ]  [path]   [ / F ] 

 

Figure 3.7 
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Here, in this format, "Drive:" is name of that drive, for which you wish to see the directory 
structure. Path is the full path name for the directory, for which the directory structure is to 
be seen. If you specify /F switch file names are also displayed along with the directory tree 
structure. 

DELTREE Command 

DELTREE command is used for deleting the directory tree. When you delete the directory 
tree, all files and directories, in it get deleted.  It is used in the following format: 

DELTREE   <name of the directory to be removed>       [Enter] 

This command will remove the complete branch of the directory structure that starts from 
the specified directory. This means that this directory and all the files and directories in it 
will get deleted.  

DISKCOPY Command 

DISKCOPY command is used for duplicating the contents of a given floppy. When you 
make use of this command, all files and directories of one floppy get copied to another 
floppy.  In its simplest form, it can be executed as follows: 

DISKCOPY   <Source drive>       <Destination drive> 

Here, in this format, "Source drive" is the name of that drive, which contains the floppy, 
whose contents are to be duplicated. "Destination drive" is the name of that drive, which 
holds the floppy, on which the contents have to be copied.  For Example, if you wish to 
copy the contents from drive A: to B: drive then following command will have to be given:  

DISKCOPY  A:   B:        [Enter] 

Note that DISKCOPY makes a mirror image of the source on the destination, so it is 
essential that both the drives should be of the same size and both should contain the floppy 
of the same capacity. Any difference will result into an error and DISKCOPY will not copy 
the files. 

If there is only one floppy drive in the computer and you wish to execute this command 
then it will have to be executed as follows:  

DISKCOPY A:   A:       [Enter] 

When the source and the destination drive are same, DISKCOPY command becomes 
interactive and prompts you as follows: 

Insert source diskette in drive A: 

Press any key to continue. 

Now you need to put the source floppy in A: drive and press any key. After this, computer 
will read the data from floppy and display the following message on the screen: 

Reading source from the diskette..... 

After reading the data, computer will again displays the following message on the screen: 
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Insert TARGET diskette in drive A: 

Press any key to continue. 

Now you have to take out the source floppy from A: drive and put the destination floppy 
(on which you wish to copy the files) in the same drive. After this, copying process will 
start when you press any key.  Note that copying may not get completed in one cycle. In 
that case above-mentioned messages will keep on appearing as many times as required. 
You will have to keep on inserting source and destination floppies as and when asked for.  

General format of the DISKCOPY command is as follows: 

DISKCOPY <source drive>    <destination drive> [/V] 

/V switch, when included in DISKCOPY command, verifies the contents after copying. 
Obviously inclusion of this switch will slow down the procedure. 

 

 

 EXERCISES                      CHAPTER 3 

 

Short Type Questions 

A.  Select most appropriate answer for following questions: 

1. Which of the following file gets automatically loaded at the time of booting the 
computer? 

 (a)  TYPE.COM  (b)  FORMAT.COM  (c)  IO.SYS (d)  DIR 

2. Which of the following file is not part of MS-DOS operating system? 

 (a)  COMMAND.COM (b)  IO.SYS (c)  FORMAT.COM (d)  DIR.DAT 

3. Which of the following character doesn't represent a directory? 

 (a)  \   (b)  /  (c)  .  (d)  .. 

4. Which of the following character represents a wild card in MS-DOS? 

 (a)  *   (b)  $  (c)  %  (d)  ! 

5. Which of the following command does not operate upon file? 

 (a) EDIT  (b)  COPY (c)  CLS (d)  DEL 

B.  Fill in the blanks: 

6. Loading the operating system into computer's memory is called 
……………………………….………………….. 

7. Those commands of MS-DOS, which remain resident in computer's memory are 
called ………………..……………….…………………… 
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8. External commands of MS-DOS reside on  
…………………………….…………….………. 

9. Primary name of MS-DOS file can be up to …………………. characters long while 
extension could be………………… characters long. 

10. ……………………………… command can be used for renaming a file. 

11. The character ................................. represents root directory. 

12. ............................. command is used for displaying the names of all the files 
present on disk. 

13. ................................. command is used for displaying the contents of  a file. 

14. ................................. command could be used for typing your personal details on 
computer. 

15. ............................ command could be used for making mirror image of a floppy. 

C.  State, true or false for following statements: 

16. IO.SYS file contains all internal commands of MS-DOS. 

17. COMMAND.COM file contains all external commands of MS-DOS.  

18. DEL is an external command of MS-DOS. 

19. FORMAT command erases all the files present on the disk. 

20. REM command renames a given file. 

D. Differentiate between the following: 

21. IO.SYS and MSDOS.SYS files of MS-DOS. 

22. FORMAT /S and SYS commands of MS-DOS. 

23. COPY and XCOPY commands. 

24. VOL and LABEL commands of MS-DOS. 

25. DELTREE and RD commands of MS-DOS. 

E.  Describe the functioning and format of following commands: 

26. (a) DIR     (b)  REN   (c) PROMPT   (d)  MOVE        (e) MD  (f)  DISCOPY 

 

Detailed Answer Type Questions 

E.  Answer the following questions in detail: 

27. Draw a block diagram of MS-DOS and describe the role of COMMAND.COM file. 

28. What do you understand by wild cards? Name the characters that are used as wild 
cards in MS-DOS. What do they signify? 

29. Name any three internal commands of MS-DOS and write their general format. 

30. Name any three external commands and write their general format. 



 

 

50    Computer Application For Engineering 

31. How will you make a floppy bootable in MS-DOS? 

32. How will you FORMAT a floppy in MS-DOS and make it bootable? 

33. How will you rename the file, A.DAT to A.BAK in MS-DOS? 

34. How will you check the presence of DATA.DAT file on a floppy, which is present in 
A: drive. 

35. How will you make a mirror image of a floppy, it you have only one floppy drive in 
your computer? 

36. How will you see the contents of A.DAT file on VDU?  

   

  

  

PRACTICAL ASSIGNMENTS 

 

ASSIGNMENT 1  :  Working With MS-DOS Commands.  

1. Switch on the computer and boot it with MS-DOS operating system. 

2. Make a directory with the name TEST. 

3. Go into TEST directory. 

4. Make a file, INDIA.TXT and enter following text into it: 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. India is the world's largest, oldest, continuous civilization.  

2. India never invaded any country in her last 10000 years of history.  

3. India is the world's largest democracy.  

4. Varanasi, also known as Benares, was called "the ancient city" when Lord Buddha 
visited it in 500 B.C.E, and is the oldest, continuously inhabited city in the world today.  

5. India invented the Number System. Zero was invented by Aryabhatta.  

6. The World's first university was established in Takshashila in 700BC. More than 
10,500 students from all over the world studied more than 60 subjects. The 
University of Nalanda built in the 4th century BC was one of the greatest 
achievements of ancient India in the field of education.  

7. Sanskrit is the mother of all the European languages. Sanskrit is the most suitable 
language for computer software - a report in Forbes magazine, July 1987.  

8. Ayurveda is the earliest school of medicine known to humans. Charaka, the father 
of medicine consolidated Ayurveda 2500 years ago. Today Ayurveda is fast 
regaining its rightful place in our civilization.  
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5. Perform following operations on this file. 

(a) Add few lines at top, bottom and in middle. 

(b) Delete few lines from the text. 

(c) Copy some portion of the text to some other part. 

(d) Move some portion of the text to other location. 

(e) Save the text in the file and exit. 

6. Execute DIR command and observe the output. 

7. Make a duplicate copy of INDIA.TXT file with another name, INDIA1.TXT. 

8. Display the contents of INDIA.TXT file on VDU. 

9. Rename the file INDIA.TXT to BHARAT.TXT. 

10. Make another directory with the name JUNK. 

11. Copy BHARAT.TXT file into JUNK directory with same name. 

12. Copy BHARAT.TXT file into JUNK directory with another name, BHATRAT.BAK. 

13. MOVE to JUNK directory. 

14. Execute DIR commands to see how many files are there. 

15. Now execute CD .. command first and then print the current directory name so as to 
know the effect of CD .. command. 

16. Remove the file BHARAT.BAK. 

17. Try to remove JUNK directory, you will get an error. 

18. Perform all necessary steps and remove JUNK directory. 

19. Take a floppy and format it. 

20. Make the floppy bootable.  

21. Copy few files from TEST directory to floppy. 

22. Move one file from hard disk to floppy. 

23. Remove the file that you had copied on floppy. 

24. Display the names of the files present on floppy. 

25. Delete all the files from floppy. 

26. Reboot the system from floppy. 

27. Give C: command to make hard disk as default disk. 

28. Print the name of working directory. 

29. Go to root directory. 

30. Go to TEST directory. 
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31. Take another floppy that has few files in it. Using DISKCOPY command, copy all the 
contents of previous floppy to this floppy.  

32. Move around the system. Go to other drives. 

33. Perform DEL A:*.*  command for floppy and note the message that appears against this 
command. 

34. Execute TREE command and view the complete directory structure. 

35. View the Label of floppy.  

36. Change the label of the floppy.  

37. Clear the contents present on VDU screen, using CLS command. 

38. Change the system prompt, using PROMPT command. 

 39.Confirm the presence of COMMAND.COM, IO.SYS and MSDOS.SYS files on bootable 
floppy. 

40. Make an exit from the system and switch it off. 

 

  **** 

 



UNIT - II 

 

 

 

 

 

Windows Operating System   

INTRODUCTION 

Windows is the most popular operating system of modern times. It has been designed and 

developed by Microsoft Corporation of USA.  Windows not only activates computer and 

makes its devices functional, it also provides applications for performing wide variety of 

tasks on computer. For example, its Notepad program enables you to write letters and 

notes. Using its Paint program you can draw pictures on computer and color them too. 

Likewise there are many more programs in Windows. An introduction to its features, 

functions and applications is given in its chapter. 

FEATURES OF WINDOWS OPERATING SYSTEM 

Following are the features of Windows operating system: 

GUI Based Operating System 

GUI is acronym for Graphical User Interface. Windows is Graphical User Interface based 

operating system. It provides very simple, yet powerful and interesting mechanism for 

interacting with computer. 

In GUI interaction, you don’t interact with computer by typing commands, as you do in 

MS-DOS. Instead of this you make use of graphical items like icons, menus, buttons, 

dialog boxes etc. As and when required, these items appear on computer screen and you 

click, double click or right click the mouse on them to carryout required tasks. Thus in GUI 

mode of interaction, you need not remember the commands and their formats to perform 

the task, rather you should know the method of clicking, right clicking, dragging and 

dropping the items. 

Multitasking Operating System 

Windows is multitasking operating system. Thus in Windows, you can perform multiple 

tasks simultaneously. For example, while typing the letter through keyboard, you can view 

a movie on VDU and print the report on printer too. 

4 CHAPTER 
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Drag And Drop 

Drag and Drop is a powerful feature of Windows operating system. Using this feature, you 

can drag objects like files, folders etc. from their original location and drop them at some 

other place, so that they could either be copied or moved there. For example, dragging the 

file A from folder F1 and dropping it on folder F2 will move the file A from F1 to F2. 

CUT COPY And PASTE 

Cut, Copy and Paste are powerful features of Windows operating system. Using these 

feature, selected item like text, graphics, icons etc. can either be copied from their original 

place to a temporary memory location called Clipboard or from Clipboard to the desired 

location. Thus you can either move these items from one place to other or make duplicate 

copies of them. For example, when you select an item and perform CUT operation on it, it 

physically moves from its original place to the Clipboard. When you move to some other 

location and perform PASTE operation there, the item from Clipboard gets copied to the 

current location. Thus at the end of CUT-PASTE operation, selected item changes its place. 

Similarly when you perform COPY operation on a selected item, it get copied into 

Clipboard (doesn’t get removed from its original place, as it happens in the case of CUT 

operation). After this, when you change your current location and perform PASTE 

operation there, contents of Clipboard get copied to the new location. Thus a duplicate 

copy of the selected item gets made. 

Object Embedding 

This is one of the most powerful features of Windows operating system. It enables two or 

more programs to exchange objects like text, graphics etc. among them. For example, a 

drawing made in Paint program could be brought into the document, created through 

WordPad program so that figure could be embedded in the text. For example, you may type 

the description of Kutubminar in WordPad program and draw its figure in Paint program. 

Using object embedding feature of Windows, you can place the figure of Kutuminar in 

Kutuminar text, so that it becomes complete text in itself. 

Object Linking 

Object Linking is yet another powerful feature of Windows operating system. Using this 

feature, one object can be linked to the other object. Thus whenever linked object is 

modified or changed, modifications/changes get visible in other object also. For example, 

you may type the description of Personal Computer in WordPad program and draw its 

figure in Paint program. Using Object Linking feature you may link the computer figure to 

computer description so that it appears in the document (as it did in case of Object 

Embedding). Now whenever you will make modifications/changes in computer figure they 

will automatically get reflected in the description. You may note that overall effect of 

Object Embedding and Object Linking is same but automatic reflection of 

changes/modifications does not take place in case of Object Embedding. 
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Plug And Play 

It is an important feature of Windows operating system. It makes the operating system, 

slightly intelligent. Whenever a new device is attached to the computer, operating system 

automatically senses its attachment and loads its device driver. Thus due to plug and play 

feature, new devices become automatically operational in Windows operating system. 

Command Prompt 

Using this feature, Windows provides MS-DOS working environment, within Windows 

environment. Thus all MS-DOS commands could be executed from Windows. 

WINDOWS-A SERIES OF OPERATING SYSTEMS 

Windows is now, quite popular operating system. Long back, it came into existence. It was 

continuously updated to enhance its power and to incorporate more and more features into 

it. With the result of this, it has become world's most favorite operating system. 

Development of Windows operating system has taken place in two streams. First stream 

deals with stand alone environment while second stream deals with network environment. 

Different versions of Windows, which gradually came into existence, in stand alone 

environment are Windows-95, Windows-98, Windows-me, Windows-XP etc. Each version 

that came later was improved and enhanced version of the previous one. These operating 

systems were designed and developed for single user environment. 

For network environment, Windows-NT, Windows-2000, Windows-3000 etc. came into 

existence. They all are network operating systems. They not only provide base networking 

facilities but also provide network administration utilities. 

In this book, we will mainly deal with Windows-XP, which is the latest operating system 

for stand alone working environment. All throughout the book, we will refer it with the 

name Window. 

BOOTING COMPUTER WITH WINDOWS 

To boot the computer with Windows 

operating system, first switch the monitor on 

and then switch on the CPU, using ON/OFF 

switch present in its chassis. 

When you do so, computer will check all its 

peripherals, if they are functioning properly or 

not. If any unit is found faulty, an error 

message appears on the screen and booting 

process stops. On the other hand, if all the units 

are found OK, booting process continues. 

Computer reads the operating system from the 

disk, loads it into memory and displays a dialog 

box, as shown in figure 4.1.  
 

Figure 4.1  
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This dialog box is part of Windows security system. It asks for login name and password to 

ensure that only authorized persons use the system. To boot the system, enter your login 

name and password correctly and click the mouse on OK button. After a while, display on 

the monitor will turn as shown in figure 4.2. 

 

 

Figure 4.2 

INTRODUCTION TO WINDOWS DESKTOP 

After booting the system with Windows, the first 

screen that appears on the monitor is called Desktop. 

Desktop is illustrated in figure 4.2. A brief 

introduction of each component of Windows desktop 

is given below. 

Desktop Icons 

Icons are graphical pictures. They represent objects 

like programs, files, folders etc. Initially few icons 

appear on desktop. Later, if the need be, more icons 

are placed on the desktop. To activate any icon, you 

need to double click the mouse on it. 

Start Button 

Start button is the starting point of Windows menu 

system. When you click the mouse on "Start" button, 

Start menu, as shown in figure 4.3 appears on the screen. 

Desktop 

Icon

Task Manager 

System Tray 

Start Button Quick Launch 

Toolbar 

 

Figure 4.3 
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Refer Start menu, shown in figure 4.3 and note the following points: 

1. Some of the options in Start menu have an arrow marked in front of them. This 

arrow indicates that when you click the mouse on the option, a submenu will appear 

on the screen. 

2. Some of the options have few dots (…) marked in front of them. These dots 

indicate that when you click the mouse on the option, a dialog box will appear on 

the screen. 

3. Those options that neither have arrow nor dots marked in front of them get directly 

executed when you click the mouse on them. 

Quick Launch Toolbar 

As illustrated in figure 4.2, Quick Launch toolbar comprises of many buttons. Each button 

represents a program. When you click the mouse on any button, corresponding program 

gets executed. 

Task Manager 

Initially, Task Manager appears as blank area but when you execute any program, a button 

for that program gets created in this area. This button identifies the program and provides 

means for performing different operations on the running program. For example, using the 

button you could terminate the program. 

System Tray 

Initially system tray displays few icons and system time in it. Each icon of the system tray 

represents a program, which is invisibly running in the background. To operate upon a 

background program, you can double click the mouse on its icon. For example, to set the 

system date and time, you can double click the mouse on system time icon.  

INTRODUCTION TO WINDOW 

Windows operating system drives its name from the fact that each running program, in 

Windows appears in the form of a window. When you execute a program, a window 

appears on monitor screen. For example, when you execute WordPad program of Windows, 

WordPad window, as illustrated in figure 4.4 appears on monitor screen. 
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Figure 4.4 

Refer figure 4.4 and note that window comprises of many components. 

Role and function of each component of the window is given below. 

Title Bar 

Title bar acts as window header. It comprises of following items: 

System menu button : When you click the mouse on this button, 

system menu, as illustrated in figure 4.5 

appears on the screen. 

Program Name : Name of the program, with which window is related, appears in 

the title bar. This name identifies the windows. When you have 

many windows present on the screen, program name in title bar 

helps you in identifying the window. 

Minimize Button : It shrinks the window to a button, placed in task bar, when you 

click the mouse on it. 

Maximize Button : When you click the mouse on this button, window enlarges to 

the size of the monitor screen and the button gets converted to 

Restore button. When you click the mouse on Restore button, 

enlarged Window gets back to its original size. 

Close Button : When you click the mouse on this button, program terminates. 

Its window and task bar button, both get removed from the 

monitor screen. 

Bar Menu 

Bar menu appears as broad strip with multiple options in it. Each option has an underlined 

character in it. For example, File option has F character, underlined in it. When you select 

any option, a pull down menu (submenu) appears on the monitor screen. To select any 

option from the bar menu, either of the following operations could be performed: 

  Insertion 

Pointer

 Status Bar

Title Bar 

 Format Bar

Bar Menu

 Toolbar 

 Ruler 

Figure 4.5 
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1. Click the mouse on the option, which you wish to select. 

2. Press Alt key and underlined character key together. For example, to select File 

option, you could press Alt and F keys together. 

Toolbar 

Toolbar comprises of many buttons. Each button performs a specific task, when you click 

the mouse on it. For example, when you click the mouse on Save button, current contents 

get saved on the disk. When you rest the mouse pointer for some time on any button of the 

tool bar, its name appears on the monitor screen. 

Status Bar 

Status bar appears at the foot of the window. Relevant information, help messages, current 

activity status etc. get displayed in it. 

OPERATING UPON A WINDOW 

Any window that appears on the screen can be operated upon in many ways. Following are 

the operations that can be performed on a window. 

Moving The Window 

Window can be moved from one place to another on the screen by dragging it with its title 

bar and dropping it at the desired location.  

Changing The Size Of The Window 

Dragging the window by its border, changes its length, width or both. For example, if you 

place the mouse pointer on window's right borderline and drag it towards left/right, its 

width will decrease/increase. Similarly if you place the mouse pointer on top borderline 

and drag it above/below, its length will increase/decrease. If you wish to increase/decrease 

the length and width of the window simultaneously, in proportion, drag the window by 

placing the mouse pointer on any of its corners. 

Minimizing The Window 

To minimize a window, click the mouse on its Minimize button. When you do so, it shrinks 

to a button in Task Manager Area and gets removed from VDU. 

Restoring The Minimized Windows 

To restore a minimized window, right click the mouse on its button present in Task 

Manager Area. When you do so, a short cut menu, as illustrated in figure 4.5 appears on the 

monitor screen. 

Select "Restore" option from this menu. When you do so, minimized window returns back 

to its original status.  
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Maximizing The Windows 

To maximize a window, click the mouse on its Maximize button. When you do so, its size 

gets enlarged to the size of monitor screen and Maximize button gets converted into 

Restore button. 

Restoring The Maximized Windows 

To restore the maximized window, click the mouse on Restore button. When you do so, it 

returns back to its original size and Restore button gets converted into Maximize button. 

Closing The Windows 

To close the window and terminate the program, click the mouse on its Close button. 

GUI COMPONENTS OF WINDOWS 

Windows is Graphical User Interface (GUI) based operating system. While working with 

this operating system, you interact with the computer through many GUI components. A 

brief description of commonly used GUI components of Windows is given below. 

Program Icons 

All those icons that represent program are called Program icons. Some of the program icons 

are illustrated in figure 4.6. To run the program, you need to double click the mouse on its 

program icon. For example, to execute Date/Time program, you will have to double click 

the mouse on its icon. 

 

Figure 4.6 

Objects Icons 

All those icons that represent objects like devices, files, folders etc. are called object icons. 

Some of the object icons are illustrated below. 

Program Icons 
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  Represents Floppy drive. 

   Represents hard disk. 

   Represents a folder. 

     Represents executable file. 

    Represents non-executable files. 

     Represents data file. 

Bar Menu 

Bar menu appears in the form of a horizontal strip, with options written inside. A typical 

bar menu, is illustrated in figure 4.7.  

 

Figure 4.7 

To select an option from the bar menu, you need to either click the mouse on the option or 

press underlined key along with ALT key. For example, to select Edit option from the bar 

menu, you can either click the mouse on Edit option or press ALT and E keys together. 

This combination of ALT and underlined key is called hot key. 

Pull Down Menu 

Pull down menus appear as submenu, when you select an option from 

some other menu. For example, when you select any option (say Edit) 

from the bar menu, a pull down menu appears on the monitor screen. 

A typical pull down menu is illustrated in figure 4.8. 

To select an option from the pull down menu, you need to click the 

mouse on it. 

Popup Menu 

These menus appear as independent menus, when you click the left button of your mouse 

on some object. They automatically disappear when you click the mouse at some other 

place. For example, when you click the mouse on "Start" button, Start menu pops up as an 

independent menu. These menus do not appear everywhere but remain available at some 

special location. A popup menu is illustrated in figure 4.3. 

Figure 4.8 
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Shortcut Menu 

Shortcut menus appear when you right click the mouse. For 

example, when right click the mouse on desktop, a shortcut 

menu appears on the monitor screen. Such a shortcut menu is 

shown in figure 4.9. 

To select an option from the shortcut menu, you need to click 

the mouse on the option. When you select the option, 

corresponding activity takes place and popup menu 

disappears from the screen. 

Toolbars 

A row of small buttons, with icons in them forms a toolbar. Each button performs a specific 

task when you click the mouse on it. A typical toolbar is illustrated in figure 4.10. 

 

Figure 4.10 

To find out, what a button of toolbar does, rest the mouse pointer on the button for a while. 

Don't click on it, a label called tool tip will appear near the button. Generally labels are 

such that they give idea of button's function. 

Dialog Box 

A dialog box is special type of window that allows you to enter specifications for 

performing a task, as per your choice. For example, when you open a file, a dialog box, as 

illustrated in figure 4.11 appears on the screen. Using this dialog box, you can specify 

drive, folder, file name etc. of the file, which you wish to open. 

  

Figure 4.11 

Button 

 Drop Down List Box 

Horizontal 

Scroll Bar

 Text Box 

Vertical  

Scroll Bar 

List Box 

Figure 4.9 
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Text Box 

Text box consists of rectangular blank area, in which contents are typed. A typical text box 

is illustrated in figure 4.11. Note that the label written beside the text box gives the idea of 

the contents that are to be typed in text box. For example, the label "File name" indicates 

that the name of the file is to be typed in this text box. 

List Box 

A rectangular box, with many items in it, forms a list box. To select an item from it, you 

need to click the mouse on the item. A list box is illustrated in figure 4.11. 

Drop Down List Box 

Drop down list box is another type of list box that looks like a text box with a down 

pointing arrow on its right hand side. A list of options drops down when you click the 

mouse on the arrow. To select any option from this list, you need to click the mouse on it. 

A drop down list is shown in figure 4.11. 

Scroll Bar 

Whenever items to be displayed do not get accommodated in the given space, blank 

columns with arrow buttons at their end and a slider inside appear on the screen. These 

columns are called scroll bars. Vertical columns of such type are called vertical scroll bars 

and horizontal columns are called horizontal scroll bars. Horizontal scroll bar is illustrated 

in figure 4.11. Either by clicking the mouse on arrow buttons or by dragging the slider, you 

can display the items of the list, which are not being currently displayed on the screen. 

Buttons 

Rectangular labels, with some text written on them form buttons. Few buttons are 

illustrated in figure 4.11. When you click the mouse on the button, an action takes place. 

The text written on the buttons, generally gives an indication of the action, which will take 

place, when you click the mouse on it. For example, when you click the mouse on "Open" 

button, the file mentioned in the dialog box gets opened. 

Radio Buttons 

Group of at least two or more 

rounded buttons form radio 

buttons. Label written near 

buttons gives an indication 

of the type of 

data/information that will get 

selected when you click the 

mouse on it. Only one radio 

button, from the group can 

 

Figure 4.12 Radio Button 

Tab 

Check Box 



 

 

64    Computer Application For Engineering 

be selected. When you select a button, a black dot appears within the selected button. Radio 

buttons are illustrated in figure 4.12. 

Check Boxes 

Small square shaped buttons (could be one or more) form check boxes. Label written near 

the button gives an indication of the type of data/information that will get selected, when 

you click the mouse on it. When you select a check box, a tick mark gets placed within the 

check box. If you wish, you could select more than one check box from the group. Check 

boxes are illustrated in figure 4.12. 

Tab 

The shape of tab resembles the shape of half opened button. Tabs are basically the medium 

to display categorized information of different subjects in the same dialog box. Tabs are 

illustrated in figure 4.12. Each tab has some subject written on it. When you click the 

mouse on a tab, it gets selected and information or options related to the selected subject 

get displayed in the dialog box. 

Spinner 

A spinner consists of two arrow 

buttons and text box, with some value 

written into it. One arrow points up 

and the other points down. The value 

in the text box increases when you 

click the mouse on up arrow. When 

you click it on down arrow the value 

in the text box decreases. A typical 

spinner is illustrated in figure 4.13. 

Alert Boxes 

Alert box comprises of rectangular area with an icon, a message and few buttons in it. A 

typical alert box is illustrated in figure 4.14. Alert boxes generally appear to attract user’s 

attention in the event of some error or failure. Further course of action, which needs to be 

taken, is communicated to windows by clicking the mouse on any of the desired buttons. 

For example, if you exit Notepad program, without saving the contents on the disk, 

program will display an alert box, as illustrated in 

figure 4.14. Thus if you wish to exit without 

saving the contents, you will have to click the 

mouse on "No" button. On the other hand, if you 

wish to exit after saving the contents, you will 

have to click the mouse on "Yes" button. If 

somehow you wish to cancel the decision of 

exiting the program, you will have to click the 

mouse on "Cancel" button. 

 

Figure 4.14 

  

             Figure 4.13 

Spinner 
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WINDOWS APPLICATIONS  

Windows is a powerful operating system. It not only makes the computer functional, it also 

provides many useful programs using, which you can perform, different types of 

operations. Following are commonly used programs of Windows: 

Notepad This program is used for creating small text files. 

WordPad This program is used for creating large text files. It also provides 

many formatting options, using which the document could be 

formatted and made attractive. 

Paint It is basically a drawing and coloring program. Using this program, 

you can create shapes and drawings and color them with attractive 

colors. 

Calculator Using this program, you can use your computer as calculator and 

perform arithmetic and scientific calculations. 

Media Player Using this program, you can play audio and video files on your 

computer. 

Movie Maker Using this program, you can put graphical pictures in sequence and 

prepare multimedia presentations. 

Windows Explorer Windows Explorer is a program, using which file and folder 

maintenance activities are performed on computer. Creating new 

folders, deleting old folders, moving or copying files from one 

folder to another are the activities, which are easily performed with 

the help of Windows Explorer. 

Internet Explorer Internet Explorer is basically a browser, using which activities like 

net surfing, net search, e-mail etc. are performed. 

 

 

 EXERCISES                      CHAPTER 4 

 

Short Type Questions 

A. Select most appropriate answer for following questions: 

1. What is Windows? 

 (a) An operating system  (b) Computer hardware    

 (c) A command   (d) A program 

2. Which of the following is not applicable for Windows? 

 (a) GUI based     (b) Multi Tasking 

 (c) Object Embedding    (d) Multi user 
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3. Which of the following button will bring a maximized window to its original size? 

 (a) Minimize    (b) Restore  

 (c) Recover    (d) Start 

4. Which of the following is called Hot Key combination? 

 (a) ALT + Underlined word key (b) CTRL + Underlined word key 

 (c) Shift + Underlined key  (d) ALT + DEL keys 

5. Which of the following application could be used for file/folder maintenance on 
disk? 

 (a) Notepad    (b) WordPad 

 (c) Internet Explorer   (d) Windows Explorer   

B. Fill in the blanks: 

6. GUI stands for  …………………  …………….……   ………….....….. 

7. ...............……… is a feature of Windows, which enables multiple programs to run 
simultaneously. 

8. To move an object from one application to another, you will have to make use of   
……………………… and ............................... options of Windows. 

9. To copy an object from one place to another in document, you will have to make 
use of ............................. and ............................... options of Windows.   

10. ……………………………… is that place of a window, where the name of the   
application gets displayed. 

C. State, true or false for following statements: 

11. Windows is Graphical User Interface based operating system. 

12. Windows is multitasking operating system. 

13. If a graphics is embedded in a document then change in graphics will get 
automatically reflected in the picture, present in the document. 

14. Using Plug and Play feature of Windows you can copy a file from one folder to 
another folder. 

15. Shrink button of Windows, reduce the window to a button. 

D.  Answer the following questions in short: 

16. What is Windows?  

17. Which feature of Windows enables automatic loading of device driver, when a new 
device is plugged to the computer? 

18. Name any member of Windows operating systems series, which works as network 
operating system. 

19. Name that button of Windows, which enables you to work with Windows menu 
system. 

20. Name any two components that remain present on Windows desktop. 
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E. Differentiate between the following: 

21. Minimize and Maximize button of Windows. 

22. Radio buttons and Check boxes. 

23. List box and Drop down list box. 

24. Object Embedding and Object Linking. 

25. Popup menu and short cut menu. 

26. In which type of user interface, user has to type the command to interact with computer? 

 

Detailed Answer Type Questions 

E.  Answer the following questions in detail: 

27. What do you understand by the term GUI? Name any two GUI items of Windows. 

28. Explain the term multitasking. How it is related to Windows? 

29. Write two applications of CUT, COPY, PASTE features of Windows. 

30. Explain Drag and Drop feature of Windows, by taking a suitable example. 

31. Explain Plug and Play feature of Windows, by taking a suitable example. 

32. What Command Prompt feature of Windows does? 

33. How will you move a Window from one place to another? 

34. How will you change length and width of a window? If the window is to be enlarged 
in proportion, how will you do it? 

35. What is the role of Paint program in Windows? 

36. Write any two methods of selecting an options from the Bar menu. 

37. What do you understand by Object Embedding? Explain in detail. 

38. What do you understand by Object Linking? Explain in detail. 

 

 

   

PRACTICAL ASSIGNMENTS 

 

ASSIGNMENT 1  :  Getting Familiar With Windows Desktop.  

1. Switch on the computer and boot it with Windows operating system. When system gets 
booted, desktop will get displayed on monitor screen. Identity desktop icons, Start 
button, Quick Launch toolbar and System Tray. 

ASSIGNMENT 2  :  Working With  Desktop Icons. 

2. Move few icons on the desktop by dragging them to some other place. 
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3. Rearrange the icons, using following method:   

(i) Right click the mouse on some blank portion of the desktop. When you do so, a 
shortcut menu will appear on the screen. 

(ii) Select "Arrange Icon By" option from this menu. When you do so, another popup 
menu will get displayed on the screen. 

(iii) Select "Name" option from that menu. 

 This procedure will rearrange the icons on desktop. 

ASSIGNMENT 3  :  Familiarity With Multitasking Feature Of Windows . 

4. To get familiar with multitasking feature of Windows (i.e. executing many programs 
simultaneously), perform following operations:  

(i) Execute few programs, using different methods: 

(a) Double click the mouse on time that gets displayed in system tray. 

(b) Double click the mouse on "My Computer" icon present on desktop. 

(c) First click the mouse on "Start" button and then select any option from Start 
menu. 

(d) Click the mouse on any icon present in Quick Launch toolbar. 

 Each step mentioned above will invoke a program. All the programs thus 
invoked will be in running state. This clearly demonstrates multitasking 
feature of Windows. 

 Now right click the mouse at some blank space in Task Manager. When you 
do so, a shortcut menu will appear on the screen. Select "Tile Windows 
Horizontally" option from this menu. This process will arrange all the windows 
neatly on desktop.  

(ii) Now switchover from one program to another by either clicking the mouse on title 
bar of the window or by clicking the mouse on the corresponding button in Task 
Manager area. 

ASSIGNMENT 4  :  Operating Upon  Program Window. 

5. Select any window, present on the desktop and perform following operations on it. 

(i) Move the window. 

(ii) Decrease the width of the window. 

(iii) Increase the length of the window. 

(iv) Change length and width of the window in proportion, by dragging it by corner. 

(v) Maximize the window. 

(vi) Restore maximized window. 

(vii) Minimize the window 

(viii) Restore minimized window. 
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(ix) Arrange all the windows in cascading fashion by right clicking the mouse on some 
blank space of Task Manager and then selecting "Cascade Windows" option from 
the popup menu that appears thereafter. 

(x) Close the window. 

ASSIGNMENT 5 :  Working With  Date & Time Program . 

6. Perform following operations to set new date and time for system clock: 

(i) Invoke "Date and Time" program by clicking the mouse on "Start" button and then 
selecting "All programs/Control Panel/Date and Time" options from the menus 
and windows, which appear one after another. 

 When you do so, a dialog box, as shown in figure 4.13 will appear on the screen.  

(ii) Set new date and time using drop down list and spinners present in the dialog 
box. 

ASSIGNMENT 6:  Working With Notepad Program. 

7. Perform following operations to create small notes in Notepad program: 

(i) Invoke "Notepad"  Program by first clicking the mouse on "Start" button and them 
selecting "All Program/Accessories/Notepad" options  from the menus that appear 
one after the other. 

 When you do so, Notepad window, as shown in figure 4.14 will appear on monitor 
screen. 

 

 

 

 
Figure 4.14  
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(ii)  Enter following text in Notepad window: 

 

 

 

 

 

 

 

 

 

 

 

 

 

(iii) Select some portion of the text by dragging the mouse over it. 

(iv) Cancel the selection by clicking the mouse on unselected portion of the text. 

(vi)  Copy some portion of the text by using "Copy" and "Paste" options of Edit  
submenu. 

(v) Move some portion of the text by using "Cut" and "Paste" options of Edit 
submenu. 

(vi)  Cancel the effect of last operation by selecting "Undo" option from Edit submenu. 

(vii) Make use of "Replace" option present in Edit submenu for finding a given word 
and replacing it with another word. 

(viii) Save the text in a file. 

(ix) Make exit from Notepad program. 

 

ASSIGNMENT 7  :  Working With  Paint Program. 

8.  Perform following operations to make shapes and filling colors in them: 

(i)  Invoke Paint Program by first clicking the mouse on "Start" button and them 
selecting "All Program/Accessories/Paint" options from the menus that appear 
one after the other. 

 When you do so, Paint windows, as shown in figure 4.15 will appear on monitor 
screen. 

Computer is electronic equipment. It is mainly used for automating manual 

tasks.  

In offices computers are used for preparing letters, documents and reports. 

In hotels, computers are used for advance booking of rooms, preparing 

bills and providing other services.  

In railways computers are used for rail reservation, printing of tickets and 

preparation of reservation charts.  

Doctors use computers for diagnosing the illness and treatment of 

deceases.  

Architects use them for map designing and city planning. In meteorology 

department they are used for weather forecasting.  
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Figure 4.15  

(ii)  Drag the drawing area by handle. This will change the size of drawing area. 

(iii)  Click the mouse on "Line" tool and draw a line by dragging the mouse in drawing 
area. 

(iv) Draw another line of different thickness and color by selecting desired options. 

(v) Draw straight line. For this, press Shift key while dragging the  mouse. 

(vi) Draw an ellipse, by selecting "Ellipse" tool from tool box and dragging the mouse 
in drawing area. 

(vii) Draw a circle by selecting "Ellipse" tool from toolbox and dragging the mouse in 
the drawing area, with shift key pressed. 

(viii) Now first click the mouse on "Fill with color" button tool and then on green color 
swatch of color palette. At last, click the mouse within the circle that you had 
made in the last step. Circle will get filled with green color. 

(ix) Perform similar steps to draw shapes like rectangle, polygon etc. 

(x) Click the mouse on "Curve" tool and drag the mouse in spiral path. This action 
will make a spiral. 
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(xi) Make use of pencil tool and make few free hand drawings by dragging the mouse 
in drawing area. 

(xii) Click the mouse on "Brush" tool. Select the thickness of the brush. Select the 
color of the brush by clicking the mouse on desired color in color palette. Now 
drag the mouse in drawing area and make free hand drawing.  

(xiii) Select "Eraser" tool by clicking the mouse on it. Select the size of the eraser by 
clicking the mouse on desired thickness.  

 Now drag the mouse on the drawing. This action will erase the drawing. 

(xiv) Click the mouse on "Text" tool. Now drag the mouse in drawing area. This action 
will make a text box for writing the text. To type the text, click the mouse within 
the text box and start typing the text. 

9.  Now you are familiar with the process of drawing shapes in Paint program. So make a 
new drawing, which is shown in figure 4.16. 

 
Figure 4.16  

10.  Save the drawing in a file. 

11. Close Paint Program and come out of it. 

ASSIGNMENT 8  :  Working With  Windows Explorer. 

12. Perform file and folder related tasks by carrying out following operations:  

(i) Invoke Windows Explorer program by first right clicking  the mouse on "Start" 
button. When you do so, a popup menu will get displayed. Select  "Explorer" 
option from this popup menu. When you do so, Windows Explorer window, as 
shown in figure 4.17 will appear on monitor screen. 

 

Figure 4.17  
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(ii) Click the mouse on any folder in left pane of the window. Contents present within 
the folder will get displayed in the right pane. 

(iii) Click the mouse on "Desktop" icon, present in left pane of the window. 

(iv) Perform following steps to make a new folder on desktop: 

(a)  Right click the mouse on some blank space in right pane of the windows.  
When you do so, a popup menu will get displayed. 

(b)  First Select "New" option from this popup menu and then "Folder"   option 
from the menu, which appears thereafter. This will create a new folder with 
the name "New Folder" 

(c) Now type any desired name. Say you type "test". By doing so, a new folder 
with name, test will get created at desktop. 

(v) Drag a file icon and drop it on folder icon. When you do so, file will move to test 
folder. 

(vi) Undo the effect of Move operation by selection  "Undo" option from "Edit" 
submenu. 

(vii) Press Control key and repeat step (v). This process will copy the file in test folder  

(viii) Copy few more files into folder, using above mentioned procedure. 

(ix) To go into test folder, double click the mouse on its icon. When you do so, all the 
files present in it will get displayed in right pane. 

(x) To delete a file, right click the mouse on any icon. When you do so, a popup 
menu will appear on the screen. Select "Delete" option from this menu. 

(xi) To rename any file, right click the mouse on its icon. When you do so, a popup 
menu will appear on the screen. Select  "Rename" option from this menu and type 
the new name of the file. 

(xii) To come out of test folder, click the mouse on "UP" button present in toolbar of 
Windows Explorer window. When you do so, display in right pane will change. 

(xii) Now delete this folder by right clicking the mouse on it and selecting "Delete" 
option from the popup menu that gets displayed thereafter. 

 

**** 



UNIT - III 

 

 

 

 

 

Introduction To MS-Word   

INTRODUCTION 

Quite some time back, typewrites were very popular in offices, organizations and factories. 

They were used for preparing documents like letters, reports, memos etc. But ever since 

computers became popular, they replaced typewriters. Today the situation is that majority 

of organizations are using computers for their typing work. Advantages of using computers 

are many. Many typing related activities, which can be performed through computers, 

cannot be performed through typewriter. For example, including pictures with the text, 

checking spelling mistakes, reformatting the document after typing it etc. are few activities 

that cannot be performed in typewriters but can be very easily performed in computers. Use 

of computers for typing related activities is explained in this chapter. 

INTRODUCTION TO WORD PROCESSING 

In computer terminology, all typing related activities, such as setting the margins, typing 

the document, formatting the text, including different types of objects such as pictures, 

tables, charts etc. in the document, are called word processing. The software, using which 

such types of activities are performed on computer is called word processor. 

INTRODUCTION TO MS-WORD 

MS-Word is word processing software. It is mainly used for entering text into computer 

and formatting it in the form of letters, notes, memos or reports. MS-Word has been 

designed and developed by Microsoft Corporation of USA. It is GUI based, easy-to-use 

interactive software, which takes care of most of the typing related requirements. It 

provides numerous facilities to make the text entry easy and document attractive. Its 

operational details are described below. 

GETTING STARTED WITH MS-WORD 

For getting started with MS-Word, perform following steps after making sure that computer 

is booted with Windows operating system:  

5 CHAPTER 



 

 

Chapter 5 – Introduction To MS-Word   75

1. Click the mouse on "Start" button. When you do so, Start menu, as shown in figure 

5.1 (a) will appear on the screen. 

2. Select "All Program" option from this menu. When you do so, a submenu as shown 

in figure 5.1 (b) will appear on the screen. 

3. Select "Microsoft Word" option from this submenu. 

 

       

(a)                      (b) 

Figure 5.1 

When you do so, a window, as illustrated in figure 5.2, will get displayed on the screen.  

This window is called Word Window. 
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INTRODUCTION TO WORD WINDOW 

 

 

 

 

Figure 5.2 

Refer figure 5.2 and note that Word window comprises of many objects. Some of the 

objects like Title bar, Minimize button, Maximize button, System menu button, Bar menu 

etc. are common objects that remain present in each windows. These objects require no 

further explanation. But some of the objects are local to Word window. A brief introduction 

of such objects is given below. 

Standard Toolbar 

Standard toolbar comprises of many buttons. These buttons relate to frequently performed 

activities, which are performed while typing the text. To know, which button performs 

which activity, rest the mouse pointer on the button for a while. When you do so, a 

message, called tool tip will get displayed. Tool tip generally gives an indication of the 

activity that would get performed by the button. To perform any activity through a button, 

you need to click the mouse on that button. For example, when you click the mouse on 

"Save" button, typed text gets saved in a file.  

Format Toolbar 

Buttons for text formatting functions remain present in Format toolbar. For example, font, 

font size, font style etc. for the text can be set, using Format toolbar buttons. 
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Drawing Toolbar 

Different types of shapes, such as square, rectangle circle, ellipse, stars etc. can be drawn 

using Drawing toolbar buttons. 

Rulers  

Two rulers i.e. Horizontal ruler and Vertical ruler remain present in Word Window. Operations 

like, margin setting, paragraph indenting etc. are performed using different components of 

these rulers. Horizontal ruler and its components are illustrated in figure 5.3. 

 

 

 

 

 

 

 

Figure 5.3 

Role of each component of horizontal ruler is described below. 

Left And Right Margin Indicators 

These indicators are used for setting the respective margins of the document. For example, 

if Right Margin Indicator's position is set to one inch then the width of the left margin, for 

the whole document will be one inch. To change the width of the margin, you can drag the 

respective indicator to the desired place.  

Hanging Indent Marker 

Usually all the paragraphs of the document start from left margin but Hanging Indent 

Marker provides the facility to start the current paragraph from a different position. It could 

be dragged to a new position to define the starting place for the current paragraph. For 

example, if the right margin has been set to 1 inch  and Hanging Indent Marker has been 

positioned at 1.5 inch then all the paragraphs other than the current paragraph will start 

from 1 inch but the current paragraph will start  from 1.5 inch. 

First Line Indent Marker 

First line Indent Marker provides the facility to start the first line of the paragraph from a 

place other than that from where rest of the lines of the paragraph start. For example, all the 

lines of the paragraph may start from the left margin (say 1 inch) but first line for the 

paragraph may start from 1.5 inch from the left margin. To set the position of the first line 

of the paragraph, First Line Indent Marker can be dragged to the desired position. 
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Left Indent Marker 

Left Indent Marker facilitates simultaneous movement of First line Indent Marker and 

Hanging Indent Marker. When you drag it, both the markers move together in the same 

direction and by the same distance. 

Tab  

Tab button, present in horizontal ruler, facilitates setting of tab positions for the Tab key of 

the keyboard. To set the tab positions, first click the mouse on Tab button and then click it 

at the desired position in the ruler. This will put a mark in the ruler and set the tab position. 

When you press the tab key, insertion pointer will jump to the set tab position. For 

example, if you set the tab positions at 3, 5 and 7 inches then pressing the Tab key once 

will take the mouse pointer to a place 3 inches away from left margin. When you press it 

again it will move 5 inches away and if you press it again, it will move it by 7 inches. To 

remove a tab position, drag the tab mark and drop it off the ruler. 

Status Bar 

A clear view of status bar is illustrated in figure 5.4. Status bar displays the status of the 

current document.  

 

 

 

 

 

 

 
 

 

Figure 5.4  

Refer figure 5.4 and note that there are four view mode buttons in Status bar. These buttons 

are used for switching over from one mode of display to another. To switch over to desired 

mode, click the mouse on corresponding button. 

Information like, total number of pages in the document, current page number, current line 

number, current character position etc. also get displayed in the status bar. 

Type Area 

The blank white space, present in the Word window is called Type Area. Whatever you 

type gets typed in this area. 
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Insertion Pointer 

A small blinking vertical line initially appears at the beginning of the type area. It is called 

Insertion Pointer. It basically indicates current position in the document. Whatever you 

type from the keyboard, gets entered at current insertion pointer position. 

PAGE SETUP 

Before typing the text, page specifications like, page size, width of the margins, header 

footer distance etc. need to be decided, so that typed text gets accommodated accordingly. 

Perform following steps to decide the page specifications: 

1. Select "File" option from the bar menu. When you do so, File submenu, as shown in 

figure 5.5 will appear on the screen. 

2.  Select "Page Setup..." option from File submenu. On selecting this option, a dialog 

box, as shown in figure 5.6, will appear on the screen. 

    

            Figure 5.5                                           Figure 5.6 

3. Using different objects like spinners, text boxes, radio buttons, tabs etc. present in 

the dialog box, enter values for all required settings. 

4. At last click the mouse on "OK" button. 

When you do so, page setup will change as per values entered above and whatever you type 

from the keyboard will get arranged on the page, accordingly. 

ENTERING THE TEXT 

When you press any key of the keyboard, character gets typed at current cursor position. 

Thus by pressing different keys of the keyboard, you can type the complete letter, 

document, or report. 

While entering the text, when insertion pointer reaches the right margin, it automatically 

gets placed in first column of the next line. When current VDU screen becomes full of text, 
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document automatically shifts upwards (this process is called scrolling) and blank line 

appears at the bottom of the screen, where you can further enter the text. 

When current page becomes full, insertion pointer gets automatically placed at the 

beginning of the next page. Thus, continuing in this way, you can enter the text, page after 

page. 

While entering the text, you can always make use of Del and Backspace keys to erase 

characters, words or sentences. 

To insert the text in between two characters, words, sentences or paragraphs, click the 

mouse at the place where the text is to be inserted. When you do so, insertion pointer will 

get placed there. Now whatever you type will get typed in between and the text on the right 

hand side will automatically shift. 

To overwrite on already entered text, first double click the mouse on OVR button of status 

bar and then type the text. To come out of Insert mode, double click the mouse on the same 

button again. 

To start a new paragraph, press Enter key.  

SAVING THE TEXT IN A FILE 

Perform following steps to save the text in a file: 

1. Select "File" option from bar menu. When you do so, File submenu, as shown in 

figure 5.5 will appear on the screen. 

2.  Now select "Save" option from 

File submenu. When you do so, 

a dialog box, as shown in figure 

5.7, will appear on the screen. 

3.  Select the drive and the folder 

in which the file is to be saved. 

4. Enter the name of the file in 

"File Name" text box. 

5. Click the mouse on "Save" 

button. 

When you do so, current text will get 

saved on the selected disk, in specified 

folder and file. 

CLOSING THE FILE 

Perform following steps to close currently opened file: 

1. Select "File" option from the bar menu. When you do so, File submenu, as shown in 

figure 5.5 will appear on the screen. 

2. Select "Close" option from File submenu.  

 

Figure 5.7 
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 If no additions or modifications 

have been made in the document, 

ever since it was last saved, file 

will get closed. On the other 

hand, if they were made, an Alert 

box, as shown in figure 5.8, will 

appear on the screen. 

3. Click the mouse on "Yes" button 

if you wish to save the additions and modification on the disk. Select "No" button 

for not saving them. If you wish to cancel the idea of closing the file, click the 

mouse on "Cancel" button. 

You are now familiar with the method of defining the page layout, entering the text and 

saving it in a file. Whatever text you save in the file, remains permanently available for use.  

OPENING AN EXISTING DOCUMENT 

Following are the steps for opening an existing file: 

1. Select "File" option from the Bar 

menu. When you do so, File 

submenu, as shown in figure 5.5 

appears on the screen. 

2. Select "Open...." option from 

File submenu. On selecting 

this option, a dialog box, as 

shown in figure 5.9, will 

appear on the screen. 

3. Make use of various GUI 

objects present in this dialog 

box and select disk, folder and 

the file, in which the contents 

exist. 

4. At last, click the mouse on "Open" button. On doing so, contents of selected file 

will get displayed in Word window. 

EDITING OPERATIONS 

After opening the file you may wish to make few modifications in it. For example, you may 

wish to delete few lines or you may wish to copy a part of the text from one place to 

another or you may wish to move few lines of paragraphs from here to there. For 

performing all such types of editing operations, you will have to first select the text on 

which you wish to perform the operation. MS-Word provides different mechanisms for 

selecting different portions of the text. They are explained below.  

Figure 5.8 

 

Figure 5.9 
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Selecting The Text  

For selecting different parts of the document, perform actions, as mentioned below. 

    Sr.  To  Select           Action 

No 

1. A word Double click on the word. 

2. A portion of the text Drag the mouse over the text that is to be selected. 

3. A graphic picture Click the mouse on the picture.  

4. A line  Click the mouse on the left hand side of that line.  

5. Multiple lines Drag the mouse vertically in the left margin, starting 

from the first line to the last line of the selection. 

6. A sentence Hold down the CTRL key and click the mouse 

anywhere in between the sentence that is to be 

selected.  

7. A paragraph Triple click anywhere in-between the paragraph.  

8. Multiple paragraphs Drag the mouse pointer in the left margin. 

9. Entire document Triple click in the left margin. 

10. A vertical block of text Hold down ALT key and drag the mouse Up/Down 

and left/ right, covering the vertical block. 

To cancel the selection, either click the mouse anywhere in the document or press any 

arrow key of the keyboard. 

Selecting The Entire Text 

Perform following steps to select the entire text: 

1. Select "Edit" option from the bar menu. When you do so, 

"Edit" submenu, as shown in figure 5.10, will appear on 

the screen.  

2. Select "Select All" option from Edit submenu. 

When you do so, complete text will get selected. 

Deleting Text 

Different parts of the text can be deleted differently. Various 

deletion operations are explained below.  

1. To delete a word after the insertion pointer, press CTRL 

and DEL keys together. 

2.  To delete a word before the insertion pointer, press CTRL 

and Backspace keys together. 

 

Figure 5.10 
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3.  To delete a desired portion of text (either text or graphics), select it, using any of 

the methods mentioned above and then press DEL key. 

Copying The Text 

Perform following steps to copy a portion of text to some other place in the document: 

1. Select the text you wish to copy. 

2. Select "Edit" option from the bar menu. On doing so, "Edit" submenu, as illustrated 

in figure 5.10, will appear on the screen.  

3. Select "Copy" option from this submenu. 

4. Now take the insertion pointer to the place, where you wish to copy the selected 

text. 

5. Select "Edit" option again from the bar menu and get Edit submenu, as illustrated in 

figure 5.10, on the screen. 

6. Now select "Paste" option from this submenu. 

When you do so, selected text will get copied at current insertion pointer's position. 

Moving The Text 

Perform following steps to move a portion of text from it's original place to some other 

place in the document: 

1. Select the text that you wish to move to other location of 

the document. 

2. Now right click the mouse on selected portion. When you 

do so, a popup menu, as shown in figure 5.11 will appear 

on the screen. 

3. Select "Cut" option from this menu. 

4. Now right click the mouse at that place of the document, 

where the text is to be moved. When you do so, popup 

menu, as shown in figure 5.11, will reappear on the 

screen. 

5. Select "Paste" option from this menu. 

When you do so, selected text will shift its place from its original position to current 

insertion pointer's position.  

OFFICE CLIPBOARD 

When you perform cut or copy option, the selected text gets copied into specific portion of 

computer's memory, called Clipboard. When you perform these operations again, previous 

contents of clipboard get lost. If you wish to retain these contents so that you could use 

them later, you can make use of Office Clipboard feature of MS-Word.  

Perform following steps to make Office Clipboard feature on: 

 

Figure 5.11 
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1.  Select "View" option from the bar menu. When you do so, View submenu, as 

shown in figure 5.16, will appear on the screen.  

2. Select "Toolbar" option from View submenu. When you do so, another submenu 

will appear on the screen.  

3. Select "Clipboard" option from this submenu. When you do so, a clipboard panel 

will get displayed. For each Cut/Copy operation that you perform, an icon for it will 

get made in it.  

3.  To paste any clipboard content at current insertion pointer's position, click the 

mouse on its icon, present in clipboard panel. 

FINDING THE GIVEN WORD IN THE TEXT 

Perform following steps to search the presence of a given word:   

1. Select "Edit" option from the bar menu. When you do so, Edit submenu, as shown 

in figure 5.10, will appear on the screen. 

2. Select "Find..." option 

from this submenu. On 

selecting this option, a 

dialog box, as shown in 

figure 5.12, will appear 

on monitor screen. 

 3.  Enter the word that you 

wish to find in "Find 

what" text box. For 

example, if you wish to 

search the word "Dynamic", enter "Dynamic" in "Find what" text box. 

4. If more details, related to search need to be specified, click the mouse on, "More" button. 

When you do so, more options related to search, as shown in figure 5.13 will appear 

within the dialog box. 

5.  Using "Search" drop down 

list, specify the direction of 

search as All, Down or Up.  

6.   If you wish that MS-Word 

should differentiate between 

upper case letters and lower 

case letters, check "Match 

Case" check box. For example, 

when you check this check 

box, MS-Word will treat 

Dynamic, DYNAMIC and 

dynamic as 3 different words. 

 
Figure 5.12 

 

Figure 5.13 
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7.   If complete word match is to be found, check "Find Whole Word Only" check box. 

In such cases partial matches will not be reported as found. For example, say you 

are searching the word "garden" then it will not be reported found, when MS-Word 

comes across, the word "gardener". 

8. To perform the search according to the parameters defined above, click the mouse 

on "Find Next" button. 

When you do so, MS-Word will search the first occurrence of the specified word and 

temporarily halt the search there and highlight the word in the text. Clicking the mouse on 

"Find Next" button again will search the next occurrence. Following this procedure, search 

can be continued for finding other occurrences of the same word. 

REPLACING THE WORD WITH ANOTHER WORD 

For finding the occurrence of a word and replacing it with another word, MS-Word 

provides replace facility. Replacement of a word using this facility can be done as 

mentioned below: 

1. Select "Edit" option from the bar menu. When you do so, Edit submenu, as shown 

in figure 5.10, will appear on the screen. 

2. Select "Replace..." option from 

Edit submenu. When you do so, a 

dialog box, as shown in figure 

5.14, will appear on the screen. 

3. Enter the word that is to be 

replaced, in "Find What" text box. 

For example, if the word 

"Dynamic" is to be replaced with 

other word, enter "Dynamic" in the 

text box.   

4. Enter the new word in "Replace 

with" text box. For example, if you 

wish to replace the word 

"Dynamic" with the word 

"Energetic", enter "Energetic" in "Replace with" text box. 

5. If you wish to specify more details related to replacement, click the mouse on 

"More" button. When you do so, other options, as shown in figure 5.14, will appear 

on the screen. 

6. For replacing the single occurrence of the word, click the mouse on "Replace" 

button and for changing all the occurrences in one-go, click it on "Replace All" 

button. 

At the end of replacement operation, "Cancel" button automatically changes to "Close" 

button. By clicking the mouse on "Close" button, you can close the search operation and 

return back to the document. 

 

Figure 5.14 
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GOING TO A SPECIFIC LOCATION 

Perform following steps to go to a specific location of the document. This location could 

either be a given page number, line or table etc. 

1. Select "Edit" option from the bar menu. When you do so, Edit submenu, as shown 

in figure 5.10, will appear on the screen. 

2. Select "Go To..." option from this submenu. On selecting this option, a dialog box, 

as shown in figure 5.15, will appear on monitor screen. 

  

Figure 5.15 

3.  Select the name of the item on the basis of which you would like to change your 

position, from "Go to what" list box. For example, say you select "Page" option 

from this list box.   

4. Enter the details of movement in edit box. For example, if you selected "Page" option 

in the previous step, enter page number, to which you wish to go, in the text box.  

5. At last click the mouse on "Go To" button. 

When you will do so, you will be taken to aforementioned place of 

the document. 

VIEWING THE DOCUMENT IN DIFFERENT 

WAYS 

The document that you have typed in MS-Word can be viewed in 

different ways. Perform following steps to display it in some other 

fashion: 

1. Select "View" option from the bar menu. When you do so, 

View submenu, as shown in figure 5.16 will appear on 

monitor screen.  

2. Select either "Web Layout" or "Print Layout" or "Outline" 

or "Full Screen" option from view submenu.  

When you do so, current document will get displayed accordingly. 

Which option will display the document in which fashion, is shown in figure 5.17 

 

Figure 5.16 
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Normal View    Web Layout View 

     

       Print Layout View      Outline View 

Figure 5.17 

Displaying Toolbars 

MS-Word offers many classified toolbars for performing different class of operations. 

Some of the toolbars, by default, remain visible within MS-Word window, while others 

remain invisible. Any toolbar can be made visible or invisible on the screen by performing 

following steps:  

1. Select "View" option from the bar menu. When you do so, View submenu, as 

shown in figure 5.16 will appear on the screen.  

2. Select "Toolbars" option from View submenu. When you do so, another submenu, 

as shown in figure 5.18 will appear on monitor screen.  
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3. To make a toolbar visible, select its name from this 

submenu. For example, if you wish to make Picture toolbar 

visible, select "Picture" option from this submenu. 

Note that selection procedure, mentioned above, acts like toggle 

switch. That means if the toolbar is visible, it will make it invisible. 

If it is invisible, it will make it visible.  

Header And Footer 

Header or Footer is item like text, graphic or number, which is 

printed on top or bottom of every page of the document, 

respectively. Perform following steps to introduce them in the 

document:  

1. Select "View" option from the Bar menu. When you do so, 

View submenu, as shown in 5.16, will appear on the screen. 

2. Select "Header and Footer" option from View submenu. 

When you do so, header and footer toolbar along with 

Header/Footer edit box, as shown in figure 5.19, will appear 

on the screen.  

 

Figure 5.19 

3. Whether the forthcoming entry will be for header or footer, define that by clicking 

the mouse on "Switch Between Header and Footer" button, as it alternates between 

them. 

4. Enter header/footer text in the respective area. 

5. If you wish to include current date or time as header or footer, click the mouse on 

respective buttons present in "Header and Footer" toolbar. 

6. To include the page number, take the insertion pointer to that place, where you wish 

the page numbers to appear and then click the mouse on "Page Number" button, 

present in "Header and Footer" toolbar. 

7. Generally the page numbers start from 1 and are numbered as 1, 2, 3 etc. In case 

you want them to start from some other number or want them to appear in different 

format, such as (a, b, c etc.), click the mouse on "Format Page Number" button. 

When you do so, another dialog box will appear on the screen. Define all the 

options of your choice through that dialog box. 

8. At last click the mouse on "Close" button. 

When you do so, defined header, footer page numbers etc. will be visible in the pages. 

  

Figure 5.18 
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ZOOMING THE DOCUMENT 

Contents of the page can be magnified or squeezed as per requirement by performing the 

following steps: 

1. Select "View" option from 

the bar menu. When you do 

so, View submenu, as shown 

in figure 5.16 will appear on 

the screen.  

2. Select "Zoom" option from 

View submenu. When you do 

so, a dialog box, as shown in 

figure 5.20 will appear on 

monitor screen.  

3. Select desired option from 

this dialog box. For example, 

if you wish to 2 times zoom 

the document, select "200%" 

option. If you wish to display 

multiple pages in the same 

space, select "Many pages" 

option. 

When you do so, display will change accordingly. 

FORMATTING THE DOCUMENT 

Formatting the document means arranging the contents of the document (such as text, 

graphics etc.), in such a way that the document looks attractive. For example, changing the 

font, font size, line spacing, paragraph spacing etc. are the activities, which fall into the 

category of formatting. How formatting operations are done in MS-Word, is explained 

below. 

Changing The Font, Font Style, Font Size Etc. 

Perform following steps to change font, font style, font size etc. either for the whole 

document or selected part of the text: 

1. Select the text, for which font related changes are to be done.  

2. Select "Format" option from the Bar menu. When you do so, "Format" submenu, as 

shown in figure 5.21(a) will appears on the screen.  

3. Select "Font" option from Format submenu. When you do so, a dialog box, as 

shown in figure 5.21 (b) will appear on the screen. 

 

Figure 5.20 



 

 

90    Computer Application For Engineering 

         

     (a)               (b) 

Figure 5.21 

4. Select font name, font style, font size, font color etc. from the respective list boxes. 

5. If the selected text is to be made bold, italic, underlined etc. select respective 

options. 

6. At last, click the mouse on "Ok" button.  

When you do so, font related changes will get done in selected text.    

Aligning The Paragraph 

Perform following steps to align a paragraph: 

1. Select the paragraph, which is to be aligned.  

2. Select "Format" option from the bar menu. 

When you do so, "Format" submenu, as shown 

in figure 5.21(a) will appear on the screen.  

3. Select "Paragraph" option from Format 

submenu. When you do so, a dialog box, as 

shown in figure 5.22, will appear on the 

screen. 

4. Using "Alignment" drop down list, of this 

dialog box, select the type of alignment that 

you wish to apply to the paragraph. For 

example, if you wish to right aligned the 

paragraph, select "Right" option from 

Alignment drop down list. 

 

Figure 5.22 
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5. At last click the mouse on "OK" button. When you do so, selected text will get 

aligned accordingly.  

When you do so, selected paragraph will get aligned as per options chosen, during the 

process. Visual appearance of all types of paragraph alignments is shown in figure 5.23. 

 

 

 

 

 

 

 Left Aligned  Right Aligned Center Aligned Justified 

(a) (b) (c) (d)  

Figure 5.23 

Bullets And Numbering 

In MS-Word, text can also be formatted in the form of lists. Number list and Bulleted lists, 

shown below are examples of such lists: 

       

 

 

 

    

Perform following steps to format the text in the form of list: 

1. Enter each item of the list in separate line. 

2. Select all the items, by dragging the mouse over them. 

3. Select "Format" option from the bar menu. When you do so, Format submenu, 

as shown in figure 5.21(a), will appear on the screen. 

4. Select "Bullets and Numbering" option from this submenu. When you do so, a 

dialog box, as shown in figure 5.24 will appear on the screen. 

5. If you wish to format the text as Bulleted list, click the mouse on "Bulleted" 

tab. If you wish to format it as "Numbered" list, click the mouse "Numbered" 

tab. When you do so, various options for specifying other details of the list will 

appear within the dialog box. Select the desired option. 

 

On Monday 

evening we 

decided that we all 

will go to see a 

movie. All the 

friends agreed at 

once. 

 

On Monday 

evening we 

decided that we all 

will go to see a 

movie. All the 

friends agreed at 

once. 

 

On Monday 

evening we 

decided that we all 

will go to see a 

movie. All the 

friends agreed at 

once. 

 
On Monday 

evening we decided 

that we all will go 

to see a movie. All 

the friends agreed 

at once. 

• Hardware  

• Software 

• Firmware 

• Users 

Bulleted List 

1. Hardware  

2. Software 

3. Firmware 

4. Users 

Numbered List 
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6. If you wish to put graphic bullets in the list, click the mouse on "Picture" 

button. When you do so, many graphic bullets will appear in the dialog box. 

Select the desired bullet and click the mouse on "OK" button. 

7. At last, click the mouse on "OK" button. 

When you do so, selected lines of text will get converted to Bulleted list or Numbered list, 

as the case may be. 

Removing Bullets Or Numbers 

from The List 

To remove numbers or bullets from existing 

Numbered list or Bulleted list, select the list 

and get the dialog box shown in figure 5.24 on 

the screen. Now select "None" option and 

click the mouse on "OK" button. This will 

convert lists into plain text. 

Introducing Borders And Shading 

Perform following steps to introduce borders 

around the selected text and shading in it:  

1. Select the text, around which the 

border is to be introduced.  

2. Select "Format" option from the bar menu. When you do so, Format submenu, as 

shown in figure 5.21(a), will 

appear on the screen.  

3. Select "Borders and Shading..." 

option from Format submenu. 

When you do so, a dialog box as 

shown in figure 5.25, will appear 

on the screen. Somehow, if the 

options being displayed within the 

dialog box are different, click the 

mouse on "Borders" tab.  

4. Select the border type, mentioned 

under "Setting" section of this 

dialog box. Somehow, if the 

border is to be removed, select 

"None" option. 

5. Select the style, color and width or the line, using which the border is to be made, 

through "Style", "Color" and "Width" drop down list boxes respectively.  

 

Figure 5.24 

 

Figure 5.25 
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Introducing Shading 

6. Click the mouse on "Shading" tab. 

When you do so, options shown 

within the dialog box will change as 

shown in figure 5.26.  

7. Select the color, using which the 

background of the border is to be 

shaded. If somehow shading is to be 

removed, select "No Fill" option.  

8. Select pattern of the color, using 

"Style" drop down list box. 

9. At last, click the mouse on "Ok" 

button.  

When you do so, border with selected colored background, will get introduced around the 

selected text. 

Columns 

Instead of text running in straight lines from left margin to right margin, it can be arranged 

in columns, as is done in newspapers and magazines.  Perform following steps to arrange 

the text in multiple columns: 

1. Select the text that is to be arranged in  columns. 

2. Select "Format" option from 

the bar menu. When you do 

so, "Format" submenu, as 

shown in figure 5.21(a) will 

appear on the screen.  

3. Select "Columns" option from 

Format submenu. When you 

do so, a dialog box, as shown 

in figure 5.27, will appear on 

the screen. 

4. Select the number of columns 

that have to appear across the 

width of the page by clicking 

the mouse on desired option 

present in "Preset" section of 

this dialog box. 

5. Select the width of the column 

and spacing between the columns, using respective spinners present in this dialog box. 

 

Figure 5.26 

 

Figure 5.27 
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6. At last, click the mouse "Ok" button. When you do so, text will get arranged in 

columns.  

To remove the columns and arrange the text in normal fashion, perform above mentioned 

procedure again but select single column option this time, while selecting the number of 

columns for the page.  

Case Conversion 

Perform following steps to make case related conversions in the typed text:  

1. Select the text, in which case conversion is to be done.  

2. Now select "Format" option from the Bar menu. When you do so, Format submenu, 

as shown in figure 5.21(a), will appear on the 

screen. 

3. Select " Change Case…" option from Format 

submenu. When you do so, a dialog box, as shown 

in figure 5.28 will appear on the screen. 

4. Select the desired option from this dialog box and 

click the mouse on "OK" button. 

When you do so, case of the selected text will change 

accordingly. The effect of each type of case conversion is 

shown in figure 5.29. 

Option Example Remark 

Original Text good Morning  

Sentence case Good Morning First character of sentence gets converted into 

capital letter. 

Lower case good morning All alphabets get converted to lower case. 

Upper case GOOD MORNING All alphabets get converted to upper case. 

Title case Good Morning First alphabet of each word gets converted to 

upper case. 

tOGGLE cASE  GOOD mORNING  

 

 

Lower case alphabets get converted to upper 

case and upper case alphabets get converted to 

lower case 

Figure 5.29 

Changing Background 

The text that you type is generally written on white background. If you wish, you can 

change the white background to colored background, by performing following steps: 

Figure 5.28 
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1. Select "Format" option from the bar menu. When you do 

so, "Format" submenu, as shown in figure 5.21(a) will 

appear on the screen.  

2. Select "Background" option from Format submenu. When 

you do so, a color swatch, as shown in figure 5.30, will 

appear on the screen. 

3. Select the color from this swatch by clicking the mouse 

on desired color.  

When you do so, the background for the whole document will 

change. 

Page Breaks 

When you enter the text in MS-Word and the current page becomes full, it automatically 

introduces a page break, called soft page break. It takes the mouse 

pointer to the beginning of the next page, so that whatever you type 

now, gets typed on the next page. Apart from soft page breaks, you 

can also introduce additional page breaks, at any desired location of 

the document. These page breaks are called hard page breaks. 

Perform following steps to introduce a hard page break, at desired 

location: 

1. Position the insertion pointer, at the place, where you wish to 

introduce the page break. 

2. Select "Insert" option from the Bar menu. When you do so, 

Insert submenu, as illustrated in figure 5.31, will appear on 

the screen. 

3. Select "Break..." option from Insert submenu. On selecting 

this option, a dialog box, as shown in figure 5.32, will appear 

on monitor screen.  

4. Select  "Page Break" option from this dialog box. 

5. At last, click the mouse on "OK" button. 

When you do so, this Page break will appear like dotted line, in the 

Normal view mode. 

All types of page breaks appear as thick line in Print Layout 

View mode.  

To remove hard page break, select the page break in Normal 

view mode by clicking the mouse on it and then press Backspace 

or Del key. 

Inserting Page Numbers 

Each page of the document can bear a unique number. Perform 

Figure 5.31 

 

Figure 5.32 

 

Figure 5.30 
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following steps to introduce page numbers in the document: 

1. Select "Insert" option from the Bar menu. When you do so, Insert submenu, as 

shown in figure 5.31, will appear on the screen. 

2. Select "Page numbers..." 

option from this submenu. 

When you do so, a dialog box, 

as shown in figure 5.33 will 

appear on the screen.  

3. Using "Position" drop down 

list box, select the position of 

the page number. Note that 

either it could be "Top of 

page" or it could be "Bottom 

of Page". 

4. Using "Alignment" drop down list, select the alignment of the page number. Note 

that page number could either appear at the center of the page or on the left hand 

side of the page or on the right hand side. 

5. If you wish that page number should not appear on the first page of the document, 

uncheck  "Show number on first page" check box. 

6. At last, click the mouse on "OK" button. 

When you do so, page numbers will appear accordingly, in the document. 

Inserting Date And Time  

Perform following steps to insert system date and 

time at some place of the document: 

1. Click the mouse at that place of the 

document, where current system date and 

time is to be inserted.  

2. Select "Insert" option from the Bar menu. 

When you do so, Insert submenu, as 

shown in figure 5.31, will appear on the 

screen. 

3. Select "Date and Time" option from 

Insert submenu. When you do so, a dialog 

box, as shown in figure 5.34 will appear 

on the screen. 

4. Select from this dialog box, the format, in which date and time are to be inserted. 

5. If you wish that current date and time should keep on changing with time, check 

"Update Automatically" check box.  

 

Figure 5.33 

 

Figure 5.34 
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6. At last, click the mouse on "Ok" button. 

When you do so, current system date and time will get inserted at current cursor position.  

INSERTING SYMBOLS IN THE TEXT 

MS-Word provides the facility to introduce even those characters in the document for 

which there is no corresponding key on the keyboard. Such characters are called symbols. 

For example, Trade Mark (™), Copyright (©) mark etc. are examples of symbols. To 

introduce a symbol in the document, 

perform the following steps: 

1. Place the insertion pointer at the 

place, where the symbol is to be 

introduced. 

2. Select "Insert" option from the 

Bar menu. When you do so, 

Insert submenu, as shown in 

figure 5.31 will appear on the 

screen. 

3. Select "Symbol…" option from 

Insert submenu. When you do 

so, a dialog box, as shown in 

figure 5.35, will appear on the 

screen 

4. Select the symbol of your choice by clicking the mouse on the symbol. 

5. At last, click the mouse on "Insert" button. 

When you do so, symbol will get introduced at current insertion pointer position. 

INSERTING OTHER OBJECTS IN THE DOCUMENT 

Objects like comments, footnotes, captions, pictures, text boxes etc. can be inserted at any 

desired place in the document. Perform following steps to introduce them:  

1. Click the mouse at that place of the document, where any of the objects, mentioned 

above, is to be inserted.  

2. Select "Insert" option from the bar menu. When you do so, Insert submenu, as 

shown in figure 5.31, will appear on the screen. 

3. Select the name of the object from Insert submenu. When you do so, a dialog box, 

for getting other details of the object from you, will appear on the screen. 

4. Provide those details.  

5. At last, click the mouse on "Ok" button. 

When you do so, the object will get inserted at current cursor position.  

 

Figure 5.35 
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SPELLING AND GRAMMAR CORRECTION 

It is likely that while typing the document, few spelling or grammar mistakes may go 

unnoticed into the document. It is always desirable to correct all the mistakes before the 

document is finalized. One method of finding the spelling and grammar mistakes is the 

manual method, in which the whole document is read again. Obviously this method doesn't 

guarantee 100% correctness. It is possible that the person reading the document may 

overlook some of the mistakes or he himself many not know the correct spelling. Thus 

mistakes may still persist in the document. To overcome this problem and ensure 100% 

correctness, MS-Word has automated the process of finding spelling and grammar mistakes 

and correcting them. It is implemented in two different forms: 

� Spell checker 

� On-line spell checker 

Description of these facilities is given below: 

WORKING WITH SPELL CHECKER 

Perform following steps to check and correct the spelling mistakes in the document:  

1. Open the document, in which spelling mistakes have to be found and corrected.  

2. Select "Tools" option from the bar menu. When you do so, Tools submenu, as 

illustrated in figure 5.36, will appear on the screen. 

3. Select "Spelling and Grammar" option from Tool submenu. On selecting this 

option, a dialog box, as shown in figure 5.37, will appear on the screen. 

         

   Figure 5.36           Figure 5.37   

Wrong Spelling 

displayed here 
Suggestions 

made here 
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Note that there are many buttons in this dialog box. Explanation of these buttons is given 

below.  

Ignore & Ignore All Buttons 

While performing spelling check, few words like colour, Rakesh, centre etc.  may be 

reported as spelling mistakes. To retain such type of errors, you need to make use of 

"Ignore" button. 

Ignore button ignores current word only. If the same spelling appears again, it is again 

reported as error. But instead of making use of "Ignore" button, if you select "Ignore All" 

button, all the reappearances will be automatically ignored. 

Change And Change All Buttons 

A list of correct spellings, for currently misspelled word gets displayed in  "Suggestions" 

list box.  If you wish, you can either choose a suggestion from that list or you can reenter 

the word. Be it any case, to incorporate the change, you need to click the mouse on 

"Change" button. Note that this replacement occurs only for currently misspelled word.  If 

same spelling mistake appears again, above mentioned procedure has to be repeated.  On 

the other hand, if same replacement is to be done throughout the document, you need to 

make use of "Change All" button. 

Add Button  

Any word, which is correct and (and is being reported as spelling mistake) is not present in 

the dictionary, can be added to the dictionary by selecting "Add" button. The word can 

either be added to the main dictionary, named, CUSTOM.DIC or any other personal 

dictionary.  

Auto Correct Button 

"Auto Correct" button adds currently done correction in "Auto Correct" list so that next 

time when you enter the wrong spelling, it gets automatically corrected. 

Options Button 

Using this button, various parameters like the choice of dictionary, capitalization of words 

etc. can be set for checking the spellings.  

Undo Button 

The last spelling correction made, can be undone by selecting "Undo" button. 

Cancel Button 

Using this button, you can come out of spell checker.   

ACTIVATING ON-LINE SPELL CHECKER 

On-line spell checker is a facility, using which the spelling of a word is checked as soon as 

it is typed. If the spelling is found incorrect the word is underlined with red zigzag line.  If 

you wish, it could also suggest correct spellings for this word. Note that On-line spell 
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checker marks incorrect spellings, only when it is made on. To switch it on, follow the 

following steps: 

1. Select "Tools" option from the Bar menu. When you do so, Tools submenu gets 

displayed on the screen. 

2. Select "Options" option from this 

submenu. When you do so, a 

dialog box, as illustrated in 

figure 5.38, will appears on the 

screen. 

3. Check "Check Spellings as you 

type" check box. 

4. Now select "OK" button. 

When you do so, On-line spell checker 

gets activated.  Now, whenever you type 

a misspelled word, red colored zigzag 

line automatically underlines it. 

To correct the spelling, right click the 

mouse on wrong spelling. When you do 

so, a popup menu containing the list of 

suggestions, appears on the screen. 

Correct spelling can be chosen from this 

list by clicking the mouse on appropriate 

suggestion.  

WORD COUNT 

Word Count is a facility of MS-Word, which displays 

count statistics of the document. Perform following 

steps to know, how many pages, lines, paragraphs, 

characters etc. are there in the document: 

1. Select "Tools" option from the bar menu. 

When you do so, Tools submenu, as shown in 

figure 5.36, will appear on the screen. 

2. Select "Word Count" option from Tools 

submenu. When you do so, a dialog box, as 

shown in figure 5.39, will appear on monitor 

screen. This dialog box will have all 

necessary count statistics in it.  

3. After viewing the statistics, click the mouse 

on "Close" button. 

When you do so, dialog box will get closed. 

 

Figure 5.38 

 

Figure 5.39 
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INTRODUCTION TO TABLE 

Tables are the best means for illustrating classified data. They consist of rows and columns. 

A blank table is shown in figure 5.40. The unit space formed by the intersection of rows 

and column is called cell. Thus a table consisting of 3 rows and 4 columns will have 12 

cells in it. MS-Word provides facility for creating tables and entering data in them.  The 

method of creating the table and entering data is given below: 

     4 columns 

    

    

    

Figure 5.40 

Creating A Blank Table 

Perform following steps to create a blank table in the 

document: 

1. Place the insertion pointer at the place, where the 

table is to be created.  

2. Select "Table" option from the bar menu. When 

you do so, "Table" submenu, as shown in figure 

5.41(a), will appear on the screen. 

3. Select "Insert" option from Table submenu. On 

selecting this option, another submenu, as shown 

in figure 5.41(b), will appear on the screen. 

4. Now select "Table" option from this submenu. 

When you do so, a dialog box, as shown in figure 

5.42, will appear on the screen.  

 5. Make use of different spinners present in the dialog box and specify the dimension 

of the table. Say you specify 4 column and 3 rows. 

6. At last, click the mouse on "OK" button. 

When you do so, a blank table structure, as shown in figure 

5.40, will get created. 

Drawing The Table 

Instead of making a table by adopting the procedure mentioned 

above, you can directly draw a table using "Draw Table" option 

of Table submenu. Perform following steps to draw a table of 

your choice: 

3 Rows 

 

(a) (b)  
Figure 5.41 

 

Figure 5.42 
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1. Select "Table" option from the bar menu. When you do so, "Table" submenu, as 

shown in figure 5.41(a), will 

appear on the screen. 

2. Select "Draw Table" option from 

Table submenu. On selecting this 

option, Table and Border toolbar, 

as shown in figure 5.43 will appear 

on the screen. 

3. Make use of different tools of this toolbar and draw the table of your choice.  

Entering Data In Table 

To type the data in the table, click the mouse in desired cell and start typing the data from 

keyboard. Using arrow keys, you can move within the cell. Pressing Tab key moves 

insertion pointer ahead by 1 cell, while Shift and Tab keys pressed together take the 

insertion pointer back by one cell. 

Inserting A Row 

Perform following steps to insert a row in an already existing table:  

1. Place the insertion pointer in the row, above which you wish to insert a new row. 

2. Select "Table" option from the Bar menu. When you do so, a Table submenu, as 

illustrated in figure 5.41(a), will appear on the screen. 

3. Select "Insert" option from this submenu. On selecting this option, another 

submenu, as illustrated in figure 5.41(b), will appear on the screen. 

4. Now select "Row Above" option from this submenu.  

When you do so, a blank row, above the insertion pointer, will get created in the table. 

Inserting A Column 

To insert a column in an already existing table, place the insertion pointer in the column, 

left to which, a new column is to be inserted. After this, perform all the steps mentioned in 

"Inserting a row" section but select "Column to the Left" option instead of "Row above" 

option in step (4). 

Deleting Table Or Row Or Column 

Perform following steps to delete the table, row(s) /column(s):  

1. Select the table or row or column that is to be deleted.   

2. First select "Table" option from the bar menu.  When you do so, Table 

submenu, as shown in figure 5.41(a) will appear on monitor screen.  

3. Select "Delete" option from Table submenu. When you do so, 

another submenu, as shown in figure, 5.44, will appear on monitor screen. 

Figure  5.43 

 

Figure 5.44 
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4. Select  "Table", "Rows" or "Columns" option from this submenu.  

When you do so, the selected table, row or column will get deleted.  

If you wish to delete the contents of the table/rows/columns and not the entire 

table/row/column, select the contents and press Del key. 

AUTO FORMAT 

Auto Format is a facility of MS-Word that provides many predefined table formats. Each 

table format suggests a different style and color scheme for the table. This style can be 

applied to any existing table.  Perform following steps to make use of this facility:  

1. Create a table, using above 

mentioned procedure and select it. 

2. Select "Table" option from the bar 

menu.  When you do so, Table 

submenu, as shown in figure 

5.41(a) will appear on monitor 

screen.  

3. Select "Table AutoFormat" option 

from Table submenu. When you 

do so, a dialog box, as shown in 

figure 5.45 will appear on the 

screen.  

4. Select the desired style from 

"Table Style" list box. The style 

that you select will get displayed 

in Preview list box. 

5. Select other desired options from 

this list box. 

6. At last click the mouse on "Ok" button. 

When you do so, selected style will get applied to the table.  

AUTOFIT 

AutoFit is a facility of MS-Word that fits the text within the cell as per your requirement. 

For example, if you wish that the width of the cell should be flexible and it should vary as 

per number of characters entered in the cell, you can do that, using AutoFit facility.  

Perform following steps to make use of this facility:  

1. Click the mouse on any cell of the table, on which you wish to apply AutoFit 

facility. 

2. Select "Table" option from the bar menu.  When you do so, Table submenu, as 

shown in figure 5.41(a) will appear on monitor screen.  

 

Figure 5.45 
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3. Select "AutoFit" option from Table submenu. When you do so, another submenu, as 

shown in figure 5.46 will appear on the screen.  

4. Select desired auto fit option from this submenu. 

When you do so, selected AutoFit option will get applied to 

the table and its effect will become visible when you enter 

text in the table. 

SORTING THE TABLE 

Table can be sorted in ascending or descending order on first 

column of the table. Perform following steps to sort the table: 

1. Click the mouse within the table that is to be sorted.  

2. Select "Table" option from the bar menu.  When you do so, Table submenu, as 

shown in figure 5.41(a) will appear on monitor screen.  

3. Select "Sort" option from Table submenu. 

When you do so, sort dialog box, as shown 

in figure 5.47 will appear on the screen.  

4.  Using type drop drown list, specify data 

type for the contents of the cell, on which 

the table is to be sorted. Note that contents 

can either be text, number or date.  

5. Select "Ascending" or "Descending" option 

from this dialog box. 

6. At last, click the mouse "Ok" button. 

When you do so, table rows will get rearranged 

and presented in sorted order.  

Formula 

If the need be a formula can be defined for a cell 

of the table. This formula can be based on the 

contents of other cells of the table. When you do 

so, values are automatically calculated based on 

the formula and are automatically put in the cell in 

which you had entered the formula.  

Perform following steps to define a formula in a 

cell of the table: 

1. Click the mouse within that cell of the 

table, in which formula is to be defined.  

2. Select "Table" option from the bar menu.  

When you do so, Table submenu, as shown in figure 5.41(a) will appear on monitor screen.  

Figure 5.46 

 

Figure 5.47 

 

Figure 5.48 
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3. Select "Formula" option from Table submenu. When you do so, Formula dialog 

box, as shown in figure 5.48 will appear on the screen.  

4. Write the formula in Formula edit box.  

5. At last, click the mouse "Ok" button. 

When you do so, value will be automatically calculated and put in the cell. 

CONVERTING TABLE INTO SIMPLE TEXT  

Text that has been typed in the cells of the table can be converted to simple text  by 

performing  following steps: 

1. Click the mouse within the table.  

2. Select "Table" option from the bar menu.  When you do so, 

Table submenu, as shown in figure 5.41(a) will appear on 

monitor screen.  

3. Select "Convert" option from Table submenu. When you do 

so, another submenu, as shown in figure 5.49 will appear on 

the screen.  

4. Select "Table to text" option from this submenu. When you do so, a dialog box, as 

shown in figure, 5.50 will appear on the screen.  

5. Select desired options from this dialog box. 

6. At last, click the mouse "Ok" button. 

When you do so, text within the table cells will get 

converted to simple text, as per choices made during 

conversion.  

PRINT PREVIEW 

You may wish to view the document, in the form it will 

be printed on the printer. To do this, perform following 

steps: 

1. Make sure that the document, which you wish to 

preview is open and present in current window. 

2. Select "File" option from the bar menu. When 

you do so, File submenu, as shown in figure 5.5, will appear on the screen. 

3. Select "Print Preview" option from File submenu.  

When you do so, current page of the document, as it will get printed on the printer will 

appear on the screen.  Sample of such a page is shown in figure 5.51. 

Figure 5.49 

 

Figure 5.50 
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Figure 5.51 

PRINTING THE DOCUMENT 

Perform following steps to print the document on printer: 

1. Make sure that the document, which you wish to print is open and present in current 

window. 

2. Select "File" option from the bar menu. When you do so, a submenu, as shown in 

figure 5.5, will appear on the screen. 

3. Select "Print" option from File 

submenu. When you do so, a 

dialog box, as shown in figure 

5.52, will appear on the screen. 

4. Click the mouse on "Name" drop 

down list and select the name of 

the printer, on which the 

document is to be printed. 

5. If all the pages of the document 

are to be printed, select "All" 

option present in "Page range" 

section of the dialog box else 

specify the page range as s-e. 

Here s denotes the starting page 

number and e denote the last page 

number that is to be printed. Figure 5.52 
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6. Specify number of copies that need to be pointed, using "Number of Copies" 

spinner. 

7. Advanced options like Page size, Orientation of the paper etc. can be set by clicking 

the mouse on "Properties" button. 

8. After defining all the options, as per requirement, click the mouse on "OK" button. 

When you do so, printing will start as per the parameters, set above. 

SENDING THE DOCUMENT TO OTHER DESTINATIONS 

Current document can be sent to other destinations like e-mail, Fax machine, PowerPoint 

etc. Perform following steps to do this: 

1. Make sure that the document, which you wish to send to other destinations is open 

and present in current window. 

2. Select "File" option from the bar menu. When you 

do so, File submenu, as shown in figure 5.5, will 

appear on the screen. 

3. Select "Send To" option from File submenu. When 

you do so, another submenu, as shown in figure 

5.53, will appear on the screen. 

4. Select the desired destination from this submenu. 

When you do so, current document will be forwarded to the selected destination. 

  

 EXERCISES                      CHAPTER 5 

 

Short Type Questions 

A.  Select best possible options for following questions: 

1. Which of the following operation cannot be performed in MS-WORD? 

 (a) Calculations   (b) Writing letters   

 (c) Designing page layouts  (d) Including graphics with text. 

2. Which of the following will let you set the left margin of the document? 

 (a) Components present in Horizontal ruler (b) Components present in Title Bar  

 (c) Components present in Format Toolbar (d) Components present in Status Bar. 

3. Which of the following event will select a graphics picture present in the document? 

 (a) Dragging the mouse on picture         (b) Clicking the mouse on picture  

 (c) Double clicking the mouse on picture     (d) Right clicking the mouse on picture 

 

Figure 5.53 
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4. How will you select vertical column of text? 

 (a) Click the mouse on first sentence of the block.   

 (b) Double click the mouse on first sentence of the block.   

 (c) Drag the mouse on the column with Shift key pressed.  

 (d) Drag the mouse on the column with ALT key pressed.   

5. Which of the following operation will delete a paragraph? 

 (a) Press Del key   

 (b) Press Backspace key  

 (c) Drag the mouse on paragraph and then press space key.  

 (d) Drag the mouse on paragraph and drop it on the desktop. 

6. In which type of alignment all the lines of the paragraph start from left margin end at 
right margin? 

 (a) Left alignment (b) Right alignment (c)  Center alignment (d)Justify  

7. Which of the following will start a new paragraph in MS-WORD? 

 (a)  Press Space key    (b)  Press Tab key   

 (c)  Press ALT key       (d)  Press Enter key 

8. Which option of Bar menu will have to be chosen for performing Save and Open 
operations on a file? 

 (a)  Edit  (b)  File  (c)  Format  (d)  Window 

9. Which of the following combination will physically move the text from one place to 
another within the document? 

 (a)  CUT & COPY (b)  CUT & PASTE (c)  COPY & PASTE (d)  None 

10. Which option of Bar menu will invoke Spell Checker for spelling correction? 

 (a)  Edit  (b)  File  (c)  Tools  (d)  Window 

B.  Fill in the blanks: 

11. The first line of the paragraph can be indented by few columns by dragging 
....................... of Horizontal ruler.. 

12. Find facility of WORD remains available, under ............................ submenu. 

13. If you wish that the word sweetness should not be reported found, while searching 
the word sweet in the document, you should check........................... check box. 

14. A selected paragraph can be deleted by pressing  .............................................. or 
........................ key. 

15. Contents of a paragraph can be aligned in four different ways. They are 
........................, ............................, ................................ and ............................... 

16. Hard page break can be introduced in the document by pressing 
................................. and ................................... keys together. 

17. Page numbers can be introduced in the document by selecting 
................................. option from the Bar menu. 
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18. A table of 3 rows and 2 columns can be introduced in the document by selecting 
..................... option from the Bar menu. 

19. To correct a wrong spelling, you need to ................................. the mouse on the 
spelling. 

20. Registered trade make symbol, which is not present on keyboard, can be written in 
the document by selecting .................................. option from the Bar menu.  

C.  State, true or false for following statements: 

21. Type writing activity is an example of word processing. 

22. Page layout of a document can be changed using Page setup option of Edit 
submenu. 

23. A new paragraph can be introduced by pressing CTRL and N keys together. 

24. A sentence cannot be deleted without selecting it. 

25. A line of a document can be selected by clicking the mouse pointer on the left hand 
side of the line. 

26. A paragraph can be selected by double clicking anywhere in between the 
paragraph. 

27. The whole document can be selected by triple clicking in the left margin. 

28. A tab position can be removed by dragging the tab mark from horizontal ruler and 
dropping it somewhere else. 

29. To introduce a Bulleted list in the document, each item of the list need to be 
entered as independent paragraph. 

30. Numbers can be removed from Number List by selecting the number list and 
clicking the mouse on Number list button present in the Bar menu. 

D.  Answer the following questions in short: 

31. Which organization, designed and developed MS-WORD? 

32. Which type of work is performed through MS-WORD? 

33. How will you select a piece of text in MS-WORD? 

34. How will you move the insertion pointer from the beginning of the paragraph to the 
end of the paragraph in one go? 

35. Which two options will you choose in sequence, to save the current document in a file? 

36. Which two options will you choose in sequence to open an already existing file? 

37. How will you make the current paragraph right justified aligned?  

38. 10 items have been entered in 10 different lines. How will you convert them into a 
Bulleted list? 

39. How will you change upper case letters to lower case letters in a given word? 

40. How will you increase the width of the right margin in MS-WORD? 
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Detailed Answer Type Questions 

E.  Answer the following questions in detail: 

41. Explain the term word processing?  Name a software, using which word processing 
activity could be performed on computer. 

42. Describe any two features of word processing. 

43. Describe any three activities of MS-WORD, which cannot be preformed by 
typewriters. 

44. How will you change the font of the current paragraph? 

45. How will you make fifth line of the paragraph, Bold, Italic and underlined? 

46. Write the steps for typing H2O in the document. 

47. Write the steps for typing 2
6+3

 in the document. 

48. How will you replace the word "See" with the word "Look" in the whole document? 

49. How will you set three Right aligned tab stops at distances of 1, 2 and 3 inches 
from the left margin? 

50. Describe at least three features of on-line spell checker. How do you activate it in 
MS-WORD? 

   

PRACTICAL ASSIGNMENTS 

 

Assignment -1:  Entering, Formatting And Printing The Document 

Perform, following activities in lab sessions: 

1.   Set left and right margins for the entire document. 

2. Type the following piece of text in 11 points, Times New Roman font, without caring 
about its formatting: 

 

The Crossover 

A new business opportunity is coming up at the junction of hardware and software 

embedded technology 

An Indian boy selling newspapers at Stockholm railway station was unusual enough for 

Sunil to investigate. The boy turned out to be a student at the Royal Institute of 

Technology, Sweden. He talked excitedly about an idea for a pace marker that lasted 

much longer than the ones available in the market. "Why don't you come and develop 

this product in my laboratory?" asked Sunil. 

The lab is a center of excellence for embedded systems at Tata Consultancy services (TCS) in 

Bangalore.  Sunil had set it up only a year ago, after quitting Sasken Communication 

Systems. "I had approached TCS with this idea of an embedded systems lab and TCS had 
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agreed," say Sunil. Despite being the largest software services company in India, TCS had 

not worked on embedded system other than in telecommunications. It was slow off the 

blocks, but the company was trying to make up for lost time. 

Sunil's lab's mandate was not to provide services. It would to research, develop 

technologies, and build product; not just software but complete devices. Whenever a 

product came out, it would be sold under the TCS brand name. The first device could 

be patient health monitoring system. The next one could be a box that would increase 

spectrum utilisation in CDMA (code division multiple access) networks. The third 

device could be the boy's pacemaker. 

The embedded system lab is also building competencies in three areas: wireless LAN 

(local area network), multimedia and medical electronics. TCS is about to take over a 

wireless LAN firm in Demark. This firm has a key technology that will strengthen the 

TCS portfolio. TCS is also sponsoring research at the University of Demark. Indian 

software companies have no history of sponsoring research at universities. Neither do 

they design and sell devices. So is this a short fit of absent-mindedness or a long-term 

strategic shift? 

 

3. Now perform following steps to edit and format the text: 

(i) Find the word utilisation in the document and replace it with utilization. 

(ii) Put the heading, "The Crossover" in 24 points bold, Arial Black.  

(iii) Make the text, starting with the words “A new business opportunity…...” till 
“embedded technology” as subheading. Put it in 14 points bold, italic and 
underlined.  

(iv) Find the first appearance of the word "Sunil" and change its color to red and make 
it italic bold. 

(v) Import the clip art from clip art gallery.  

(vi) Align the paragraphs.  

Format the document as shown below. 

Print the document on printer. 

Save the document in a file. 
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The Crossover 
A new business opportunity is coming up at the junction of 

hardware and software embedded technology 

An Indian boy selling newspapers at Stockholm railway station was unusual enough for 

Sunil to investigate. The boy turned out to be a student at the Royal Institute of 

Technology, Sweden. He talked excitedly about an idea for a pace marker that lasted 

much longer than the ones available in the market. "Why don't you come and develop 

this product in my laboratory?" asked Sunil. 

The lab is a center of excellence for embedded 

systems at Tata Consultancy services (TCS) in 

Bangalore.  Sunil had set it up only a year ago, after 
quitting Sasken Communication Systems. "I had 

approached TCS with this idea of an embedded 

systems lab and TCS had agreed," say Sunil. Despite 

being the largest software services company in India, 

TCS had not worked on embedded system other than 

in telecommunications. It was slow off the blocks, 

but the company was trying to make up for lost time. 

Sunil's lab's mandate was not to provide services. It would to research, develop 

technologies, and build product; not just software but complete devices. Whenever a 

product came out, it would be sold under the TCS brand name. The first device could 

be patient health monitoring system. The next one could be a box that would increase 

spectrum utilization in CDMA (code division multiple access) networks. The third 

device could be the boy's pacemaker. 

The embedded system lab is also building competencies in three areas: wireless LAN 

(local area network), multimedia and medical electronics. TCS is about to take over a 

wireless LAN firm in Demark. This firm has a key technology that will strengthen the 

TCS portfolio. TCS is also sponsoring research at the University of Demark. Indian 

software companies have no history of sponsoring research at universities. Neither do 

they design and sell devices. So is this a short fit of absent-mindedness or a long-term 

strategic shift? 
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Assignment–2 :  Creating Tables In The Document. 

4.  Prepare following letter in MS-Word: 

 

To                 Date:  12/9/06 

Mr. A. K. Tandon 

Bharat Book Depot 

77 Mal Avenue 

Lucknow 

Subject: Supply of Computer Books. 

Dear Sir, 

This has reference to the specimen of books, submitted by you for our approval. 

We are pleased to place order for following books. 

Details of the Book No. of 

Copies 

Sr. 

No. 

Title of the 

Book 

Author Edition Publisher  

1. Fundamentals Anurag 1
st
 BPB 4 

2. Windows Rahul 2
nd 
 New Age Publication 2 

3. Word Sanjeev 1
st
 New Age Publication 6 

4. Excel Ajit 2
nd
 MBD 5 

5. PowerPoint Manav 1
st
 BPB 10 

We agree to 35% discount that you have offered under your terms and conditions. 

These books may please be delivered, latest by 1-10-2006 in our library.  

Kindly submit the bill in duplicate along with the books, so that the payment 

could be made at the earliest. 

Thanking you                   

 Sincerely yours 

 

R.K. Pandey 

                     (Librarian)   

 

5.  Print the letter on printer. 

  **** 



UNIT - III 

 

 

 

 

 

Mail Merge Operations   

INTRODUCTION 

In the last chapter you learned the method of typing a letter in MS-Word and formatting it 

so that it looks attractive. Now if you have to write a letter to your friend, inviting him to 

your sister's marriage, you can very well prepare the letter in MS-Word. But the question 

is, if the same letter has to be sent to say 25 or 30 friends then what do you do? Do you 

copy the letter to 25 or 30 different files and change the names and addresses of friends in 

individual files? No, this is not the right solution. If you are working in MS-Word, it 

provides a facility called Mail Merge. Using this facility you can create two different files, 

one file containing data (i.e. names and addresses of all the friends to whom invitation 

letters have to be sent) and other containing letter (with name and address left blank). After 

creation of these files, they are merged together, so that one letter is created for each 

individual. Concept of Mail Merge is illustrated in 6.1.  

One 
invitation 
letter

20 letters (for
 each friend)

Data of
20 friends

Name, Address etc.

MS-WORD

Mail Merge 
facility

 
Figure 6.1  

TERMS AND TERMINOLOGY OF MAIL MERGE 

Before we describe operational details of Mail Merge, it is necessary to get familiar with 

few important terms and their meanings.  

6 CHAPTER 
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Main Document 

Format of the letter, which is to be sent to each individual, is called main document. Refer 

figure 6.1 and note that invitation letter format is nothing but main document. 

Main document basically consists of two items; one is the text that will appear in the letter 

(such as "You are cordially invited to my sister's marriage ….) and other are the variables, 

which will fetch the data (such as name, address etc. of friends) from the data file. How 

main document is created, is explained later in this chapter. 

Data Source 

Data source is basically a combination of two items i.e. Header row and Data. Refer figure 

6.1 and note that combination of item like name, address etc. and the data is nothing but 

data source.  

Header Row 

Those items, related to which the data exists in the data file constitute header row. For 

example, if the data in the data file relates to name, address and telephone number of the 

persons then these three items put together will constitute header row. Following is an 

example of header row:  

Name, Add, Tel 

Here names (spellings) of all individual items of header row and their sequence in header 

row are important, wherever they will be referred, they will be referred by same name and 

the data in the data file will have to be put in the same sequence. 

Data 

Data consists of those values, which are to be included in the letters. For example, if the 

letters are to be sent to 4 persons then there will be 4 rows of data. Each row will contain 

values for each individual item of the header row. Table shown here clearly illustrates 

header row and data. 

 

 

 

 

 

For generating letters through Mail Merge facility of MS-Word, you need to create main 

document, data source and data, first. After this, data is merged with the main document 

and letters are printed. Operational details for creating these items are given below. 

Name Add Tel 

Rakesh 1 Park street Lko. 2787531 

Rani 23 Dover Lane Delhi 2608529 

Rupa 43 Mall Avenu Allahabad 23405091 

Soni 69 Kanpur Road Lko 26589063 

Data

Header 

Row
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CREATING THE MAIN DOCUMENT 

Perform following steps create the main document: 

1. Select "Tools" option from the bar menu. 

When you do so, Tools submenu, will appear 

on the screen. 

2. Select "Mail Merge..." option from Tools 

submenu. On selecting this option, Mail 

Merge Helper screen, as shown in figure 6.2, 

will appear on the screen. 

3. Click the mouse on "Create" button. When 

you do so, a drop down list, as shown in 

figure 6.3 will appear on the screen. 

4. Select "Form Letters" option from this list. 

When you do so, a dialog box as shown in 

figure 6.4, will appear on the screen. 

5. If you wish to create the document in current window, click the mouse on "Active 

Window" button else click it on "New Main Document" button. In both the cases, 

Mail Merge Helper screen, as shown in figure 6.5, will appear on the screen. 

      

   Figure 6.3           Figure 6.4 

 

Figure 6.5 

 

Figure 6.2 
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Note that main document consists of text and the field names (header row constituent). So 

in order to create the main document, you will have to write the text and the field names 

also. But the field names have not yet been created. So let's first create the data source and 

then create the main document. 

CREATING THE DATA SOURCE 

Perform following steps to create the data source: 

1. Click the mouse on "Get Data" button, present in "Mail Merge 

Helper" screen (figure 6.5). On selecting this option, a drop 

down list as shown in figure 6.6 will appear on the screen. 

2. Since the Data Source is being created for the first time 

hence select "Create Data Source" option from this list. When you do so, a dialog 

box, as shown in figure 6.7, will appear on the screen. 

 

Figure 6.7  

 

Using this dialog box, create the header row and data, as mentioned below.  

Creating Header Row 

1. You know that header row consists of field names. Field names currently present in 

header row are shown in "Field names, in header row" list box. To remove any field from 

the header row, select the field and click mouse on "Remove field Name" button. 

2. To add a new field in header row, enter the name in "Field name" text box and click 

the mouse on "Add Field Name" button. 

3. To change the sequence of the fields in the header row, make use of arrow buttons. 

 For example, say you create the header row with following field names: 

Name, Add, Tel 

Enter new field 

name here

Field name: click 

the mouse on 

desired field to 

select it. 

 

Click the mouse to 

shift currently 

selected field up 

Click the mouse 

to add new field 

Click the mouse to 

remove currently 

selected field

Click the mouse to 

shift currently 

selected field down 

 

    Figure 6.6 
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4. Click the mouse on "OK" button. When you do so, usual "File Save" dialog box 

appears on the screen. Mention drive, folder and file name for saving the header 

row. Say for example, you specify the file name as "DataRow". To end the saving 

process, click the mouse on "Save" button. When you do so, a message box, as 

shown in figure 6.8, will appear on the screen. 

 

Figure 6.8  

Creating The Data 

1. To create the data, click the mouse on "Edit Data Source" button, present in the 

message box, shown in 

figure 6.8. When you do 

so, a data entry form, as 

shown in figure 6.9, will 

appear on the screen. This 

form will have provision 

for entering the data for all 

the fields of header row.  

2. To enter the data, type the 

field values in the 

corresponding text boxes 

and click the mouse on 

"Add New" button. It will 

add a new record to the file and create blank screen for entering the next record.   

After entering the complete data, click the mouse on "OK" button. When you do so, Mail 

Merge tool bar, as shown in figure 6.10 will 

appear on the screen and you will be taken 

back to the main, blank document, which, 

you had created at the beginning. Now you 

need to enter the text and header row field 

names in the document so that letters for all 

individuals could be generated. 

EDITING THE MAIN DOCUMENT 

Perform following steps to edit the main document:  

Figure 6.9 

Figure 6.10 
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1. Type the text of the letter, in normal way, as you type the contents of other 

documents 

2. To add the header field name in the text, take the mouse pointer at the place, where 

the field is to be added and click the mouse on "Insert Merge Field" button, present 

in Mail Merge toolbar (Figure 6.10). When you do so, header row field name will 

get displayed, as shown in figure 6.11.  

3. Select the field by clicking the mouse on it. When you select 

the field, MS-Word will put the field name at the current 

insertion pointer's position as, <<Name>>. Remember that 

these signs are not less than or greater than signs, they cannot 

be entered through keyboard.  They can only be included 

through Mail Merge toolbar. 

Say, for example, you prepare the main document, 

as shown in figure 6.12. 

MERGE DATA SOURCE WITH 

MAIN DOCUMENT 

Perform following steps to merge the data with 

main document: 

1. Make sure that main document file (For 

example, Invitaton.doc) is there on the 

screen.  

2. Select "Tools" option from the bar menu. 

When you do so, Tools submenu will 

appear on the screen. 

3. Select "Mail Merge" option from Tools 

submenu. When you do so, "Mail Merge 

Helper" screen, as shown in figure 6.5, will appear on the screen. 

4. Click the mouse on "Merge" button present in that screen. When you do so, a dialog 

box, as shown in figure 6.13, will appear on the screen. 

5. Using different objects of 

this dialog box specify 

printing related details. 

6. At last, click the mouse on 

"Merge" button present in 

the dialog box. 

When you do so, letters for all the 

persons, will get generated on the 

screen. If you wish, you can print 

them on printer in the same way 

 

Figure 6.11 

 

Figure 6.13 

To   

 Dear  <<Name>> 

 <<Add>> 

 <<Tel>> 

I am happy to inform you that my 

sister is getting married. You are 

requested to grace the occasion by 

your presence. 

 

Vimal Singh

Figure 6.12 
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as other document. Sample letters for the example, taken in this chapter are illustrated 

below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 
 

 

 

 

 

 

 

 

Figure 6.14 

 

  

To   

Dear Rani 

23 Dover Lane Delhi 

2608529 

I am happy to inform you that my 

sister is getting married. You are 

requested to grace the occasion by 

your presence. 

 

Vimal Singh

To   

 Dear Rakesh  

1 Park Street Lko. 

2787531  

I am happy to inform you that my 

sister is getting married. You are 

requested to grace the occasion by 

your presence. 

 

Vimal Singh

To   

Dear Rupa 

43 Mall Avenu Allahabad 

23405091 

I am happy to inform you that my 

sister is getting married. You are 

requested to grace the occasion by 

your presence. 

 

Vimal Singh

To   

 Dear Soni 

69 Kanpur Road Lko. 

26589063 

I am happy to inform you that my 

sister is getting married. You are 

requested to grace the occasion by 

your presence. 

 

Vimal Singh
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EXERCISES                      CHAPTER 6 

 

Short Type Questions 

A.  Select best possible options for following questions: 

1. Which of the following application is best suited for mail merge operation? 

 (a) Writing letter to you father (b) Typing this page on your computer 

 (c) Generating interview letters for applicants (d) None of the above 

2. How many files will be required for mail merge operations in MS-Word? 

 (a) 1   (b) 2  (c)  3        (d)  4 

3. What do you call the format of the letter, in mail merge operation? 

 (a)  Source document (b)  Data source    (c)  Main document      (d)Main header 

4. If there are 15 records in data file then how many letters will get generated by mail 
merge operation? 

 (a) 15   (b) 1  (c)  6         (d)  None 

5. What is data source? 

 (a) Main document and fields   (b) Data and field names 

 (c) Data and source document (d) None of the above 

B.  Fill in the blanks: 

6. The data along with the field names is referred to as .................................. 

7. The body of the text, which is to be merged with data is referred to as ..................... 

8. The record structure that contains the field names is called .............................  

9. Mail Merge utility can be invoked by selecting ..................... option of the bar menu. 

10. If you look at the main document then the text can be differentiated from field 
names because field names are enclosed between ............................and 
............................. signs. 

11. The result of mail merge operation can be obtained at 3 different places. These 
places are  (i) ..................................   (ii) ............................ (iii) ............................ 

C.  State, true or false for following statements: 

12. To perform mail merge operation, you need to have two different files. One should 
contain the data and another should contain the body of the text. 

13. Generating multiple copies of a letter, written to your mother is an example of mail 
merge operation. 

14. Generating call letters, for 100 students for taking an examination, is an example of 
mail merge operation. 

15. The data source not only contains the data but the contents of letter also. 
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16. While preparing the main document, you need to insert two less than signs (<<) and 
two “greater than” signs (>>) from the keyboard, at those places, where you wish to 
insert the data from data file. 

17. While merging the data with the main document, you can also be selective so that 
only selected records participate in the operation. 

D.  Answer the following questions in short: 

18. Using which facility of MS-Word, interview letters for the candidates can be 
generated? 

19. Which option will you select from the bar menu to start working with mail merge 
operation? 

20. What do you call that format of the letter, which is to be generated for candidates, 
through mail merge operation? 

21. What are those two items that constitute data source in mail merge operation? 

22. How will you print multiple copies of each interview letter, generated through mail 
merge operation? 

Detailed Answer Type Questions 

E.  Answer the following questions in detail: 

23. What is the difference between producing multiple copies of a letter and mail merge 
operation? 

24. Give at least two examples, which are best suited for mail merge operations. 

25. Explain the term “Data Source”. What is its role in mail merge operation? 

26. Explain the term “Main Document”. What is its significance? 

27. While entering the text for main document, how do you specify that at this particular 
place, data has to be inserted from the data file? 

28. Explain the mail merge operation with example. 

29. Explain three advantages of mail merge operation. 

30. What will you do if few records have to be removed from existing data source?  

31. What is header row and what is its role in mail merge operation? 
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PRACTICAL ASSIGNMENTS 

 

Assignment 1 : Generating Letters Using Mail Merge. 

1. Invoke MS-Word on your computer. 

2. Make use of Mail Merge facility. 

3. Create following data source: 

 

Name Add Tel 

Rakesh 1 Park street Lko. 2787531 

Rani 23 Dover Lane Delhi. 2608529 

Rupa 43 Mall Avenue Allahabad. 23405091 

Soni 69 Kanpur Road Lko. 26589063 

 

4. Create main document, as mentioned below. 

 

To   

Dear     <<Name>> 

<<Add>> 

<<Tel>> 

I am happy to inform you that  

my sister is getting married. You 

are requested to grace the occasion 

by your presence. 

Vimal Singh 

 

5. Merge data source with main document and generate letters. 

6. Print the letters on printer. 

7. Save the letters in a file. 

8. Generate letters for only Rupa and Soni. 

 

  **** 



UNIT - IV 

 

 

 

 

 

MS-Excel   

INTRODUCTION 

Data collection, its organization and presentation in easy-to understand forms like tables, 
graphs, charts etc. for the purpose of analysis are day-to-day activities of any working 
setup. For example, a sales organization, at the end of financial year, may collect sales 
figures from all its regional offices for analyzing company's sales performance and 
deciding the targets for the next year. Similarly a manufacturing organization may collect 
all input costs involved in manufacturing an item to estimate fund requirements and to 
calculate the profitability. 

When data volumes are small, such activities are either performed manually or using 
equipments like calculator etc. But when data volume becomes large and presentation 
requirements are complex, these tools become limitation. Other sophisticated tools are 
required to handle such situations. MS-Excel is one such software-tool, which facilitates 
maintaining large data volumes on computer, organizing them in the form of tables, charts, 
reports etc. and performing "What if" analysis. Working details of MS-Excel are described 
in this chapter. 

MS-EXCEL - A WORK BOOK 

MS-Excel is workbook software, which has been designed and developed by Microsoft 
Corporation of USA.  

Workbook software comprises of multiple 
worksheets with data editing facilities and inbuilt 
calculation abilities. Data editing facilities of 
workbook ensure proper organization of data and 
calculation abilities facilitate its automatic 
updation. 

A simple worksheet is illustrated in figure 7.1. It 
looks like a page of child's mathematics copy that 

7 CHAPTER 

 
Figure 7.1 
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has squares drawn in it. Squares are used for writing labels, data or formulae in them. 
When data pertaining to similar entities like organization, item, month, year etc. is put in 
same column or row, it automatically gets organized in the form of table. Such a table is 
illustrated in figure 7.2. 

 
 

 

Figure 7.2 

When formulae are defined in worksheet, automatic calculations are done and results are 
generated. 

For example, if formulae are defined in the worksheet, shown in figure 7.2, as mentioned 
therein, the figures will be generated automatically, as shown in figure 7.3. If somehow any 
participating figure changes, all 
corresponding changes will be automatically 
done. For example, if sales figure of Nino 
company, for the month of Jan, changes from 
2 to 5 then total figure for the month of Jan will 
change from 14 to 17.  Total sales figure for 
Nino company will change from 25 to 28 and 
Total sales figure will change from 77 to 80. 

Note that figure 7.2 or figure 7.3 illustrates a 
single worksheet. A workbook comprises of many such worksheets. An Excel workbook 
comprises of 255 such worksheets. 

OPENING A WORKSHEET AND ENTERING DATA 

Perform following steps to invoke MS-Excel on your computer:  

 1. Click the mouse on "Start" button. When you do so, Start menu, as shown in figure 
5.1 (a) will appear on the screen. 

 2. Select "All Programs" option from this menu. When you do so, a submenu, as 
shown in figure 5.1 (b) will appear on the screen. 

 3. Select "Microsoft Excel" option from this submenu. 

When you do so, MS-Excel window, as shown in figure 7.4, will appear on the screen. 

=SUM(B3:D3) 

=SUM(B4:D4) 

=SUM(B5:D5) 

=SUM(E3:E5) 
=SUM(B3:B5)

=SUM(C3:C5) =SUM(D3:D5) 

 
Figure 7.3 
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INTRODUCTION TO MS-EXCEL WINDOW 

Refer figure 7.4 and note that Excel window comprises of two nested windows. The outer 
window is called Application window and the inner windows is called Document window. 
Each window comprises of many components. A brief introduction of their components is 
given below. 

 

 

 

 

 

 
Figure 7.4 

Application Windows 

Components of MS-Excel Application window are as follows: 

Title Bar 

Title bar comprises of usual components like system menu button, name of the current 
document, minimize, maximize and close button.  

Status Bar 

Status bar at the bottom of MS-Excel window comprises of message area and few buttons. 
Message area generally displays status of current activities. Buttons display the status of various 
action keys of the keyboard. For example, Num Lock is on or off, Caps Lock key is active or not 
etc. are few situations that are indicated by these buttons. 

Control Menu Button 

Cell Pointer

 Sheet Tab 

Worksheet 

Area 

Standard 
Toolbar 
 

Format 

Toolbar

Formula Bar 

 Status Bar 

  Minimize ButtonTitle Bar 

Maximize Button  

Worksheet Tab 
Scroll Buttons 

 Horizontal Scroll Bar 

Vertical  

Scroll Bar 

Close Button   

Reference 

Area

Bar Menu  
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Document Window 
Document window comprises of few common components like bar menu, toolbars, scroll 
bar etc. and few special components, which are local to Excel window. You are already 
familiar with the role and functioning of all the common components. Role and functioning 
of all special components of MS-Excel window are explained below. 

Formula Bar 

Formula bar is a place where you can enter the contents of the cell. Whenever you type 
something in it and press Enter key (or click the mouse on tick symbol) it gets written in 
the current cell. 

Reference Area 

This is the place where the address of current cell gets displayed. 

Drop Down List 

Drop down list is basically a list of all those items of the worksheet, which have been 
assigned a name. When mouse is clicked on the arrow button, names get displayed.  

Formula Entry Area 

This is basically the text entry area. Whatever you type here is later transferred to current 
cell. All modifications in the cell entries are done in this area. 

Tick Button 

It works like "Enter" key of the keyboard. When mouse is clicked on this button, contents 
of formula entry area get transferred to the current cell. 

Cross Button 

Cross button works like "Cancel" button.  When mouse is clicked on this button, contents 
of formula entry area get erased and that area becomes blank. 

Equal To Sign Button 

When mouse is clicked on this button, function wizard appears on the screen and starts 
functioning. 

Worksheet Area 

Worksheet area comprises of rows and columns. Partial area of the worksheet remains 
visible on the screen. Other portion of it can be brought on the screen by scrolling the 
worksheet, using vertical and horizontal scroll bars. 

All together there are 65536 rows and 256 columns in a worksheet. Refer figure 7.4 and 
note that rows are labeled as 1,2,3,4,5 etc. and columns are labeled as A, B, C, D, E etc. 
Thus the last row will be labeled as 65536 and the last column will be labeled as IV 

Intersection of a row and column forms a rectangular space, called Cell. Each cell is 
identified by its address and the address of the cell is defined as column number and the 
name of the row that form the cell. For example, the cell formed by fifth column (i.e. E) 
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and third row (i.e. 3) will be defined as E3. Similarly the cell formed by fourth column (i.e. 
D) and second row (i.e.2) will be defined as D2. 

Worksheet area is used for data entry. As per standard rules of MS-Excel, contents of a cell 
are considered as single data item. In other words you can say that a cell of the worksheet 
can hold single data item only. 

Worksheet Tab 

As mentioned earlier, a workbook comprises of 256 worksheets. Each worksheet has a 
corresponding tab in MS-Excel window. Refer figure 7.4 and note that these tabs are placed 
just below the worksheet area. These tabs are named as Sheet1, Sheet2, Sheet3 ... etc. 

When you invoke MS-Excel, first worksheet appears in the window and Sheet1 tab remains 
highlighted. 

Worksheet Tab Scroll Buttons 

Refer figure 7.4 and note that not all 255 worksheet tabs (as there are 256 worksheets in a 
workbook) remain visible on the screen. Due to space limitation, only few of them appear 
on the screen. To scroll the list of these tabs, worksheet tab scroll buttons remain present in 
the window. 

Figure 7.5 clearly shows that there are four worksheet tab scroll buttons. Sequential scroll 
buttons scroll the tabs forward and backward one by one. For example, if currently Sheet3 
is visible on screen and you click the mouse on "Sequential scroll forward" button, sheet4 
tab will become visible. Similarly "Sequential scroll backward" button will move the tabs 
in backward direction. 

Step scroll buttons, scroll the tabs in steps. For example, if tabs for sheet1, sheet2, sheet3 
etc. are visible on the screen and you click the mouse on " Steps forward scroll" button, set 
of tab buttons i.e. Sheet4, sheet5, sheet6 etc. will be visible on the screen. Similarly "Step 
backward scroll" button will scroll the worksheet tabs in other direction. 

 

 

 

 
Figure 7.5  

Sequential scroll forward button 

Sequential 
scroll 
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button

Steps forward scroll button Steps backward 

scroll button
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Cell Pointer 

Refer figure 7.4 and note that the thick border around the cell (A1) is cell pointer. Cell 
pointer can be moved anywhere in the worksheet with the help of arrow keys of the 
keyboard. The cell, on which cell pointer resides, is referred to as current cell. When you 
enter the data, it gets entered in the current cell. 

Now you are familiar with MS-Excel window, its components, worksheet and the 
workbook. Now the question is how do you move around in the worksheet or workbook?  
Well, the procedure for these activities is explained below. 

MOVING AROUND IN A WORKBOOK 

You can move around in the workbook in any one of the following ways: 

1. Make use of the arrow keys to move the cell pointer to the desired location. The 
position of cell pointer will be your current position in the worksheet. 

2. Click the mouse on the cell, to which you wish to move. When you do so, cell pointer 
will get immediately placed there and the clicked cell will become current cell. 

3. Click the mouse in Reference area of formula bar and type the address of the 
desired cell. After this, when you will press Enter key, cell pointer will move to the 
cell whose address you had typed in the reference area. 

4. To move to any other worksheet, click the mouse of its sheet tab. For example, if you 
wish to move to the third worksheet, click the mouse on "Sheet3" tab, located just below 
the worksheet area. If the desired worksheet tab is not visible on the screen, make use of 
"Worksheet tab scroll" buttons, to make it appear there. 

ENTERING DATA IN WORKSHEET 
Data entry in worksheet is quite different from the text entry that is done in MS-Word. In 
MS-word, you continuously keep on typing the text but in MS-Excel worksheet you need to 
type each data item in a separate cell. For example, if you wish to enter three data items, 
say Ravi, 200, 555 then you will have to type Ravi in one cell then move to other cell and 
type 200 there. Similarly for typing 555, you will have to move to some other desired cell 
and then type the number. 

DATA TYPES 

The data that can be entered in MS-Excel worksheet is broadly classified into following 
two categories: 

1. Constants 

2. Formula 

Constants 

The values, which do not change on their own are called constants, For example, if you 
enter "Ravi" in cell A1, it will not change unless you deliberately modify it (to say, 
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Ravina). Similarly other values like 200, 255 etc. will also be treated as constants because 
they will not change automatically. 

Type Of Constants 

Constants can further be classified into following categories: 

1. Numbers 

2. Text 

3. Date 

4. Time 

Numbers 

Any combination formed by ten digits i.e. 0 to 9 is treated as number or numeric constant. For 
example, 200 is a number. Similarly 555 is another number or another numeric constant. Use of 
following special characters is allowed in the formation of numbers: 

+ - ( ) / * $ % 

While making use of these special characters in the numbers, following rules apply: 

1. MS-Excel ignores + sign in all the numbers that are preceded by it. For example, it 
will treat +176 as 176. Similarly +975 will be treated as 975. 

2. Any number preceded by a hyphen (-) is treated as negative number. For example,  
-753 is a negative number. 

3. $ sign can precede the number. For example, $200, $735 etc. are valid numbers or 
valid numeric constants. 

4. To increase the readability of the numbers, MS-Excel allows the use of comma in 
between the digits of the numbers. For example, 10,357, 1,567 etc. are valid numbers. 

5. MS-Excel also accepts numbers in scientific notation.  For example 10e6 , 10e3  
etc. are valid numbers in scientific notation. 

7. Use of parenthesis is also allowed in forming the numbers. For example, (7), 
(200+700), (300-55) etc. are valid numbers. 

Text 

Any data that is neither number nor date nor time, is treated as text in MS-Excel. For 
example, Ravi, Ravina, January, Month etc. are all examples of text. Note that a cell can 
hold at most 255 character long text. Blank is also treated as single character text. 

Date 

MS-Excel allows date entries in the cells of the worksheet. It treats them as separate identities. 
Thus date mathematics becomes possible in MS-Excel. In date data, day, month and year values 
are either separated by hyphen (-) or slash (/). Following are few valid dates: 

22/06/1975,  16/MAY/1975, 10-3-1988 etc. 
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Time 

Time is a valid data type in MS-Excel. For entering time values in MS-Excel worksheet, 
following rules apply: 

1. Time values can either be as per 12 hours clock or 24 hours clock. 

2. If time values are as per 12 hours clock, they should be followed by AM or PM. For 
example, 7 AM, 8 PM etc. are valid time values. 

3. Instead of AM, PM, A and P can also be used respectively. For example, 7A, 8P are 
also valid time values. 

4. If time value includes hours, minutes and seconds then colon (:) should be used as 
separator between them. For example, 10:45 AM, 1:10:05 PM etc. are valid time 
values. 

5. Excel automatically displays time in 24 hours clock. For example, if you enter 2 
PM, it will automatically convert it to 14:00. 

6. Date and time values can be entered together in a cell by including a blank in 
between them. For example, 10/5/2006 11:55, 3/5/1957 10:20 PM etc. are few valid 
date and time entries. 

Formula 

Formula is basically a user defined function, which can be formed as per our own 
requirements by making use of constants, mathematical operators, standard MS-Excel 
functions (there are numerous standard, predefined functions available in MS-Excel, for 
use), and cell addresses.  For example, (A1*C1)+200 is a valid formula. Similarly 
SUM(A1:A10) is another valid formula. 

To differentiate formulae with text, all formulae should start with = sign in MS-Excel. For 
example, above mentioned formulae should be entered as =(A1*C1)+200, =SUM(A1:A10) 
respectively. 

Type Of Formulae 

MS-Excel formulae can be broadly classified into following categories: 

1. Numeric Formulae 

2. Logical Formulae 

3. Text Formulae 

A brief introduction of all these types of formulae is given below. 

Numeric Formulae 

Formulae that make use of arithmetic operators are called Numeric Formulae. For example, 
=(A+B)-C1 is a numeric formula because it makes use of arithmetic operator + and -. 
Following is the list of arithmetic operators that are allowed in MS-Excel. 
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 Sign      Operations Performed 

+       Addition 

- Subtraction (or negation when placed before a value, say - 149) 

/ Division 

* Multiplication 

% Percentage (Placed after a value e.g. 25%) 

^ Exponentiation (e.g. 20^2) 

Following are few valid numeric formulae: 

=( A1+B1+C1+D1), =(B10-C10), =(A1*B1)/C1, =(C1+C5)*25%, (5^3)+B1 

Logical Formulae 

Formulae that make use of logical operators are called Logical Formulae. They are 
basically used for making logical comparison. The result of comparison is either TRUE or 
FALSE. They produce no other result. For example, =(A1>B1) is a logical formula because 
it makes use of logical operator >. 

Following is the list of logical operators that are available in MS-Excel: 

Sign Meaning  Sign  Meaning 

= Equal to >= Greater than or equal to 

> Greater than <= Less than or equal to 

< Less than <> Not equal to 

 
To get familiar with the use of logical operators and the result produced by logical 
formulae, assume that cell A1 contains 1000 and cell B1 contains 500.  Formulae entered in 
different cells of the worksheet will generate result as summarized in the following table:  

Cell Formula Result 

C1 =(A1=B1) FALSE 

C2 =(A1>B1) TRUE 

C3 =(A1<>B1) TRUE 

C4 =(A1>=B1) TRUE 

C5 =(A1<B1) FALSE 

C6 =(A1<=B1) FALSE 
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Text Formulae 

Those formulae, which make use of text operators, are called Text Formulae. 

Only one text operator, called concatenation operator, is available in MS-Excel. It is 
denoted by & sign and it operates upon two text items to join them together. For example, 
if cell A1 contains "Andhra" and B1 contains "Pradesh" then =(A1&B1) will produce 
AndhraPradesh. 

ORDER OF EVALUATION 

As per standard rules, evaluation of operators starts from right and gradually proceeds 
towards left. For example, formula =300-5+50*3 will generate 445. 

Making use of parenthesis can always change the order of evaluation. For example, 
formula=(300-5+50)*3 will generate 1035. 

Within the parenthesis, evaluation proceeds from right to left. 

In case of nested brackets, innermost bracket is resolved first. After this, next outer bracket 
is resolved and evaluation proceeds in the same way. While evaluating an expression, 
operators are evaluated in following sequence: 

 

Sr. No. Operator Description 

1. - Negation (-25) 

2. % Percent 

3. ^ Exponentiation 

4. * and / Multiplication and Division 

5. + and - Addition and Subtraction 

6. & Text joining 

7. =, <, >, <> Comparison operators 

 

DEFAULT FORMATTING 

While entering the data in worksheet, it gets automatically formatted. The rules for default 
formatting are as follows: 

1. Numeric values get right aligned. 

2. Text values get left  aligned. 

3. Date and time values get right 
aligned. 

4. Formulae get left aligned. 

Default alignments of all these data items is shown in figure 7.6 

 
Figure 7.6 
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ENTERING AND EDITING FORMULA 

You are now familiar with MS-Excel worksheet and the types of data that can be entered in 
it. To get familiar with the process of preparing a worksheet, let's take a simple example. 
Say, we have to prepare a worksheet, in which rate and quantity are entered manually and 
the amount is calculated automatically, using the formula (rate * quantity). 

Perform following steps for preparing this worksheet. 

1. Type "Rate" in cell A1. The word, Rate is a text constant and will be treated as 
label or heading. Its purpose is to communicate that the value written below is rate. 

2. Type the word "Quantity" in cell B1. This label will also serve the purpose of 
heading. 

3. Type the word "Amount" in cell C1. This text will also serve the purpose of 
heading. 

4. Since quantity and rate values have to be entered in cell A2, B2 respectively and the 
amount is to be calculated by multiplying values in these cells and the result is to be 
displayed (automatically) in cell C2 hence enter the formula, =(A2*B2) in cell C2. 

5. Now, when you enter the values in cell A2 and B2, result will get automatically 
displayed in cell C2. For example, if you enter 50 in cell A2 and 3 in cell B2 then 
the result, 150 (i.e. 50*30) will automatically appear in cell C2. 

Now, if you change the values either in A2 or B2 or 
in both the cell, value in cell C2 will automatically 
update itself, according to the formula. For example, 
if you change the value in cell B2, from 3 to 5, the 
value in cell C2 will change from 150 to 250. This 
worksheet is illustrated in 7.7. 

The formula that you enter in a cell can either be edited in cell, by double clicking the 
mouse in the cell and changing the contents there or by placing the cell pointer on the cell 
and editing the contents in the Formula Bar. 

REFERENCING A GROUP OF CELLS 

Refer above mentioned example and recall that in cell C1, we made use of the formula, 
=(A2*B2), Note that this formula makes use of the cell addresses, which refer single cell. 
For example, A2 refers a single cell. Similarly B2 refers other cell. But there would be 
times when group of cells will participate in the formula. For example, column A may 
contain 12 different sales values i.e. A1 may contain sales value for the month of Jan, A2 
may contain sales value for the month of Feb and so on. Thus to add all the 12 values, you 
will have to write a formula =(A1+A2+A3 -----+A12). This is lengthy and uncomfortable 
way.  To make the task simple, MS-Excel provides many reference operators. Using these 
operators, you can refer group of cells (more then one cell) and make the formula short. An 
explanation of these operators is given below. 

 

Figure 7.7 
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Range Operator 

As the name indicates, Range operator, refers a group of cells, which fall within the given 
cell addresses. 

Range operator is denoted by colon sign (:). It requires two operands and is used as 
Op1:Op2. Here Op1 is the first operand, which refers the address of the cell from where the 
range starts. Similarly Opt2 is the second operand, which refers the address of the cell, where the 
range ends. For example, (A1:A12) will signify all the cells starting from cell A1 to cell A12 
(i.e.12 cells). Similarly (A5:G5) will signify all the cell from A5 to cell G5 (i.e. 7 cells). 

Union Operator 

As the name indicates, Union operator refers to all those cells, which are referred in the 
expression. 

Union operator is denoted by a comma (,). It requires two operands and is used as op1, op2. 
Here op1 refers a cell address and op2 refers to another cell address. Thus (A7, B10) will 
refer two cells i.e. A7 and B10. Similarly (A7, A9, A11) will refer three cells A7, A9 and 
A11. In the same way (A5:A10), (B15:B20) will refer 12 cells i.e. all the cells starting from 
A5 to A10 (6 cells) and the cells starting from B15 to B20 (another 6 cells). 

Intersection Operator 

Intersection operator refers to all those cells, which are common between the two given ranges. 

Intersection operator is denoted by a blank space. It requires two ranges as operands and is 
used as (R1 R2). Here R1 and R2 are two ranges. For example, (A1:A10 A7:A15) will 
result into 4 cells i.e. A7, A8, A9 and A10. 

CELL REFERENCING 

Consider the use of cell addresses in a formula. For example, in the worksheet shown in 
figure 7.7, the formula = (A2*B2) was written. Here by writing A2 or B2, You are referring 
to the values present in these cells. When you refer the contents of the cell, it is called cell 
referencing. Note that just writing the cell addresses and referring their values is not the only way 
of cell referencing. MS-Excel provides following three methods of cell referencing: 

1. Relative referencing 

2. Absolute referencing 

3. Mixed referencing 

Relative Referencing 

As the name indicates, in relative referencing, cells are referred in relation to the current 
cell position. To understand the concept of relative referencing, consider the worksheet 
shown in figure 7.8. If you put the formula =(B2+C2+D2) in G2, it will show 1000 in G2. 
But it would, in the background, convey following aspects related to the current cell 
position (i.e. G2): 
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1. Take the value of the cell, which is 5 cells away towards left, from current cell. 

2. Take the value of the cell, which is 4 cells away towards left, from the current cell. 

3. Take the value of the cell, 
which is 3 cells away 
towards left, from the 
current cell. 

4. Add all the three values and 
put the result in the current 
cell. 

In MS-Excel, whenever cell 
addresses are written in normal way (i.e. A1, C2, D7 etc.), relative referencing 
automatically takes place. 

Note 

Since in relative referencing all cell positions are referred in relation to current cell 
position, hence the same formula, when copied into another cell, (which would then be the 
current cell) will refer other cells and produce different result.  

Absolute Referencing 

As the name indicates, in Absolute Referencing the position of the cell or cells being 
referred does not depend upon the current cell position. Such type of referencing is done by 
prefixing $ sign with row and column names in a cell address. 

For example, $B$2, $C$3, $D$4 etc. are examples of relative referencing. Note that B6 is 
an example of relative referencing, while $B$6 is an example of absolute referencing. 

To understand the concept of relative referencing, consider the worksheet shown in figure 7.8 and 
assume that values in G2, G3 and G4 are to be multiplied by fixed value of tax rate, present in 
cell B6. For this, formulae as mentioned in the table will have to be entered in the cells, 
mentioned therein. 

Cell Formula 

H2 =G2*$B$6 

H3 =G3*$B$6 

H4 =G4*$B$6 

Note 

Since in absolute referencing, the position of the cell being referred does not depend upon 
the current cell position hence when a formula containing absolute referencing (only) is 
copied to other cell, it produces same result.  

Mixed Referencing  

As the name indicates, in Mixed Referencing, the cell addresses are partly relative and 

 
Figure 7.8  
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partly absolute. This is done by either prefixing a $ sign with row name or column name. 
For example, $B4, B$4 both are examples of mixed referencing (but with a difference). In 
$B4, column reference is absolute but row reference is relative, while in B$4, it is just 
opposite i.e. column reference is relative and row reference is absolute. 

Note 

Since in mixed referencing, the position of cell being referred, partially depends upon the 
position of the current cell and partially doesn't depend upon it hence a formula, which 
contains mixed references, when copied to other cell may or may not produce the same 
result, depending upon where the formula is copied.  

PREPARING A WORKSHEET 

To get familiar with different types of referencing methods, let's prepare a worksheet, 
which is illustrated in figure 7.8. Say we have to enter labels and data, as shown therein. 

Assume that row totals have to be calculated and put in corresponding cells of column G. 
Tax values have to be calculated by multiplying total by tax rate (present in B6). For this, 
perform following steps: 

1. Enter all the labels, as illustrated in figure 7.8. 

2. Enter all the data items, as illustrated in figure 7.8. 

3. Enter formula, =(B2+C2+D2) in G2 

4. Enter formula, =(B3+C3+D3) in G3 

5. Enter formula, =(B4+C4+D4) in G4 

6. Enter formula, =(G2*$B$6) in H2  

7. Enter formula, =(G3*$B$6) in H3 

8. Enter formula, =(G4*$B46) in H4 

After entering these formulae, the worksheet 
will show the values, as illustrated in figure 7.9. 

SAVING THE WORKBOOK 

Perform following steps to save the workbook on the disk: 

1. Click the mouse on "File" option, present in the bar menu. 
When you do so, File submenu, as shown in figure 7.10, 
will appear on the screen. 

2. Select "Save As" option from the File submenu. When you 
do so, a dialog box, as shown in figure 5.7 will appear on 
the screen. 

3. Now select drive and the folder, in which you wish to save 
the worksheet. 

4. Enter the name of the file, in which you wish to save the 
workbook in "File Name" text box. 

 Figure 7.9 

 

Figure 7.10 
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5. At last, click the mouse on "Save" button, present in the dialog box. 

When you do so, file will get saved on the disk. 

Note 

When you save a workbook, it is saved in a file that has the name, assigned by you. But   
MS-Excel assigns .XLS extension to it. For example, if you save the workbook in a file 
named, mywork, it will be saved in a file mywork.xls.  

CLOSING THE WORKBOOK 

Perform following steps to close the workbook: 

1. Click the mouse on "File" option, present in the Bar menu. When you do so, File 
submenu, as shown in figure 7.10 will appear on the screen. 

2. Select "Close" option from File 
submenu. If current modifications 
have not yet been saved on the disk, 
an alert box, as shown in figure 
7.11, will appear on the screen. 

 On the other hand, if current 
modifications have been saved on 
the disk, the workbook will get closed. 

3. If you wish to save the current editing session on the disk, click the mouse on "Yes" 
button else click it on "No" button. If somehow you wish to abort the closing 
process, click the mouse on "Cancel" button. 

EXITING FROM EXCEL 

Exit from Excel can be made in any one of the following ways: 

1. Select "Exit" option from the File submenu. 

2. Select "Close" option from the System menu. 

3. Click the mouse on "Close" button, present in title bar. 

OPENING AN EXISTING WORKBOOK 

Perform following steps to open an existing workbook: 

1. Select "File" option from the Bar menu. When you do so, File submenu, as shown 
in figure 7.10, will appear on the screen. 

2. Select "Open" option from File submenu. When you do so, a dialog box, as shown 
in figure 5.9 will appear on the screen. 

3. Select the drive, folder and the file, in which the workbook exists. 

4. At last, click the mouse on "Open" button. 

 
Figure 7.11 
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PREPARING WORKSHEET WITH SERIES 
MS-Excel provides various mechanisms for generating following types of series: 

1. Arithmetic Progression series (1, 2, 3, 4 , 4, 5 .... etc.) 

2. Geometric Progressing series (3, 9, 24, 81 ...... etc.) 

3. Full month name series (January, February, March .... etc.) 

4. Short month name series (Jan, Feb, Mar ..... etc.) 

5. Full day name series (Sunday, Monday ...... etc.) 

6. Short day name series (Sun, Mon, Tue ..... etc.) 

7. Date series (1/1/2006, 1/2/2006 ...... etc.) 

Methods of generating, such types of series are explained below: 

Generating AP Or GP Series 

AP or GP type of series can be generated as follows: 

1. Enter starting values in the cell and press Enter key. 

2. Now select all those cells, which have to be filled with the series (including the 
one, in which you have entered the value), by dragging the mouse over them. 

3. Now click the mouse on "Edit" option, present in bar menu. When you do so, Edit 
submenu, as shown in figure 7.12(a) will appear on the screen. 

4. Select "Fill" option from this submenu. When you do so, another submenu, as 
shown in figure 7.12(b), will appear on the screen.  

Now select "Series" option from this submenu. When you do so, a dialog box, as shown in 
figure, 7.12(c) will appear on the screen. 

              

(a)             (b)                   (c) 
Figure 7.12 

6. If you wish to generate AP series, select "linear" option and for generating GP 
series, select "Growth" option. 
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7. Enter suitable value for increment, in "Step value" edit box. 

8. At last, click the mouse on "OK" button. 

When you do so, series will get generated.   

Generating Day or Date Series 
Perform following steps to generate the series of day name, month name etc.:  

1. Enter the first term of the series in a cell and press Enter key. Say you enter Sun in 
cell D4. 

2. Now click the mouse in the cell, in which you had entered the value. Thus you will 
have to click the mouse in D4 cell. 

3. Now drag the mouse by handle, in any 
desired direction, (i.e. right, left, up, or down) 
over as many cells as there have to be terms 
in the series. Say you drag the mouse over 4 
cells. 

When you do so, a series of short day names will get 
generated, as shown in figure 7.13. 

NOTE 

Similarly, by entering January, Sunday etc. as first term of the series, you can generate 
month full-name, day full-name series etc. 

EDITING CELLS 

Once a worksheet is prepared, it may require some editing. Contents of few cells may have 
to be copied from one place to other or deleted from the worksheet. The procedures for all 
such operations are described below.  

Selecting The Cells 

For operating upon a cell or group of cells, you have to 
first select them. They can be selected by performing 
following actions: 

1. To select a cell, click the mouse in the cell. When 
you do so, a thick border, with a handle at its right 
bottom corner, appears around the cell. 

2. To select a range of cells, drag the mouse over the 
range. A selected cell range is shown in Figure 7.14.  

3. To select the entire column, click the mouse on 
column name. For example, clicking the mouse on A will select the entire, first column. 

4. To select a group of contagious columns (say E, F, G and H) drag the mouse on 
their column names. 

 
Figure 7.13 

 
Figure 7.14 
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5. Another method of selecting contagious group of columns (say E, F, G and H) is to 
press shift key of the keyboard, click the mouse on first column of the group (i.e. E 
in this case) and then click it on last column of the group (i.e. H in this case, with 
shift key pressed). 

6. To select a non contagious group of columns (say A, C, D and I), keep CTRL key 
of the keyboard, pressed and click the mouse on name of each column, which is to 
be selected (i.e. A, C, D and I in this case.) 

7. To select the entire row (say fifth row), click the mouse on row name (5 in this case) 

8. To select the contagious or non-contagious group of rows, perform all the steps, 
mentioned above but instead of clicking the mouse on column names, click the 
mouse on row names.  

9. To select the complete worksheet click the mouse on blank cell, which remains 
present towards left of column label A and just above row label 1. 

Changing The Contents Of Cell 

Contents of a cell can either be edited in Formula Bar or within the cell itself. Both the 
procedures are given below: 

1. To modify the contents in Formula Bar, click the mouse in the cell, whose contents 
have to be modified. When you do so, cell contents will appear in the Formula Bar. 

 Now using DEL or Backspace keys etc. you can modify the contents. At last, press 
Enter key. 

2. To modify the contents, within the cell, double click the mouse in that cell, whose 
contents have to be modified. When you do so, insertion pointer will appear in cell. 
Now using different keys of the keyboard, modify the contents, within the cell. At 
last press Enter key. 

Copying The Contents Of The Cell 
Contents of a cell or group of cells can always be copied from their original place to 
another location of the worksheet. For this, perform following steps: 

1. Select the cell or group of cells, which is to be copied. 

2. Click the mouse on "Edit" option, present in bar menu. When you do so, Edit 
submenu, as shown in figure 7.12(a) will appear on the screen. 

3. Select "Copy" option from Edit submenu. When you do so, a moving frame will 
surround the selected cells, indicating that this portion of the worksheet will get copied. 

4. Now click the mouse on the cell (or the first cell of the range), where the contents 
have to be copied. 

5. Click the mouse on "Edit" option of the bar menu again and get Edit submenu on 
the screen. 

6. Select "Paste" option from Edit submenu. 
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When you do so, contents of selected range will get copied at current location. 

Note that if you are copying labels or data from one place to another, they will get copied as 
such, without any modifications done (internally). But if you copy the formula or formulae, 
they may get copied with some modifications or without modifications, depending upon the 
types of cell references (relative, absolute or mixed) used in the formulae. To understand the 
concept, let's consider following three cases of copying the formula: 

Copying Formula, Containing Relative References 

To understand the concept of relative referencing more clearly and observing its changing 
behavior in the event of copying the formula, perform following steps: 

1.  Enter three different values in cell A1, B1 and C1. Say you enter 100, 200 and 300 
respectively in them.   

2. Now enter the formula =(A1+B1+C1) in cell D1. When you do so, the value 600 
will get displayed in the cell D1 

3. Now copy this formula, in cell D1, to another cell, say E1. When you do so, to your 
surprise, the result will not be 600 (as the same formula produce 600 in D1). It will 
be 1100. 

 Take a look in the Formula Bar and you will find that the formula (=A1+B1+C1) 
has been copied as =B1+C1+D1 (which will correctly produce 1100). The reason 
for this change is explained below. 

Note that A1, B1 and C1 are relative references. The formula = A1+B1+C1 in cell D1 
indicates that values in the third left cell second left and first left cell have to be added 
together and the sum has to be put in the current cell.  Now if this formula is copied in cell 
E1, then it would mean the same thing. Thus for this cell the participating cells will be B1 
(third left cell that has 200 in it), C1 (second left cell, which has 300 in it) and D1( first left 
cell, which has 600 in it). Thus the sum of these three cells will result into 1100. 

Copying Formula Containing Absolute References  

To understand the concept of absolute referencing more clearly and observing its behavior 
in the event of copying the formula, perform following steps: 

1. Enter three different values in three different cells. Say you enter 100, 200 and 300 
in cells A1, B1 and C1 respectively. 

2. Now enter the formula =($A$1, $B$1, $C$1) in cell D1. When you do so, the value 
600 will get displayed in it. 

3. Now copy this formula, in cell D1, into another cell E1. When you do so, the same 
value, 600 will get displayed in cell E1. 

Take a look in the Formula Bar and you will notice that formula has been copied as 
=$A$1+$B$1+$C$1. This time there is no change in the formula. This is because all these 
references (like $A$1, $B$1 etc.) are absolute references. They do not depend upon the 
current location. They directly point to cell, in question. 
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Copying Formula Containing Mixed References 

To understand the concept of Mixed References, more clearly and observing its behavior, 
while copying the formula from one cell to another, perform following steps: 

1. Enter three different values in three different cells. Say you enter 100, 200 and 300 
in cells A1, B1 and C1 respectively. 

2. Now enter the formula = A$1+$B1+C$1 in cell D1. When you do so, the value 600 
will get displayed in it. 

3. Now copy the formula in cell D1, into cell E1. When you do so, the value 1000 will 
get displayed in it. 

 Take a look in the Formula Bar and you will notice that the formula has been 
copied as B$1+$B1+D$1. This is because in cell reference A$1, column is relative 
reference and row is fixed reference. Due to this when you copy the formula, 
relative part (i.e. column) changes but row part remains same. Thus A$1 gets 
copied as B$1. Same thing happens while copying C$1. Thus it gets copied as D$1. 

On the other hand something different happens when $B1 gets copied. Note that in this cell 
reference, row reference is absolute (it will not change and column reference is relative). 
Since the cell reference is being copied in same row hence the row reference doesn't change 
(in this case). Thus $B1 gets copied as $B1. 

The complete formula gets copied as =B$1+$B1+D$1. Note that here cell B1, containing 
200 is participating twice and cell D1 contains 600. Thus the formula produces 1000. 

Now let's consider another case, say formula in D1 is now copied to cell D2. In this case 
the formula will get copied as =A$1+$B2+c$1. Since A1 contains 100, B2 contains 0 and 
C1 contains 300. Hence value 400 will get displayed in D2. 

Moving The Contents Of A Cell 

To move the contents using Bar menu, follow all the steps that have been described for 
copying but choose "Cut" option instead of "Copy" option. 

Deleting The Contents Of The Cell 

Perform following steps to delete the contents present in the cell: 

1. Select the cell or range of the cells, from which the contents have to be removed. 

2. Select "Edit" option from bar menu. When you do so, Edit submenu, as shown in 
figure 7.12(a) will appear on the screen. 

3. Now select "Clear" option from this submenu. When you do so, another submenu 
will appear on the screen. 

4. Select "Contents" option from this submenu. 

When you do so, the contents of the selected cell or cells will get erased. 
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Undo The Changes 

Perform following steps to cancel the effect of previous command: 

1. Click the mouse on "Edit" option present in bar menu. When you do so, Edit 
submenu, as shown in figure 7.12(a) will appear on the screen. 

2. Select "Undo" option from Edit submenu. 

When you do so, the effect of previous command will get cancelled and the worksheet will 
retain the status, as it had before executing the previous command. 

Note 

Previous command can be repeated, either by selecting "Redo" option from the Edit 
submenu or by clicking the mouse on "Redo" button present in Standard toolbar. 

Finding And Replacing The Contents In The Worksheet 
Given content can be searched in the worksheet for its presence and if the need be, it could also 
be replaced by other content. For example, the presence of the word, Bonus can be searched in 
the worksheet and if required, it could be replaced by other word, say, Incentive. 

Find and Replace are two different facilities of MS-Excel, available in Edit submenu. 
Replace facility is extension of Find facility and is executed in the same way as Find 
facility is done. The procedure for finding the 
given contents and replacing it by other contents 
is given below. 

1. Select "Edit" option from the bar menu. 
When you do so, Edit submenu, as 
shown in figure 7.12(a) will appear on 
the screen. 

2. Select "Replace" option from Edit 
submenu. When you do so, a dialog box, as shown in figure 7.15 will appear on the 
screen. 

3. Enter the contents to be searched, in "Find what" text box. For example, if you wish to 
search the word, Bonus in the worksheet, type this word in "Find what" text box. 

4. Type the word, with which the word being searched is to be replaced, in "Replace 
with" text box. For example, if the word Bonus is to be replaced with Incentive, 
type Incentive in "Replace with" text box. 

5. Specify the direction of search by selecting either "By Rows" option or "By 
columns" option from "Search" dropdown list. 

6. To make the search, case sensitive, check "Match case" check box. 

7. To start the process, click the mouse on "Find Next" button. When you do so, MS-
Excel will search the given contents (Bonus in above mentioned example) and halt 
the search temporarily, if it finds a match. 

 

Figure 7.15 
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8. To replace the searched occurrence, with the given word, click the mouse on 
"Replace" button. 

9. If you wish to replace all the occurrences of the given word with another word, in 
one shot, click the mouse on "Replace All" button. 

10. At last, click the mouse on "Close" button. 

MANIPULATING THE WORKSHEET 
Operations like changing the height and width of rows and columns, inserting new rows 
and columns etc. are the operation, which are frequently required, while preparing a 
worksheet. Operational details of these activities are given below. 

Changing Height Of The Row 

Perform following steps to alter the height of the row, so that bigger font characters could 
be accommodated in it: 

1. Select the row or group of rows, for which the height has to be changed. 

2. Select "Format" option from the bar menu. When you do so, Format submenu, as 
shown in figure 7.16(a), will appear on the screen. 

       

(a)  (b)        (c) 

Figure 7.16 

3. Select "Row" option from Format submenu. When you do so, another submenu, as 
shown in figure 7.16(b), will appear on the screen. 

4. Select "Height" option from this submenu. When you do so, a dialog box, as shown 
in figure 7.16(c) will appear on the screen. 

5. Now enter the desired height in "Row height" text box, of this dialog box. 

6. At last, click the mouse on "OK" button. 

When you do so, the height of selected rows will change. 

Changing The Width Of The Column 

The procedure for changing the width of the column is same as that of changing the height 
of the row (mentioned above), except that you need to select "Column" option from the 
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Format submenu (figure 7.16(a)) and "width" option from the submenu that appears 
thereafter. 

Inserting Blank Row Or Column 

Perform following steps to insert blank row or column in the 
worksheet:  

1. Place the cell pointer on the row (or column), above (or left) 
which the blank row (or column) is to be inserted. 

2. Click the mouse on "Insert" option present in the bar menu. 
When you do so, a submenu, as shown in figure 7.17, will 
appear on the screen. 

3. Select "Rows (or columns)" option from Insert submenu. 

When you do so, a new blank row (or column) will get inserted just 
above (or towards left of) the current row (column).  

Deleting Row Or Column 

Perform following steps to delete unwanted row(s) or column(s) in the worksheet: 

1. Select the row(s) or column(s) that need to be deleted. 

2. Click the mouse on "Edit" option of the bar menu. When you do so, Edit submenu, 
as shown in figure 7.12(a) will appear on the screen. 

3. Select "Delete" option from Edit submenu. When you do so, a 
dialog box, as shown in figure 7.18 will appear on the screen. 

4. Select "Entire row" (or entire column) option from this 
dialog box. 

5. At last, click the mouse on "OK" button. 

When you do so, selected row (or column) will get removed from 
the worksheet. 

Inserting A New Blank Worksheet 

Perform following steps to insert a new blank worksheet in the workbook:  

1. Click the mouse on that tab of the worksheet, left to which a new blank worksheet 
is to be inserted. For example, if a new worksheet is to be inserted in between 
Sheet4 and Sheet5, click the mouse on Sheet5 tab. 

2. Select "Insert" option from the Bar menu. When you do so, Insert submenu, as 
shown in figure 7.17 will appear on the screen. 

3. Select "Worksheet" option from Insert submenu. 

When you do so, a blank worksheet will get inserted in the workbook. 

 

Figure 7.18 

 

Figure 7.17 
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Renaming The Worksheet 

Recall that the worksheets of the workbook are named as Sheet1, Sheet2, Sheet3 etc. 
Perform following steps to rename any worksheet: 

1. Right click the mouse on that name (sheet tab), which is to be changed. For 
example, if fifth worksheet is to be renamed, click the mouse on the tab named 
Sheet5. When you do so, a popup menu, as shown in figure 
7.19 will appear on the screen. 

2. Select "Rename" option from this submenu. When you do 
so, the sheet name will get highlighted. 

3. Type the new name and press Enter key. 
When you do so, the name of the worksheet will change. 

Deleting A Worksheet 

Perform following steps to remove any worksheet from the 
workbook:  

1. Select the worksheet, which is to be deleted by clicking the mouse on its sheet tab. 
For example, if fifth worksheet is to be deleted, click the mouse on Sheet5 tab. 

2. Click the mouse on "Edit" option of the bar menu. When you do so, Edit submenu, 
as shown in figure 7.12(a) will appear on the screen. 

3. Select "Delete Sheet" option from Edit submenu. When you do so, an alert box, as 
shown in figure 7.20 will appear on the 
screen. 

4. Click the mouse on "OK" button. 

When you do so, current worksheet will get 
removed from the workbook. 

FORMATTING CELLS 

You are already familiar with the default formatting that automatically takes place, when 
you enter text, numbers, formulae etc. in the cells (already explained earlier). If the need be 
the default format for the selected range or the entire worksheet can be changed. In addition 
to this, many other things like adding comma or $ sign in numbers, changing alignment of 
text in cells, applying borders around selected cells etc. can also be done through 
formatting facility available in MS-Excel. Different types of formatting operations are 
described below.  

Applying Number Format 

Perform following steps to specify the format for the numerical values that would be 
entered in the cell or range of cells: 

Figure 7.19 

 
Figure 7.20 
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1. Select the cell or range of cells, on which you wish to apply the Number format. 

2. Select "Format" option from the Bar menu. When you do so, Format submenu, will 
appear on the screen. 

3. Select "Cells" option from Format submenu. When you do so, a dialog box, as 
shown in figure 7.21 will appear on the screen. If somehow different options appear 
in the dialog box, click the mouse on "Number" tab. 

4. To apply the Number format, select the 
desired option from "Category" list 
box. For example: 

(a) To decide the way, numbers will 
appear in the cells, click the 
mouse on "Custom" option, 
present in "Category" list box. 
When you do so, a list of formats 
will appear within the dialog box. 
Select the desired format. 

(b) To decide the Date or Time formats, 
click the mouse on "Date" or "Time" 
option (respectively), present in 
category list box. When you do so, 
many date and time formats will 
appear, within the dialog box. Select 
the desired format. 

(c) Where and at what place the comma should be used in numbers and in what 
color or format the negative numbers should appear, can be decided by 
selecting "Number" option present in "Category" list box. 

(d) Likewise other options can be selected from "Category" list box and related 
formats can be decided from the options that appear thereafter. 

5. To decide how many numbers will appear after the decimal point, make use of the 
spinner named "decimal places". 

6. Click the mouse on "OK" button. 

When you do so, all chosen formats will get applied to the selected cells. If the data already 
exists in the cells, it will get automatically formatted else when the data will be entered in 
these cells, the format will get applied on them. 

Applying Alignment 
Recall that the contents entered in the cell are either left aligned or right aligned. But if the need 
be, they can be top or bottom aligned or oriented at certain angle, as shown in figure 7.22(a). Note 
that applying Alignment format to the desired cells does this. Perform following steps for 
applying this format: 

 
Figure 7.21 
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1. Select the cell or range of cells, on which you wish to apply the Alignment format. 

2. Select "Format" option from the bar menu. When you do so, Format submenu will 
appear on the screen. 

3. Select "Cells" option from Format submenu. When you do so, a dialog box, as 
shown in figure 7.21 will appear on the screen. 

4. Click the mouse on "Alignment" tab. When you do so, the dialog box options will 
change, as shown in figure 7.22(b). 

    

  (a)                  (b)   
Figure 7.22 

5. If the contents of the cell are to be aligned horizontally, select the desired alignment 
(such as, left, right center etc.), using "Horizontal" drop down list, present in the 
dialog box. If you wish to fill the whole cell with repeated occurrence of a 
character, select "Fill" option from this drop down list. 

6. If the cell contents are to be vertically aligned, select the desired option, (such as, 
Top, Bottom, Justify etc.) from "Vertical" drop down list. 

7. If the contents of the cell are to be placed diagonally, set the angle of inclination 
through "Degree" spinner, present in orientation section of the dialog box. 

8. If the length of the text is larger than the width of the cell and you wish to wrap the 
text so that it is accommodated in multiple lines, within the cell, check the "Wrap 
text" check box. 

9. If you wish to shrink the longer text so that it fits within the width of the cell, 
check, "Shrink to fit" check box. 

10. To merge, adjacent cells, so that longer text is accommodated properly, check 
"merge" cells check box. 
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11. At last, click the mouse on "OK" button. 

When you do so, chosen alignment option will get applied to the selected cells. 

Applying Font Formats 

The data that you enter in worksheet is always entered in preset font, font style and font 
type. These specifications can always be changed either for selected cells or entire 
worksheet. Perform following steps to apply font format: 

1. Select the cell or range of cells, on which you wish to apply Font format. 

2. Select "Format" option from the bar menu. 
When you do so, Format submenu will 
appear on the screen. 

3. Select "Cells" option from Format submenu. 
When you do so, a dialog box, as shown in 
figure 7.21 will appear on the screen. 

4. Click the mouse on "Font" tab. When you do 
so, dialog box options will change as shown 
in figure 7.23. 

5. Select the name of the font from "Font" list 
box. 

6. Select font style and font size specifications 
from respective list boxes. 

7. If the characters have to be underlined, 
select a suitable line type from "Underline" drop down list box. 

8. If the text has to be striked out, check "strikethrough" check box, present in effects 
section of this dialog box. 

9. At last, click the mouse on "OK" button. 

When you do so, chosen font specifications will get applied to the selected cell. 

FUNCTIONS  

MS-EXCEL has numerous inbuilt formulae in it. The formulae are called functions or 
Excel functions. Each formula operates upon the given value (either taken from cell or 
written directly in the function itself) and produces specific result. These functions can 
either be written directly in the cell or can be included in the formula that you define. 
Functions are written in following format: 

Function-name (arguments) 

Here function-name is the name of the function and arguments are the list of values, 
separated by comma, on which the function has to operate. 

 

 Figure 7.23 
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For example, SUM is a valid MS-Excel function. It takes cell addresses or constant 
numeric values as arguments and returns total. For example, SUM (10, 20, 30) will return 
60. Similarly, it can be used as SUM(A1+B1+C1) here A1, B1 and C1 are the cell 
addresses. If they contain 100, 150 and 200 respectively then this function will return 450. 

As mentioned above, you can also use functions in your own formulae. For example, 
=1000-SUM (A1+B1+C1) is a valid formula. Few commonly used MS-Excel functions are 
described in the following table: 

 No. FUNCTION PROCEDURE EXAMPLE RESULT 

1 ABS(number) Returns absolute value of 
the number. 

=ABS(-200) 200 

2 INT(number) It rounds the number to 
the nearest integer. 

=INT(200.37) 200 

4  SQRT(number) Returns the square root of 
the number. 

=SQRT(64) 8 

5 SUM(number1, 
number2....) 

Adds all the number  =SUM(140,30) 170 

6 MOD(number1, 
number2...) 

This function divides the 
first number with the 
second number and 
returns the remainder. 

=MOD(127,5) 2 

7 PRODUCT(number1, 
number2...) 

It multiples all the 
numbers given and 
returns the product 

=PRODUCT(5,6) 30 

8 ROUND(number1, 
number2...) 

It rounds the number to 
the specified number of 
digit. 

=ROUND(122.66,1) 

=ROUND(122.6679,
2) 

122.7 

122.66 

9 AVERAGE(number1,
number2...) 

It returns the average 
(arithmetic mean) of its 
arguments. 

=AVERAGE(15,17) 16 

10 COUNT(value1, 
value2) 

It counts the numbers, 
which are provided to it as 
arguments.  

=COUNT(1,8,4,9,1) 5 

11 MAX(number1, 
number2) 

It returns the largest value 
in given set of values 

=MAX(100,135) 135 

12 MIN(number1, 
number2) 

It returns the smallest 
value in given set of 
values. 

=MIN(100,135) 100 

13 LEN(text) Returns the number of 
characters in a text string 

=LEN("INDIA") 5 

14 LEFT(text, value) This function returns as 
many leftmost characters 
of the given text string as 
specified by value. 

=LEFT("INDIA",2) IN 
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 No. FUNCTION PROCEDURE EXAMPLE RESULT 

15 RIGHT(text, value) This function returns as 
many rightmost 
character of the given 
text string as specified 
by value. 

=RIGHT("INDIA",2) IA 

16 LOWER(text) Converts all the 
uppercase letters in the 
lowercase 

=LOWER("INDIA") india 

17 UPPER(text) Converts a text string to 
uppercase 

=UPPER("India") INDIA 

18 TRIM(text) It removes all the spaces 
from the text string, 
except for single space 
between the words. 

=TRIM("Hi       
Dear")       

Hi Dear  

19 REPT(text, number 
of times) 

It repeats the text, given 
number of times 

=REPT("S",5) SSSSS 

PRINTING THE WORKSHEET 

Perform following steps for printing the worksheet: 

1. Select "File" option from the bar menu. When you do so, File submenu, as shown in 
figure 7.10 will appear on the screen. 

2. Select "Print" option from this submenu. 
When you do so, a dialog box, as shown 
in figure 7.24, will appear on the screen.  

3.  Make use of "Name" drop down list box 
and specify the name of the printer, on 
which the worksheet is to be printed.  

4. Make use of "From" and "To" spinners to 
specify the pages of the worksheet that are 
to be printed.  

5. Make use of "Number of copies" spinner 
and specify the number of copies that are 
to be printed. 

6. If the printing is to be done in a file, check "Print to File" check box. 

7. After selecting all the required options, click the mouse on "OK" button.  

When you do so, printing will start and the worksheet will get printed.  

 

 

Figure 7.24 
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EXERCISES                      CHAPTER 7 

 

Short Type Questions 

A.  Select best possible options for following questions: 

1. For which type of work, MS-Excel suites well? 

(a)  Word processing  (b)  Numerical calculations and analysis   

(c)  Drawing    (d)  Presentation of a subject. 

2. Which of the following cannot be performed in MS-Excel? 

(a)  Arranging data in the form of a table       (b)  Converting data into charts 

(c)  What-if analysis  (d)  Letter generation 

3. Which of the following can be used for moving from one worksheet to other? 

(a)  Scroll bars   (b)  Reference area   

(c)  Tab sheet button  (d)  System menu button 

4. Which of the following is a valid formula of MS-Excel? 

(a)  (A1+B1)  (b)  =(1+7)       (c)  =(A1+B1+C1)   (d)  =(A+B) 

5. Which of the following will copy the contents of a selected cell to other cell? 

(a)  Drag the cell (b)  Drag the cell by border   

(c) Drag the cell by border with Shift key pressed  

(d) Drag the cell by border with control key pressed 

6. Which option of the bar menu, should be chosen to save the worksheet on disk? 

(a)  Edit  (b)  Insert (c)  Format  (d)  File 

7. Which option of the bar menu should be chosen to change the height of the row? 

(a)  File  (b)  Edit (c)  Insert  (d)  Format 

8. Which option of the bar menu, should be chosen for the canceling the effect of 
previous command? 

(a)  Edit  (b)  Insert (c)  Format  (d)  File 

9. Which option of the bar menu should be chosen for printing the worksheet? 

(a)  File  (b)  Edit (c)  Insert  (d)  Format 

10. Which type of referencing is done if the cell is addressed as A$1? 

(a)  Relative  (b)  Absolute (c)  Mixed  (d)  Fixed 

B.  Fill in the blanks.  

11. Using MS-Excel, data can be arranged in the form of ........................................ 

12. MS-Excel workbook consists of many ......................................... 

13. A worksheet consists of .................................... rows. 
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14. A worksheet consists of ............................... columns. 

15. The intersection of rows and columns is called .................................. 

16. A cell formed by seventh row and tenth column will be addressed as ...................... 

17. ............................... is an example of relative referencing. 

18. MS-Excel formula should always be preceded by ............................... sign. 

19. When date and time values are entered in the same cell, they should be separated 
from each other by ............................... sign. 

20. ............................ sign (operator) is used to concatenate two text values.  

C.  State true or false for following statements: 

21. MS-Excel was designed and developed by Microsoft Corporation of USA. 

22. Using MS-Excel, numerical data can be converted into charts. 

23. What-if analysis applications can be very well done in MS- Excel. 

24. MS-Excel workbook consists of 250 worksheets. 

25. MS-Excel provides facilities for adding two dates and time values. 

26. All numbers, when entered in the worksheet, by default, get right justified. 

27. Text can be vertically written in the cells of the worksheet. 

28. Formula =$B$4*2 will get changed when you copy it from one cell to another. 

29. A formula, =($A$1+$B$1), when copied from C1 to C2, will get copied as 
=($A$2+$B$2). 

30. In MS-Excel, union operator is denoted by : sign. 

D. Answer the following questions in short: 

31. What do you call the intersection of rows and columns of the worksheet? 

32. Where will you click the mouse to go to the seventh worksheet? 

33. Where will you click the mouse to select the fifth row? 

34. Where will you click the mouse to select the seventh column? 

35. Where will you click the mouse to select the entire worksheet? 

36. Which two options of Edit submenu, should be chosen to copy the contents of a cell 
to another cell? 

37. Which two options of Edit submenu should be chosen to move the contents of a cell 
to another cell? 

38. Which symbol is used for denoting Range operator? 

39. Which symbol is used for denoting Union operator? 

40. Which symbol is used for denoting Intersection operator? 

41. Name the three types of referencing that can be done in MS-Excel. 

42. What address will you type in Reference Area to move to the cell, formed by tenth 
row and sixth column? 
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43. Which option of the bar menu should be chosen to get Find and Replace dialog box on 
the screen? 

44. Which function of MS-Excel will convert negative values to positive values? 

 

Detailed Answer Type Questions 

E.  Answer the following questions in detail: 

45. What is MS-Excel? For which type of activities it is used? 

46. What is the use of formulae in MS-Excel? What advantage you get from them? 

47. Explain the term cell referencing, using a suitable example. 

48. What is relative referencing? Explain, using a suitable example. What happens 
when you copy a relative reference formula? Explain, using an example? 

49. What is absolute referencing? Explain, using a suitable example. What happens 
when you copy an absolute reference formula? Explain, using an example. 

50. What is mixed referencing? Explain, using a suitable example. What happens when 
you copy a mixed reference formula? Explain, using an example. 

51. Differentiate between a worksheet and workbook. How will you delete a worksheet? 

52. Explain the method of changing width of a column. 

53. How will you write text vertically in a cell? 

54. How do you print a worksheet? 

55. How will you generate Mon, Tue, Wed............. series? 

56. How will you exit from MS-Excel? 
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PRACTICAL ASSIGNMENTS 

 

Assignment 1: Creating a Simple Worksheet. 

1.   Perform following operations to get familiar with the process of creating worksheet: 

(i)  Invoke MS-Excel on your computer. 

(i) Enter all the labels, formulae and data that are shown in figure 7.2 and create a 
simple worksheet.  

(iii) Modify sales figures and observe its effect on total. 

(iv) Save the worksheet on disk. 

(v) Open the worksheet and perform following operations: 

(a) Add a new column after Mar to accommodate April figures. 

(b) Add a new row above Total row to accommodate a new company, named 
Zeta. 

(c) Modify all formulae accordingly to get the sum of all the four months and four 
companies.  

(d) Add data for April month and Zeta company and check your results. 

Assignment 2: Creating A Worksheet For An Office. 

2.  Read following requirement first: 

Assume that an organization wishes to computerize its Budget Preparation & Analysis 
activities. It has decided to computerize the work, using MS-Excel. Say following are 
the details of the budget activities: 

(i)  Organization's budget is prepared under following five heads: 

(a) Salary   (b) Travel & Tour    (c) Rent & Maintenance 

(d) Electricity & Telephone (e)  Miscellaneous  

(ii)  Following figures are clearly shown in the budget: 

(a) Amount under each head is classified into two categories i.e. Officers and Staff. 
Totals of these amounts are also shown in the budget. 

(b) Previous year figures are also included in same format in the report (as that of 
current year, mentioned in previous point). 

(iii) Apart from above mentioned figures, following analysis is also included in budget: 

(a) The difference between current year figures and last year figures, for each 
head. 

(b) Percentage increase/decrease for each head. 

To perform this activity, using Excel, make a worksheet as shown below. 
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Budget For The Year 2006-2007 

(Figure In Lakhs) 

Head Last Year Current Year Difference 
Total % 
Diff. 

 Officers Staff Total Officers Staff Total Officers Staff Total  

Salary           

Travel & 
Tour 

          

Rent & 
Maintenance 

          

Electricity & 
Telephone 

          

Miscellaneous           

Total           

 

3. Perform following activities, for preparing the worksheet. 

(i) Wherever Totals are there, use formula for them. 

(ii) Make use of formula to calculate differences. 

(iii) Make use of formula to calculate all the percentages. 

(iv) Enter relevant data in the worksheet and test the validity of formulae used and 
worksheet. 

4.  Save the worksheet in a file.  

5.  Print the worksheet on printer. 

6.  Exit from MS-Excel 

 

**** 

 



UNIT - IV 

 

 

 

 

 

Introduction to MS-Excel Chart  

INTRODUCTION 

Representing data in the form of chart is one of the most popular methods, which is used, 

for the purpose of data analysis. Excel provides many tools and facilities, using which you 

can transform the data into charts. In this chapter we will mainly deal with charting 

capabilities of MS-Excel. Let's take the example of following data and analyze it. The data 

pertains to sales and expenditure figures of three companies viz. TEK, SUN and NET. 

When you go through the data carefully you may find the following facts from the data: 

1. Maximum sale has been made by the company NET, which paid the lowest tax. 

2.   Highest expenditure has been made by the company SUN, which has paid the 

highest tax. 

3. The company TEK has made a loss, 

while the other two companies have 

incurred a profit. 

From the above analysis, it is quite clear that 

data table is an effective medium for data 

analysis. But you have to do lot of 

calculations to bring out the hidden facts. On 

the other hand, if you transform the same 

data into a chart, no calculations have to be done. Hidden facts get revealed themselves. So 

you can say that chart is more effective medium of data representation. Details of MS-

Excel charts are described below. 

WHAT IS CHART? 

Chart is graphical representation of data. Data values are represented in terms of bars, lines, 

columns, pie, slices etc. Different bars, columns, lines etc. are colored in different colors so 

that different data series can be distinguished from one another. Standard data values are 

also plotted horizontally and vertically so as to get the exact idea of their magnitude. Figure 

8.2 illustrates some of the charts that have been plotted in MS-Excel. 

8 CHAPTER 

Figure 8.1 
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Figure 8.2 

INTRODUCTION TO MS-EXCEL CHARTS 

Excel supports 18 different types of charts to represent the data in different forms. 

Different parts of the chart can also be labeled. Which type of chart will suit best, for the 

given data will depend upon what the data pertains to and what type of analysis is to be 

done.  

Before we go into the operational aspects of drawing the chart, let's first, get introduced to 

different types of charts that can be generated in MS-Excel. 

TYPES OF CHARTS 

1. Area Chart and 3-D - Area chart.  

2. Bar Chart and 3-D - Bar chart.  

3. Column Chart and 3-D - Column chart.  

4. Line Chart and 3-D - Line chart.  

5. Pie Chart and 3-D - Pie Chart.  

6. Doughnut Chart and  

7.  XY Scatter Chart. 

Apart from above mention charts, MS-Excel provide following 3-D Charts: 

8. 3-D Cylinder Chart. 

9. 3-D Cone Chart. 

10. 3-D Pyramid Chart. 

11. 3-D Surface Chart. 
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COMPONENTS OF AN EXCEL CHART 

Excel chart not only comprises of Bars, Columns or Pies alone but it comprises of many 

other components also. Figure 8.3 illustrates different components of MS-Excel chart. A 

brief description of all its components is also given below. 
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Figure 8.3 

Chart Area : Chart Area is the entire area that is reserved for accommodating the chart 

and other components such as legends, titles etc. 

Plot Area : Plot area is part of chart area, which contains the chart. 

Y Axis : It is the vertical line whose length and segments represent different 

values, which you will be making use of, to show the variation of different 

identities (such as sales, expenditure, profit figures etc.) when you plot the 

chart. 

X Axis : A horizontal line, which meets Y axis at right angle, on which you show 

the variation of another component (such as time, month, year etc.) of the 

chart. Its length and segments represent different intervals of values. 

Y Axis Title : Y axis title identifies the values, which have been illustrated on Y axis. 

For example, simply writing 10, 50, 100, 150 etc. on Y axis doesn't 

convey the full details of the values. But a Y axis title 'Sales value in 

Lakh clearly illustrates that the figures written on Y axis represent Sales 

figures and that too in Lakh. 

X Axis Title : Similar to Y axis title, X axis conveys details of the X axis values. 

Chart Title 

Plot Area 

Chart Area 

Data Label 

Y Axis Title 

Y Axis Values  

Y Axis 

X Axis 

Tick Mark X Axis Title  

Legend  

Grid Lines  

Data Point/ 

Marker  
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Tick marks : They are the small lines, used to divide both the axes into small segments, 

in order to form a scale. 

Grid Lines : Grid lines are the lines that can be thought of as an extension of tick 

marks. They help in reading the values of the data points. They are scaled 

according to the values of the axes. 

Data Series : Data series is a collection of 

related values that are 

plotted on a chart. For 

example, following are two 

data series: 

Data Point : It represents one value     of 

the data series. 

Data Label : Data label is some piece of text, which is written near data point, to 

highlight some aspect of it. For example, writing 'Max' identifies that this 

data point represents the maximum value of the series. 

Chart Title : Chart title is the text, written in chart area, which identifies the chart. For 

example, the chart title, 'Sales Performance Chart' clearly states that the 

chart has been plotted to represent sales performance of the 

company/companies, graphically. 

Legends : Legends are some sort of labels that identify different series that have 

been plotted in the chart. Generally these labels are attached to a symbol 

or color or pattern that is associated 

with the series of the chart. It is used 

to distinguish one data series from 

another. 

MAKING A CHART USING CHART 

BAR 

In order to make a chart, using chart bar, firstly you 

have to display the chart bar on the screen and then 

perform the required steps. The procedure to display the 

chart bar is explained below: 

Displaying The Chart Bar 

Perform following steps to display the Chart Bar on the 

screens, if it is not there:  

1. Select "View" option from the bar menu. When 

you do so, View submenu, as shown in figure 

8.5(a), will appear on the screen.  

Figure 8.4  

(a)   (b) 

Figure 8.5 
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2. Select "Toolbar" option from View submenu. When you do so, another submenu, as 

shown in figure 8.5(b), will appear on the screen.  

3. Select "Chart" option from this submenu. On doing so, a chart bar, as shown in 

figure 8.6, will appear on the screen: 

 

 

 

 

 

 

 
Figure 8.6 

Making A Chart 

Perform following steps to prepare the desired chart: 

1. Select that portion of the data that has to be transformed into chart. Let's take the 

example of the data pertaining to three companies viz. Tek, Sun & Net that is 

shown in figure 8.7(a). Select the range A2:D6. 

     

Profit & Loss Chart
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(a)          (b) 

Figure 8.7 

2. Now select "Chart Type" button from the chart bar. On selecting this button, MS-

Excel will display a chart list as shown in figure 8.8.  

3. Select the desired chart type from this list. Say you select Column Chart option 

from this list.  

When you do so, MS-Excel will automatically plot the chart and include it as an object in 

the worksheet. A Column chart made for the options chosen above is shown in figure 

8.7(b).  

Chart Object

Format Selected Object

 Chart Type  By Row 

Data Table 

By Column 

Angle Text 

Downward 

Angle Text 

Upward 

Legend 
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Refer figure 8.7(b) and note the following points: 

1. Clicking on the 'Legend' button will display or hide the legend in 

the chart. 

2. To plot the data series according to the row, click on  'By Row' 

button. If you want to plot the series according to the column, select 

the 'By Column' named button. 

3. To display the chart text diagonally, select 'Angle text' button. 

CHANGING CHART VALUES 

Once you have created a chart, its data points (columns in case of Column 

charts, bars in case of Bar charts, slices in case of Pie charts etc.) get automatically linked 

to the values (of the worksheet), based on which they were created. Due to this link, on-line 

updating of charts is possible. In On-line updating, if you change the values in worksheet, 

corresponding change is automatically reflected in the chart, without giving any command 

or performing extra function. For example, if you have plotted a column chart for depicting 

the sales performance of three companies viz. Tek, Sun and Net, in which Tek’s sales was 

Rs. 5000. Now if you change the value from 5000 to 10000 then immediately the height of 

Tek’s column (representing sales figure) will increase. 

INTRODUCTION TO FORMATTING OPERATIONS 

While working with MS-Excel charts, you may be required to perform following types of 

functions: 

1. Change size of the chart. 

2. Move the chart to a different suitable location. 

3. Change the titles, legends, text etc. 

4. Change the font, font size and style etc. of the text. 

All such types of operations are called formatting functions. Remember that for most of the 

formatting functions, first you have to select the chart and then that particular component 

of the chart that has to be modified and then perform formatting operation on it. The 

procedure for selecting the chart and 

its components is described below. 

Selecting The Chart 

Chart can be selected by clicking the 

mouse on it. When you select the 

chart, handles appear around the 

chart, as shown in figure 8.9. 
 

 

 

Figure 8.8 

 

                      Figure 8.9 

Handle 
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Selecting Items In A Chart 

Perform following steps to select an item of the chart: 

1. Select the chart by clicking the mouse on the chart. 

2. Now click the mouse on the item that you want to select. 

For example, if you wish to select the legend of the chart, first select the chart by clicking 

the mouse on it and then click it on the legend. When you click the mouse on the item, it 

gets surrounded with a border with handles, which indicates that this component of the 

chart has been selected for modification. 

Canceling The Selection 

To cancel the selection press Esc  (escape) key or click the mouse on any blank space of the 

worksheet. 

Deleting A Chart 

To delete a chart, first select the chart and then press "Del" key of the keyboard. 

Moving The Chart 

To move the chart from one location to another, simply select the chart and drag the mouse 

to the new location. As you drag the mouse, chart will also move along with the mouse 

pointer. When you release the mouse button the chart will get located at new location. 

Sizing The Chart 

To change the size of the chart (increase/decrease), first select the chart and then place the 

mouse pointer at any handle. The mouse pointer will change to a double-headed arrow 

pointer. Now drag the mouse. Dragging the mouse will change the size of the chart. 

Changing The Title In The Chart 

Perform following steps to make changes in the title: 

1. First select the title that needs to be altered. 

2. Now select "Chart" option from the bar menu. When you do so, a 

submenu, as shown in figure 8.10, will appear on the screen.  

3. Now select "Chart Options" option from this submenu. When you do 

so, a dialog box, as shown in figure 8.11, will appear on screen. 
 

Figure 8.10 
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Figure 8.11 

4. Click the mouse in 'Chart Title' text box and enter the title. If you wish to change 

the title of the chart. If you wish to make changes in X axis title or Y axis title, 

select corresponding text boxes and enter new titles in the desired text box. 

5. At last, click the mouse on "OK" button. 

When you do so, selected chart will get updated automatically. 

Making Other Modifications In The Chart 

Other modifications can be made in the chart by clicking the mouse on other tabs like 

"Axes", "Gridlines", "Legends", "Data Labels" etc. present in the dialog box and entering 

modified data in corresponding text boxes that appear within the dialog box.   

 

 

EXERCISES                      CHAPTER 8 

 

Short Type Questions 

A.  Select best possible options for following questions: 

1. What is chart? 

 (a)  Another form  of data   (b)  Graphical representation of data 

 (c)  Data arranged in the from of table (d)  A method of comparison. 

2. Which  type of chart cannot be made  MS-Excel? 

 (a)  Doughnut  chart       (b)  Pie chart   

 (c)  Histogram chart    (d)  Bar chart 
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3. Which type of chart shows percentage wise contribution of an item in the complete 
whole? 

 (a)  Pie chart  (b)  Bar chart  (c)  Column chart (d)  X Y chart 

4. Which of the following chart should be plotted to compare the sales and 
expenditure figure of 5 companies? 

 (a)  Column chart (b)  Pie chart       (c)  Pyramid chart (d)  X Y Plot 

B.  Fill in the blanks.  

5. The shape of Pie chart is always……………………………………………………. 

6. That chart, which make use of vertical bars to plot the data series is called 
………………………………………chart. 

7. That chart, which compares percentage wise contribution of all the participating 
items is called ……………………………………………………chart. 

8. To make the chart bar appear on the screen, you need to select……………….option 
from the bar menu. 

9. The graph that you plot in MS-EXCEL, is included as an   ………in the worksheet. 

C.  State, true or false for following statements: 

10. Chart is graphical representation of data. 

11. Chart helps in data comparison and data analysis. 

12. Doughnut is a type of chart that can be made in MS-EXCEL. 

13. MS-EXCEL has provision for making 3-D charts also. 

14. To select the legend of the chart, you will have to first click the mouse on chart area 
and then on legend. 

D.  Answer the following questions in short: 

15. Name any two charts that can be plotted in MS-EXCEL. 

16. Name any two charts of MS-EXCEL that are circular in shape. 

17. Name any two charts that comprise of columns. 

18. Write the steps to select the title of the chart. 

19. Give example of data series. 

Detailed Answer Type Questions 

E.   Answer the following questions in detail: 

20. What is chart? What are its advantages over data presented in the form of table? 

21. Differentiate between bar chart and column charts. 

22. What is Pie chart? Explain using an example. 

23. What does On-line updating of chart mean? 

24. Differentiate between Pie chart and Doughnut chart. 
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25. Exercises   

PRACTICAL ASSIGNMENTS 

 

Assignment 1 : Plotting Chart For Given Data. 

1. Assume that five student of a collage scored marks in their final examination, as 
mentioned below. 

 

 Subject 

Student Name Physics Chemistry Maths 

Rahul 88 90 98 

Soni 80 82 86 

Ranjna 90 69 96 

Atul 70 75 85 

Vipul 75 76 77 

 

2. Enter this data in Excel worksheet to present it in the form of a table. 

3. Enter formula in the worksheet to calculate total marks for Rahul. 

4. Copy above mentioned formula for other students. 

5. Plot a Pie chart for Rahul to show subject wise contribution. 

6. Plot a Bar chart to show subject wise comparison of marks for Atul and Vipul. 

7. Plot a Doughnut chart to show subject wise comparison of marks for Rahul and Soni. 

Assignment 2 : Plotting Another Chart For Given Data. 

8. Assume that target and achievement figure of three companies are as follows: 

 

Company Budget Achievement 

JET 500 498 

SPARK 800 980 

FUSION 300 600 

 

9. Enter above mentioned data in MS-Excel worksheet. 

10. Enter a formula in suitable cell to calculate the difference between target and 
achievement. 

11. Copy this formula for other two companies.  



 

 

168    Computer Application For Engineering 

12. Plot a column chart to show budget and achievement figures of all the three companies. 

13. Modify the chart and: 

(i) Include "Performance Chart For 2007" as chart title in the chart. 

(ii) Include "Company" as X axis title in the chart. 

(iii) Include "Value in Lakh" as Y axis title in the chart. 

14. Change achievement figure of FUSION Company from 60 to 1000 and observe the 
change in the chart. 

15. Select achievement column of SPARK Company and drag it downwards and observe its 
effect on corresponding data in worksheet. 

16. Move the chart to some other location. 

17. Change the size of the chart. 

18. Convert column chart into bar chart. 

19. Copy the chart in some other worksheet. 

20.  Delete the charts. 

 

  **** 



UNIT - V 

 

 

 

 

 

MS-PowerPoint 

INTRODUCTION 

Be it internal activities of any office or external affairs of an organization, effective 

communication plays a major role in their success. In order to make the communication 

effective, innovation and creativity both have to be built into the presentation. Unless the 

presentation is interesting, audience will not pay attention to the speaker. 

Computer is a modern tool, which helps in building impressive presentations and 

presenting a subject before the audience in interesting way. PowerPoint is one of the most 

popular software, which is used for making computer-based presentations. 

MANUAL PRESENTATION 

When a speaker talks on a subject, before the audience it is said that he is making a 

presentation. For example, when Managing Director of an organization addresses Sales 

Mangers to tell them sales plan of the next year, it is said that he is making a presentation. 

Similarly in an exhibition, exhibiter makes a presentation of his product before the crowd. 

All these are of manual presentations. 

POWERPOINT PRESENTATION  

PowerPoint presentation is basically a series of slides, containing information of the subject, 

which is to be put before the audience. They appear on computer screen, one after the other, 

either automatically or on a click of mouse. 

ELEMENTS OF POWERPOINT PRESENTATION 

In order to make the presentation impressive, PowerPoint presentation slides may contain 

multimedia elements like text, graphics, audio, animation, video etc. in them. These elements put 

together open multi channels of communication and make the presentation more convincing. 

9 CHAPTER 
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GETTING STARTED WITH POWERPOINT 
Perform following steps to start work in PowerPoint:  

1. Click the mouse on "Start" button, present on desktop. When you do so, Start menu, 

as shown in figure 5.1(a), will appear on the screen. 

2. Select "All Programs" option from Start menu. 

When you do so, another submenu, as shown in 

figure 5.1(b) will appear on the screen. 

3. Select "Microsoft PowerPoint" option from this 

submenu. When you do so, a dialog box, as shown 

in figure 9.1, will appear on the screen. 

4. To open a new blank presentation, select "Blank 

Presentation" option from this dialog box. 

5. Now click the mouse on "OK" button. When you do 

so, a dialog box for selecting the slide layout, as 

shown in figure 9.2, will appear on the screen. 

6. Select the desired layout from this dialog box. Say 

you select "Text & ClipArt" layout. 

7. Now click the mouse on "OK" button. When you do 

so, selected layout, within the PowerPoint window, as shown in figure 9.3, will 

appear on the screen. 

Now you can add desired contents in the slides. The procedure for including different items 

in the slide is explained below. 

     

Figure 9.2      Figure 9.3 

Adding Title In The Slide 

To add title in the slide, click the mouse in Title placeholder and Type the title. To change 

the font, font size and font style drag the mouse on text and select desired specifications, using 

respective objects (like drop down lists, buttons etc.), present in Format toolbar. 

 
Figure 9.1 
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Adding Text In The Slide 

Click the mouse within Text placeholder and type the text. To change the font specifications, 

follow the method mentioned above. 

Adding Clipart In The Slides 
PowerPoint has an inbuilt graphics library of its own. Perform following steps to include pictures 

from that library, into the slide: 

1. Double click the mouse within ClipArt placeholder. When you do so, ClipArt 

dialog box, as shown in figure 9.4, will appear on the screen. 

2. Select a category of the clipart from this dialog box, by double clicking the mouse 

on desired category icon. When you do so, all the clip arts available in the selected 

category appear on the screen, as shown in figure 9.5. 

   

Figure 9.4     Figure 9.5 

3. Click the mouse on desired clipart. When you do so, a 

graphical popup menu, as shown in figure 9.6, will 

appear on the screen. 

4. Now click the mouse on "Insert Clip" option. 

When you do so, the selected clip art will get included in the slide. 

Including Notes 

To include a brief description or remarks about the slide, so as 

to make the slide more informative, click the mouse in "Click to add notes" placeholder and 

type the contents. 

Note that these contents (notes) are for documentation purpose only. They do not get 

displays when the slide show goes on. 

ADDING NEXT SLIDE TO THE PRESENTATION 

After completion of the first slide, next slide can be added to the presentation by 

performing following steps: 

 
   Figure 9.6 

Insert Clip 
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1. Select "Insert" option from the bar menu. When you do so, Insert submenu, as 

shown in figure 9.7(a) will appear on the screen. 

2. Select "New Slide" option from Insert submenu. When 

you do so, a dialog box, as shown in figure 9.2 for 

selecting the slide layout, will appear on the screen. 

3. Select the desired layout from this dialog box and 

click the mouse on "OK" button. When you do so, 

placeholders as shown in figure 9.3, will appear within 

PowerPoint window. 

4. Now add the desired contents, like text, graphics, 

notes etc. to the slide, following the methods, 

mentioned above. 

Following above mentioned method, you can add as many slides 

to the presentation as you want. 

DIFFERENT SLIDE VIEWS  

Once the slides of the presentation are made, they can be viewed in different modes. 

PowerPoint offers following modes for viewing the slides: 

1.  Normal View    2.  Outline View   3.  Slide View    

4.  Slide Sorter View 5.  Slide Show View 

Each mode serves a different purpose and offers ease of operations, while performing 

specific type of task. A brief introduction of each mode is given below. 

Normal View 

A slide and its contents, as they would appear in Normal View are shown in figure 9.8.  

 

Figure 9.8  

Refer this figure and note that Normal View comprises of three panes. These panes are 

Outline pane, Slide pane and Notes pane. 

 

(a)   (b) 

Figure 9.7 

Slide Pane 

Notes Pane 

Outline Pane
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In outline pane, title and the text get displayed in hierarchical order. It is generally utilized 

for organizing the slides, within the presentation and text within the slides. For example, 

the text can be added modified, shifted or deleted in outline pane. Similarly position of the 

slides can also be changed by dragging and dropping them at desired place. 

In slide pane, the physical appearance of the slide gets displayed. Note that if slide includes 

graphics, pictures etc. they do not get displayed in outline pane. They are visible in slide pane. 

Notes pane is the place, where speaker notes or important information that is to be shared 

with audience is maintained. 

Outline View 
A slide and its contents, as they will appear in 

Outline View, are shown in figure 9.9.  

Refer this figure and note that it is basically a 

rearrangement of Normal View. In this view, 

outline pane occupies larger space and Slide Pane 

becomes smaller. 

For rearranging the contents and the slides, 

outline view comes handier than Normal View. 

Slide View 
As the name indicates, in Slide View, single slide gets displayed at a time. Physical 

appearance of the slide gets displayed in a larger area. To modify the contents, slide can be 

displayed in Slide View mode and then changes can be made. An idea of Slide View mode 

is given in figure 9.10. 

Slide Sorter View 

In slide sorter view, all the slides of the presentation get spread across the screen in 

miniature form. An idea of this mode is given in figure 9.11. While working in this mode, 

you get an idea of how the presentation will flow. If the need be, rearrangement of the 

slides can be done in this mode by dragging and dropping them at desired place. 

        

                          Figure 9.10                     Figure 9.11 

 

Figure 9.9  
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Slide Show View 

In this mode, all the slides of the presentation appear one after the other on the screen either 

automatically or on a click of mouse. More details of this mode are given later in this chapter. 

Switching From One View Mode To Other 

Refer figure 9.12 and note that at the bottom left corner of PowerPoint window there are 

five view buttons. Each button corresponds to a view mode. To switchover to a view mode, 

you need to click the mouse on corresponding button. For example, if you are it Normal 

View mode and wish to switchover to Slide Sorter view mode, you will have to click the 

mouse on Slide Sorted view button. 

 
Figure 9.12  

APPLYING ANIMATION 

To make the presentation interesting, objects of the slides can be animated. In PowerPoint, 

animation is applied through "Animation Effects" toolbar. Usually it doesn't remain present 

on the screen but it can be made to appear by right clicking the mouse on any toolbar and 

then selecting "Animation Effects" option from the popup menu that appears thereafter.  

Animation Effects toolbar is illustrated in figure 9.13. 

 

 

 

 

 

 

 

 

Figure 9.13  

Normal View 

Slide View 

Slide Sorter View 

Outline View Slide Show 

Animate Title

Animate Slide Text

Drive-In Effect

Flying  Effect

Camera  Effect

Flash Once
laser Text Effect 

Typewriter Text  Effect 

Reverse Text Order Effect 

Animation Order 

Custom Animation 

Drop In Animation Preview 
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Perform following steps to apply animation in any slide: 

1. Make the slide appear in Normal view mode. 

2. To animate the title of the slide, click the mouse on "Animate Title" button, present 

in Animation Effects toolbar. On the other hand, if you wish to animate the text of 

the slide, select "animate Slide Text" button. 

3. Select the desired animation effect by clicking the mouse on corresponding button (such 

as Drive-In effect, Flying effect etc.) present in Animation Effects toolbar. 

4. If more than one objects are to be animated on the slide, their animation order can be 

selected through "Animation Order" drop down list, present in the toolbar. 

5. To preview the effect of selected animation, click the mouse on "Animation 

Preview" button, present in the toolbar. 

6. When you do so, a small window will appear on the screen and animation effects 

will get displayed in that window. 

Once all the effects have been applied, slide show can be run. 

INTRODUCTION TO SLIDE SHOW 

In slide show, all the slides of the presentation get displayed on the screen, one by one. 

Next slide replaces the previous slide in attractive and eye-catchy manner. Slide shows can 

be of following types: 

1. Manual Slide Show 

2. Automatic Slide Show 

Basic characteristics of both types of slide shows are described below. 

Manual Slide Show 

In manual slide show, one slide replaces the other slide only when space bar is pressed or 

mouse is clicked. Till the time any of these two events don't take place, slide remains 

visible on the screen. 

Automatic Slide Show 

In automatic slide show, each slide has certain time duration, called Slide Timing, assigned 

to it. Slide remains there on the screen, for this duration and as soon as time duration is 

over, next slide of the presentation replaces it. 

Looped Slide Shows 

A slide show, be it automatic or manual, is said to be running in loop, if after the display of 

last slide, first slide of the presentation replaces it again and again. 

TRANSITION EFFECT 

The way one slide replaces the other slide, during the slide show is called Transition Effect. 
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For example, the next slide may take entry on the screen from left hand side and gradually 

replace the previous slide. Similarly, in other transition effect the first slide may tear apart 

from the middle, as if stage curtains are sliding left and right and the next slide is slowly 

becoming visible in back. 

PowerPoint offers many transition effects, which can be selected and applied to one, many 

or all slides of the presentation. 

Applying Transition Effect And Slide Timings 

Perform following steps to apply slide timings and transition effect to the slides of the 

presentation:  

1. Open the presentation and display the slide, in which the transition effect or slide 

timing is to be applied, in Normal View mode. 

2. Select "Slide Show" option from the bar menu. When you do so, Slide Show 

submenu, as shown in figure 9.14(a) will appear on the screen. 

         

      (a)        (b) 

Figure 9.14 

3. Select "Slide Transition" option from this submenu. When you do so, a dialog box, 

as shown in figure 9.14(b) will appear on the screen. 

4. Select the desired transition effect from "Effect" dropdown list. 

5. Select the speed of the transition (i.e. how fast the replacement of one slide by the other 

has to be done) by clicking the mouse on Slow, Medium or Fast radio button. 

6. If the slide show has to advance on the click of the mouse, check "On mouse click" 

check box. 

7. If slide timing is to be assigned to the slide, check "Automatically after" check box 

and specify the time duration (for which the slide has to stay on the screen), using 

corresponding spinner. 
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8. If sound is to be produced on its appearance on screen, select a sound clip from 

"Sound" drop down list. 

9. If the sound clip is to be played till the time other sound is invoked, check "Loop 

until next sound" check box. 

10. If these settings are to be applied to the current slide only, click the mouse on 

"Apply" button. On the other hand, if the settings are to be applied to all the slides 

of the presentation, click it on "Apply to All" button.  

When you do so, selected transition effect and chosen slide timing will get applied to the slides. 

SETTING UP THE SLIDE SHOW 

After making the slides and applying transition effects, certain parameters related to slide 

show need to be set. Perform following steps to set those parameters: 

1. Open the presentation, for which the parameters need to be set. 

2. Select "Slide Show" option 

from the bar menu. When 

you do so, Slide Show menu, 

as shown in figure 9.14(a), 

will appear on the screen. 

3. Now select "Set up Show" 

option from this submenu. 

When you do so, a dialog 

box, as shown in figure 9.15, 

will appear on the screen. 

4. To run the slide show in loop, 

either select "Browsed at a 

kiosk (full screen)" radio button or check "Loop Continuously until Esc" check box. 

5. If narration and animation, present in the presentation are to be displayed, check the 

corresponding check boxes. 

6. If all the slides of the presentation have to participate in the slide show, select "All" 

radio button else select "From", button and specify the slide numbers that have to 

appear in the slide show. For this, make use of the "From" and "To" spinners, 

present in the dialog box. 

7. If the slide show has to run in manual mode (slides advance on the click of mouse 

or on pressing space bar), select "Manually" radio button. For automatic slide show, 

select "Using timings, if present" radio button. 

8. At last, click the mouse on "OK" button. 

When you do so, slide show will get ready to run as per the specifications set by you. 

 
Figure 9.15 



 

 

178    Computer Application For Engineering 

RUNNING THE SLIDE SHOW 

To run the slide show, follow any one of the methods described below: 

1. Select " Slide Show" option from " View" submenu. 

or 

2. Select "View Show" option from "Slide Show" submenu.  

    or 

3. Click the mouse on "Slide Show" button, present at the left bottom part of 

PowerPoint window. 

 

 

 EXERCISES                      CHAPTER 9 

 

Short Type Questions 

A.  Select best possible options for following questions: 

1. For which type of activities, PowerPoint suites well? 

(a) Creating animations               (b) Drawings and coloring 

(c) Creating sound effects            (d) Making presentations 

2. Which of the following is not a valid view mode of PowerPoint? 

(a) Outline View         (b) Slide Sorter View    

(c) Graphic View         (d) Slide Show View 

3. Which of the following can be included in the slides of PowerPoint presentation? 

(a) Animation       (b) Sound     (c) Both of the above    (d) None of the above 

4. In which of the following mode, all the slides of the presentation can be seen at a 
glance?  

(a) Slide Sorter View       (b) Slide Show View  

(c) Both of the above    (d) None of the above 

5. Which of the following option of bar menu will have to be selected for adding 
background sounds in the slides? 

(a) Insert     (b) Edit     (c) File  (d) View 

B.  Fill in the blanks.  

6. ..................... is a software, using which slide shows can be created on computer. 

7. All modifications in PowerPoint slide are done in .................. view mode. 

8. The slide show, in which slides of the presentation advance after fixed interval of 
time, is called ...................... slide show. 
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9. A slide show, in which first slide of the presentation replaces last side every time 
presentation is run, is said to run in ........................... 

10. Five view modes of PowerPoint presentation are  (a) ...................... 
(b)......................    (c) ......................    (d) ......................           (e) ...................... 

C.  State, true or false for following statements: 

11. In PowerPoint presentation, contents of the slide can be shown moving. 

12. In Slide Sorter view mode, slides of the presentation appear one after the other, 
when you click the mouse. 

13. Remarks and notes can always be included in every slide of the PowerPoint 
presentation. 

14. Before running the slide show properly, you need to set up the slide show. 

15. PowerPoint picture library is called ClipArt gallery, from where picture can be lifted 
and included in the slides. 

D. Answer the following questions in short: 

16. Name any three contents, which could be included in a slide. 

17. Where will you click the mouse to switchover from Normal view to Slide view? 

18. Using which option of the Bar menu, you can add transition effects in the slide? 

19. Using which object, animation is introduced in the slides? 

20. What happens if you animate the title of the slide?  

 

Detailed Answer Type Questions 

E.  Answer the following questions in details: 

21. What is PowerPoint? What is its purpose? 

22. State the type of activities for which PowerPoint software is used? 

23. State at least two advantages of using PowerPoint. 

24. Differentiate between Normal view and Slide view of PowerPoint. 

25. Differentiate between Slide Sorter view and Slide show view of PowerPoint 

26. What is slide timing? What effect does it create at the time of slide show? 

27. Differentiate between automatic slide show and manual slide show. 

28. What is animation? How it is different from video? 

29. How will you animate the title of a slide? 

30. What is transition effect? How will you introduce it in a PowerPoint slides?  
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PRACTICAL ASSIGNMENTS 

 

Assignment 1 : Preparing A Presentation. 

1.  Assume that you have to talk about India in an international seminar. For this, you have 
to make PowerPoint presentation comprising of many slides. Titles of these slides and 
their contents are suggested below:      

Title  Contents 

India is a great country Few sentences in appreciation of India. 

Geographical facts Few facts like Himalayas in north, Indian ocean in south, area, 

population etc. 

Unity in diversity Different states and their cultures. Feeling of unity that 

prevails. 

Highlights Important aspects of India and its strong points. 

Famous tourist spots Names and highlights of famous tourist spots of India. For 

example, Taj Mahal, sea beaches of Goa, Palaces of Jaipur etc. 

Famous temples Locations of famous temples and stories associated with them. 

Events Few famous events like independence day, festivals like 

Diwali, Holi etc. 

Personalities World renowned personalities and their contributions. 

Indian culture Greatness of Indian culture and its difference from other 

cultures. 

East or west India is best  All those aspects, which make India better than other countries. 

Developments of India Progress that India has made in last decade. 

My dream India What India should be after 10 years. 

2.  Collect above mentioned details and write them on paper. 

3. Create all slides mentioned above. 

4. Now run the slide show and test the presentation. 

5. Add clip arts in few slides. 

6. Run the slide show again. 

7. Apply transition effect on the slides. 

8. Run the slide show again. 

9. Make animation toolbar on and apply animation in first slide. 

10. Run the slide show again. 

11. Apply slide timings to the slides and run the presentation in automatic mode. 

12. Run the slide show in loop. 

**** 
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MS-Access   

INTRODUCTION 

MS-Access is database management system. It has been designed and developed by 

Microsoft Corporation of USA for performing data storage and retrieval type of activities 

on computer. It stores data in the form of tables and provides means for defining the 

selection criterion for retrieving the data and presenting it in the form of report. What are 

tables, how they are defined and how data is entered and retrieved from them are the topics, 

which are described in this chapter. 

INTRODUCTION TO TABLE 

Table is basically collection of rows, divided into one or more columns. Each row consists 

of complete information of a single identity (such as individual, object, place etc.) and each 

column of the row represents an attribute, related to which the information is maintained 

within the table. 

For example, a table containing data of ten meritorious students, who secured first ten 

positions in the examination, is illustrated below: 

Roll No. Name Sex City Age Marks 

101 Ravi M Delhi 17 855 

170 Jyoti M Hyderabad 18 846 

210 Rahul M Mumbai 19 835 

525 Seema F Mumbai 17 795 

750 Jyoti F Lucknow 20 780 

810 Suman F Hyderabad 18 780 

825 Alok M Chennai 19 775 

888 Saket M Hyderabad 18 760 

860 Sachin M Mumbai 21 747 

920 Tarun M Delhi 19 735 

10CCCCHAPTERHAPTERHAPTERHAPTER    
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Record 

Each row of the table is referred to as record. In other words, you can say that complete 

information of an individual identity that is being maintained within the table, is called 

record. Refer above mentioned table and note that it contains 10 records. 

Field 

Columns of the row are referred to as fields.  In other words, you can say that all those 

attributes, related to which information is being maintained in the rows are called fields. 

Refer above mentioned table and note that each record consists of 6 fields.  

Concept Of Primary Key 

The field that uniquely identifies the record is called Primary Key. Refer above illustrated 

data. It consists of 10 records and 6 fields. In this data, Roll Number field uniquely 

identifies the record. For example, when you say, get me the record of roll number 170 then 

there is no confusion. In response, record of Jyoti, male student is given to you. On the 

other hand, if you ask for record of Jyoti, confusion prevails. It is not sure, whether record 

of roll number 170 is to be fetched or record of roll number 750 is to be fetched because 

both of them have the same name. Similarly neither sex field nor city nor age nor marks 

field can uniquely define the record. In other words, it can be said that value of Primary 

Key doesn't get repeated in the table. 

DATA TYPES 

Refer previously illustrated table and note that Roll Number is a field, which consists of 

numbers. Similarly Name field consists of alphabets. Now the question is what all types of 

data can be accommodated in MS-Access fields? Well, an introduction of the data types, 

supported in MS-Access is given below. 

Text 

Text data consist of alphabets, numbers, special characters etc. For example, India, 77 Park 

Avenue, Hyderabad-08 etc. are examples of Text data. 

Fields that hold text data are called Text fields. In MS-Access, text fields can hold 

maximum up to 255 characters. Default length of text field is 50 characters. 

Memo 

Like text data, memo data also consists of alphabets, numbers, special characters etc. But they 

can consist of more than 255 characters. Those fields, which hold Memo data, are called Memo 

fields. In MS-Access, practically there is no limit to the length of Memo fields. They are 

generally utilized for storing long history or remarks associated with the record. 

Number 

Number data consists of numerical figures. For example, 175, 266.87, 23.4298 etc. are 

examples of Number data. 
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Fields that hold numbers are referred to as, Number fields. Number fields can either hold 

integer numbers or real numbers (number with decimal point).  

Date/Time 

Date and Time data consists of valid date and time values respectively. In date, day, month, 

year values are separated by forward slash. For example, 05/03/2006, 10/12/2004 etc. are 

valid date values. Similarly 10:15:05AM, 10:25:30PM etc. are valid time values. 

Currency 

Currency data consist of financial figures. For example, 100.25, 77.75 etc. are financial 

figures. Those fields, which hold financial figures, are called Currency fields. In MS-

Access these fields are accurate up to 15 digits on left of the decimal point and 4 digits on the 

right of decimal point. While doing calculations, rounding off is prevented in this type of field. 

Auto Number 

These fields are basically, serial number fields, in which serial number is automatically 

entered (by MS-Access). 

Yes/No  

Those fields, which hold logical data, are called Yes/No fields. Valid logical values that 

can be held in them are T and F. If you enter Yes in this field, T gets stored in the table. On 

the other hand, if you enter No, F gets stored. 

OLE 

Objects like, MS-Excel Worksheet, graphical pictures, sound clips, video clips etc. are example 

of OLE data. Those fields that hold OLE data are called OLE fields. In MS-Access these fields 

basically hold the links to OLE objects, which have been created by other softwares. 

Hyperlink 

Hyperlink is basically a link to other object. When you click the mouse on hyperlink, linked 

object is accessed. Those fields, which contain hyperlinks, are called Hyperlink fields. 

Lookup Wizard 
It is a special type of field, which when defined, allows you to select the values, which 

have already been entered. For example, if the examination of the students is to be held 

only in Hyderabad, Bangalore and Chennai then these three cities can be entered in a table 

and examination center choice of the student, in some other table, can be defined as lookup 

wizard field, so that while entering student's data, no other city than these three cities is entered. 

TABLE STRUCTURE 
Now you are familiar with characteristics of MS-Access tables and the field types that are 

allowed in MS-Access. Now the question is, what is "table structure"? Table structure is the 

format of the record, which clearly defines the names of the fields, type of data that they 

will hold, length and format of the data that will be contained in them. 
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For performing data storage and retrieved activities in MS-Access, you need to first decide 

the table structure. To get familiar with this process, let's define the table structure for the 

data, which is illustrated in the last table: 

Name of the field Field Type     Width of the field   Number of places after decimal 

Roll Number    0 

Name Text  30 

Sex Text  1 

City Text  15 

Age Number    0 

Marks Number    0 

Once table structure is finalized, tables can be created, data can be entered and retrieved as 

per requirements. 

CREATING TABLE 

MS-Access provides many ways of creating a table structure. Some of them are as follows: 

1. In Datasheet view 

2. Using Table wizard 

3. Using Design view 

Most versatile method is, "Using Design 

View" method. Perform following steps to 

create a table in Design view: 

1. Click the mouse on "Start" button, 

present on desktop. When you do 

so, Start menu, as shown in figure 

5.1(a), will appear on the screen.  

2. Select "All Programs" option from 

Start submenu. When you do so, 

another submenu, as shown in figure 5.1(b), will appear on the screen. 

3. Select "Microsoft Access" option from this submenu. When you do so, a window 

with a dialog box, as shown in figure 10.1, will appear on the screen. 

4. Create a blank database, by selecting "Blank Access database" option and clicking 

the mouse on "OK" button. 

 When you do so, a dialog box, as shown in figure 10.2, will appear on the screen. 

5. First select the drive and the folder, in which you wish to create the database and 

then enter the name that you wish to assign to this blank database (being created) in 

"File name" text box. 

 

Figure 10.1 
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6. At last, click the mouse on "Create" button. Say, you create a blank database with 

the name "MYDB". 

When you do so, a dialog box, as shown in figure 10.3, will appear on the screen. If 

somehow the options within the dialog box are different, click the mouse on "Table" 

option. 

      

Figure 10.2      Figure 10.3 

7. Select "Create table in Design view" option and click the mouse on "Open" option, 

present in database design toolbar. 

 When you do so, Data Design window, as shown in figure 10.4, for entering the 

table structure, will appear on the screen. 

 

           Figure 10.4  

 Refer Data Design View window and note that it consists of following three panes: 

   (a) Field Entry pane (for entering field details) 

(b) Field Property pane (for entering field property details) 

(c) Help pane (for displaying help messages related to current entry) 

Field Entry 

Pane 

Field Property 

Pane

Field Selector
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8. Enter the field name in "Field Name" column. Say you enter roll (for the example 

taken above) in this column. When you do so, a drop down list will automatically 

appear in "Data Type" column.  

9. Now select the field type from the drop down list, present in "Data Type" column. Say 

you select Number for the example mentioned above. 

10. To set the properties for the current field, click the mouse on "General" tab, present 

in Field Property pane and enter the details in the text box provided against 

property title. For example, if no digit is to be entered after decimal, enter 0 in 

"Decimal Places" text box. 

 Similarly if the field is "must enter" type (i.e. it can 

never be left blank), enter "Yes" in "Required" text box. 

11. Repeat the process for all the fields of the table. For 

above mentioned example, you will have to repeat the 

process for name, sex, city, age and marks fields. 

12. To save the table structure in a file, click the mouse on 

"File" option present in bar menu. When you do so, File 

submenu, as shown in figure 10.5 will appear on the 

screen. 

13. Select "Save As" option from File submenu. When you 

do so, a dialog box, as shown in figure 10.6, will appear on the screen. 

14. Enter the name that you wish to assign 

to the table in "Save Table" text box 

and select "Table" option from "As" 

drop down list box. For example, you 

enter "Students" in this text box to 

save the table with name "Students". 

15. At last, click the mouse on "OK" 

button. 

When you do so, the table will get saved in the database (Mydb for this example). 

DATA ENTRY 

After saving the table in the database, data can be entered in the 

table by performing following steps: 

1. Click the mouse on "View" button, present in Data Design 

View window. When you do so, a list of options, as shown 

in figure 10.7, will appear on the screen. 

2. Select "Datasheet View" option from this list. When you do so, Datasheet view 

window, as shown in figure 10.8, will appear on the screen. 

 
Figure 10.5 

 
Figure 10.6 

 
Figure 10.7 
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3. To enter the data in the table, using Datasheet view window, make use of following 

procedures: 

(a) To enter the data in any field, 

click the mouse in the 

corresponding blank space (cell) 

and type the data. When the field 

becomes full, no more characters 

will be accommodated in the field. 

(b) To move to the next field or 

previous field of the same record, 

make use of right and left arrow 

keys respectively. 

(c) To make modifications within the 

current field, make use of DEL and Backspace keys. 

(d) After entering the data in the last field of the current record, press Enter key. When 

you do so, a blank place is created ahead to enter the next record. 

(e) To move to the next or previous record, make use of Down and Up arrow keys. 

(f) While entering the data in any field, if data mismatch occurs, MS-Access gives 

an error message and the data entry stops. In such a situation, either correct the 

mistake and enter the correct data or click the mouse on View button, select 

Data Design View and correct the field specifications. 

EXITING FROM THE TABLE 

After entering all the records, make an exit from the table by performing following steps: 

1. Select "File" option from the bar menu. When you do so, File submenu, as shown in 

figure 10.5, will appear on the screen. 

2. Select "Close" option from File submenu. When you do so, MS-Access will close the table. 

OPENING AN EXISTING TABLE 

To open an existing table, first invoke MS-Access and get the dialog box, shown in figure 

10.1, on the screen. After this, perform following steps: 

1. Select "Open an existing file" option. When you do so, names of all the databases 

created, up till now, will appear in the dialog box. 

2. Select the name of the database that you wish to open. Say, you open "mydb" 

database, which was created in the example mentioned above. 

3. Click the mouse on "OK" button. When you do so, a dialog box, as shown in figure 

10.3, will appear on the screen. If somehow, the options shown, within the dialog 

box are different, click the mouse on "Table" option. When you do so, the names of 

all the tables, created within, current database (mydb in this example) will get 

listed, within the dialog box. 

 
Figure 10.8 
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4. Select the name of the table, which you wish to open and click the mouse on 

"Open" button, present in the toolbar of the dialog box. 

When you do so, selected table, will get displayed in Datasheet view mode. 

If you wish to add more data in the table, enter the data in Datasheet view. 

If you wish to make changes in the table structure, click the mouse on View button. When 

you do so, table structure will get displayed in Data Design View. Now make the 

modifications as mentioned below. 

INSERTING A FIELD IN BETWEEN TWO FIELDS 

To insert a field in between the two fields, place the insertion pointer on the field, above which 

the new field is to be inserted, in Design View. After this perform any one of the following step: 

1. Open that table which is to be modified in design view mode. 

2. Now click the mouse on that field above which the new field is to be inserted. 

3. Either click the mouse on "Insert Rows" button present in "Table Design" toolbar, 

or select "Rows" option from Insert submenu.  

When you do so, a blank field will get created. Now type the details in the same way as you 

had typed at the time of creating the existing fields. 

DELETING A FIELD FROM TABLE 

To delete a field from the table, place the insertion pointer on the field, which is to be 

deleted and perform any one of the following steps: 

1. Select "Delete" option from Edit submenu. 

or 

2.  Click the mouse on "Delete Rows" button, present in "Table Design" toolbar. 

When you do so, a confirmation box, for the confirmation of deletion of the field appears 

on the screen. To delete the field, click the mouse on "Yes" button else click it on "No" 

button. 

CHANGING THE SEQUENCE OF THE FIELD 

To change the current place of a field, drag the field and drop it at the new location. 

Note that after changing the sequence of the field in the table, the data in the data table also 

changes its sequence. 

RENAMING THE FIELD 

To rename any field, simply edit its name and then save the table. 

EDITING THE RECORDS 
Note that above mentioned procedures were for editing the table. Now the question is how 

do you edit data? Well, for this, open the database and the table, related to which the data is 
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to be edited and then click the mouse on "View" button present in the toolbar. When you do so, 

data in the table, as shown in figure 10.8, will appear on the screen, in Datasheet view. 

To perform different types of operations perform procedures mentioned below. 

ACCESSING THE DESIRED RECORD 

Refer figure 10.9 and note that for navigating the records, a navigation toolbar remains 

present at the bottom of Datasheet view window. 

 

 

 

 

 
Figure 10.9  

Using this toolbar, any record of the database can be accessed and made current. 

To access any record of the table, enter the record number in the edit box and press Enter 

key. For example, if you wish to access, 50
th
 record, enter 50 in the edit box and press 

Enter key. When you do so, 50
th
 record will appear in Datasheet view within the window. 

Refer figure 10.9. Role and function of other components (buttons) of record navigation 

toolbar are illustrated and labeled there. Click the mouse on these buttons and access other 

records of the table. 

Alternate Methods Of Accessing Records 

MS-Access offers many ways of accessing the record. One way of 

accessing was described above. Other methods are described below. 

1. Click the mouse on "Edit" option, present in bar menu. When 

you do so, Edit submenu will appear on the screen. Select "Go 

To" option from Edit submenu. When you do so, a submenu, as shown in figure 

10.10 will appear on the screen. 

2. Perform following steps to find a record, with the given field value: 

(a) Select the column (field name), on the basis of which, the record is to be 

accessed. For this, click the mouse on field name. For example, if you wish to 

find the first occurrence of the record containing Mumbai in city field, click the 

mouse on "City" field.  

(b) Now either select "Find" option from Edit submenu or press CTRL and F keys 

together. 

 When you do so, a dialog box, as shown in figure 10.11 will appear on the 

screen. 

Figure 10.10 
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(c) Enter the data on the basis of which the record is to be accessed, in "Find What" 

text box. For example, for finding the 

first record with city Mumbai, enter 

"Mumbai" in this text box. 

(d) If you wish to search the occurrence 

of the given data, throughout the table 

(not only in the selected field), select 

the name of the table from "Look In" 

drop down list box. 

(e) At last, click the mouse on "Find 

Next" button. 

When you do so, the first record with the data will get selected and it will appear on the screen. 

To search the next occurrence, click the mouse on "Find Next" button again. 

You can continue clicking on "Find Next" button till the time all the records get selected 

one by one. 

MODIFYING THE DATA 

 Perform following steps to modify the data: 

1. Access the record, in which contents have to be modified, using navigation toolbar. 

2. Using arrow keys, access that field, in which modifications are to be done. 

3. Using Del and Backspace keys modify the data. 

DELETING A RECORD 

To delete a record, from the table, select the record, which is to be deleted and then 

perform any one of the following actions: 

1. Select "Delete" option from Edit submenu. 

or 

2. Click the mouse on "Delete Record" button, present in "Table Datasheet" toolbar. 

When you do so, a confirmation dialog box for the confirmation of deletion of the records, 

will appear on the screen. If you wish to delete the record, click the mouse on "Yes" button 

else click it on "No" button. 

APPENDING RECORDS 

To add more records at the end of the table, click the mouse on "New Record" button, 

present in "Table Datasheet" toolbar. When you do so, Insertion pointer gets placed at the 

end of the table (in first field of the blank record). Now enter the data. 

 

Figure 10.11 
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QUERYING THE DATABASE 

You are now familiar with the process of creating the database, entering data into it and 

then navigating the database. Now the question is how do you retrieve records of your 

choice from the database? Well, this is done through a process, called querying the 

database. 

While querying the database, you need to specify your choices like, selection criterion for 

retrieving the records, the fields that would appear in the output etc. Once these choices are 

applied on the database, MS-Access provides the required output. 

The process of querying the database is explained below. 

CREATING QUERIES  

Perform following steps to create a query in Design view: 

1. Open the database, which contains the table, from which the records are to be 

retrieved. For example, if you wish to retrieve the records from "students" table 

open "mydb" database. When you do so, MS-Access window with a dialog box, as 

shown in figure 10.3, will appear on the screen. 

2. Now click the mouse on "Query" option, present in 

this dialog box. When you do so, following two 

options, will appear, within the dialog box: 

� Create Query in Design View 

� Create Query by using Wizard 

3. Select "Create Query in Design View" option, and 

click the mouse on "Open" button, present in 

dialog box toolbar. When you do so, a dialog box, 

as shown in figure 10.12, will appear on the screen. 

4. Select the name of the table from which the data is to be retrieved. First click the 

mouse on "Add" button and then on "Close" button present in "Show Table" dialog 

box. When you do so, a query window, as shown in figure 10.13, will appear on the 

screen. 

 

 
          Figure 10.13  

 
Figure 10.12 
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Using this query window, you can design queries, execute them and retrieve the data, as per 

your requirement. 

Few examples of this are given below. 

Retrieving All The Records And All The Fields From Database 

To retrieve all the records and all the 

fields of the database, drag the character, 

"*" from field list and drop it in the first 

column of field row. Note that here * carries 

special meaning and refers to all the fields of 

the table.  

To run this query, click the mouse on 

"Run" button, present in "Query Design" 

toolbar. When you do so, it will generate 

the output, as shown in figure 10.14. 

Refer this output and note that all the 

fields and all the records appear in the 

output. 

Retrieving Selected Fields Of All The Records 

Say you wish that only roll, name and marks field should appear 

in the output. For this, perform following steps: 

1. Drag the name "roll" from field list box and drop it in the 

first column of Field row. 

2. Click the mouse on second column of Field row. When 

you do so, a drop down list will appear in that column. 

Select the name "name" from that list. 

3. Drag the name "marks" from field list box and drop it in 

third column of Field row. 

To run this query, click the mouse on "Run" button present in 

"Query Design" toolbar. When you do so, it will generate the output, as shown in figure 

10.15. 

Hiding A Field In The Output 

After designing the query, if you wish to hide a field in the output, uncheck the 

corresponding check box, present in "Show" row. 

For example, if you wish to hide name field in above mentioned query, 

uncheck the corresponding check box that is present in "Show" row. 

When you run this query, output, as shown in figure 10.16 will appear on 

the screen. 

  
Figure 10.15 

 
Figure 10.14 

 
Figure 10.16 
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Obtaining Sorted Output From The Query 
Say you wish that roll, name and age fields should appear in the output and the output 

should be sorted in descending order of age field. For this, perform following steps: 

1. Include the three fields, roll, name and age in the output by either dragging them 

from field list and dropping them in three consecutive columns of Field row or by 

clicking the mouse one by one in first three columns of field row and selecting the 

names of the fields from the drop down lists that appear thereafter. 

2.  To sort the output on age fields, click the mouse in 

corresponding column of sort row. When you do so, a drop 

down list will appear in that column. 

3. Select "Descending" option from that list. 

To run the query, click the mouse on "Run" button present in "Query 

Design" toolbar. When you do so, output, as shown in figure 10.17, 

will appear on the screen. 

Applying A Selection Criteria In Query 

If the need be, selection criteria could be introduced in the query so that not all the records 

of the database appear in the output but only those records are retrieved, which satisfy the 

selection criteria. 

For example, say you wish to retrieve only those records in which marks > 795. Perform 

following steps for this: 

1. Include all the fields of the table in the output by dragging them from field list and 

dropping them in consecutive columns of Field row. 

2. Enter >795 in marks column of criteria 

row. 

To run the query, click the mouse on "Run" 

button, present in "Query Design" toolbar. 

When you do so, output, as shown in figure 

10.18, will appear on the screen. 

Applying Multiple Selection Criteria Using OR Operator 

Two or more conditions can also be introduced within the query to define the selection 

criteria precisely. For example, if you wish to select the records of those students who are 

either female or have secured more than 835 marks, perform following steps: 

1. Include the names of all those fields, which are required in the output, using any of 

the methods, described earlier. Say you include roll number, name, sex and marks 

fields. 

2. To introduce female condition enter ="F" in sex column of criteria row. 

3. To introduce marks condition, enter >835 in marks column of OR row. 

 
Figure 10.17 

 
Figure 10.18 
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To run the query, click the mouse on "Run" button present in "Query Design" toolbar. 

When you do so, output, as shown in figure 10.19, will appear 

on the screen. 

Applying Multiple Selection Criterion 

More than one condition can be applied to retrieve the records 

from the table. For example, you may wish to retrieve the 

records of all those students who live in Mumbai and have 

secured more than 750 marks, perform following steps: 

1. Include the names of all those fields, which are required in the output, using any of 

the methods, mentioned above. Say you 

include, roll, name, city and marks fields. 

2. To introduce, city condition, enter="Mumbai" 

in city column of criteria row. 

3. To introduce marks condition, enter >750 

in marks column of criteria row. 

To run the query, click the mouse on "Run" button, 

present in "Query Design" toolbar. When you do so, output, as shown in figure 9.20, will 

appear on the screen. 

SAVING THE QUERY 

Perform following steps to save the query in 

the database:  

1. Either click the mouse on "Save" 

button, present in Standard toolbar 

or select "Save As" option from File 

submenu. When you do so, a dialog box, as shown in figure 10.21, will appear on 

the screen. 

2. Enter the desired name in "Query Name" text box, present in this dialog box. 

3. Click the mouse on "OK" button. For example, say you save the last query with the 

name myq. 

When you do so, the query will get saved in the database for further use. 

OPENING AN EXISTING QUERY 

To open the query, open the database, in which the query exists (if not yet opened) and get 

the dialog box, shown in figure 10.3 on the screen. Click the mouse on "Query" button. 

When you do so, the names of all the queries, present within the opened database will get 

listed in that dialog box. 

Select the name of the query, which you wish to open and click the mouse on "Open" 

button, present in the toolbar. When you do so, the selected query will get opened and 

 
Figure 10.19 

 
Figure 10.20 

 
Figure 10.21 
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executed to show the result. For example, if you open the myq query, which was saved in 

the last section, it will display the results, as shown if figure 10.20. 

MODIFYING THE QUERY 

To modify a query, which is already opened, simply click the mouse on "View" button, present in 

MS-Access window. When you do so, the query, will get displayed in Query Design window. 

Now by performing following activities, query can be modified as per requirement: 

1. To add a new field, in the query, drag the new name from field list and drop it in 

the blank column of Field row. If the need be, visibility factor, sort order, selection 

criteria etc. can also be introduced in the query by following the methods, described 

above. 

2. To change the current place of a field in the query, select the field by clicking the 

mouse in column selector. After this, drag the field and drop it at desired location. 

3. To delete a field, select the field by clicking the mouse in column selector. After 

this, either press Del key or select "Delete" option from Edit submenu. 

4. Note that in the result obtained from the query (query executed), field names appear 

as headings, at the top of each column. For example, if you have designed query to 

extract roll, name and marks data from the table then "roll" "name" and "marks" 

will appear as headings of the three columns in the output. If you wish to change 

these headings, you can do so by prefixing the field names by new headings and a 

colon sign (:). For example, if you wish that "Roll Number" should appear as 

heading, instead of roll then you should write "Roll Number:roll" in the query 

column of Field row. Similarly if you wish that instead of name, Student Name 

should appear as heading, in the output, you should write "Student Name: name" in 

the query. 

FORM 

Form is a utility, using which you design screens for data entry and data retrieval. Forms 

consist of fields, field headings and GUI objects like graphics, radio buttons, check boxes, 

list boxes etc. If the need be, you can also include generated fields (which are calculated on 

the basis of the data entered in previous fields) in the form. How do you create these forms, 

how do you utilize them for data entry and data retrieval operations, is explained below. 

CREATING A FORM USING FORM DESIGN VIEW WINDOW 

Creating forms in Design View is the best method for creating forms because it gives you 

full control over the appearance of the form. Perform following steps to create the form in 

design view:  

1. Open that database, which contains the table, for which, you wish to create the 

form. Say you open "Mydb" database, which was created earlier. When you do so, 

MS-Access will display database view window as shown in figure 10.3. 

2. Select "Form" tab from that window and click the mouse on "New" icon present in 
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the toolbar. When you do so, a dialog box, 

as shown in figure 10.22 will appear on 

the screen. 

3. First select "Design View" option present 

this dialog box and then select the name of 

the table or query for which you wish to 

design the form, from the combo box 

present in this dialog box. After this, click 

the mouse on "OK" button. For example, 

say you select "Student" table and click 

the mouse on "OK" button. When you do 

so, MS-Access will display Form Design 

View window, as shown in figure 10.23. 

 

 

 

 

  

Figure 10.23 

 Refer Form Design View window, shown in figure 10.23 and notice that this 

window contains many elements for designing the form. An introduction to these 

elements is given below. 

(a) Form Detail Section- Form Detail Section, is the base of the form, on which all 

the fields, controls etc. are placed. 

(b) Form Toolbox- Form toolbox consists of various controls. To design the form, 

you have to select the controls from here and then drag and drop them in Form 

Detail Section. An elaborated view of form toolbox is shown in figure 10.24.   
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Figure 10.22 
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Figure 10.24 

(c) Field List: Field list consists of field names that can be included in the form.  

(d) Property list box- Property list box is the list box, which displays the properties 

and the current values for the controls, which you have currently selected in 

form detail section. By changing the value of any property, you can change 

various parameters associated with the control. 

4. Now you have to place the fields in form detail section. To add the fields of the 

selected table, in form detail section, drag the name of the desired field from the 

field list box and drop it at the desired place in form detail section. Note that if 

more fields are to be added in the form then this process has to be repeated for each 

field that you wish to add in the form. 

Say you select three fields i.e. roll, 

name and marks. When you do so, 

form detail section will look like as 

shown in figure 10.25.  

5. Refer detail section and note that the 

field headings are same as the names 

of the fields, which were assigned to 

them, while creating the table. If you 

wish to change the field headings, 

either click the mouse on field heading 

and enter the new heading or change 

the Caption property value to new 
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Figure 10.25 
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heading that you wish to assign to the field. For example, say you click the mouse 

on roll field heading and change it to "Roll Number". Using the same process you 

can change the headings of all the described fields. 

6. To add controls like check boxes, option buttons, list boxes etc. in the form, select 

the desired control from the toolbox and drop it at the desired place in the form 

detail section. For example, say you wish to include a combo box, on the form for 

data entry in city field. For this, click the mouse on combo box control present in 

toolbox and then drag it to the desired place in form detail section. After this, set 

the following properties for the combo box: 

(a) Select Data tab from properties list box. 

(b) Now click the mouse on Control Source property and select the field in which 

you wish to store the value, by taking the input from the control. For example, 

say you select City field. 

(c) Click the mouse on "Row source type" property text box and select Value List 

option from the drop down list. 

(d) Now enter the values in "Row Source" text box, which need to be displayed in 

the combo box. Say you wish to display Delhi, Hydrabad, Mumbai, Lucknow 

and Chennai values in the combo box. For this, click the mouse on Row Source 

text box and enter “Delhi”; “Hydrabad”; "Mumbai";  “Lucknow”; 

“Chennai” into it. 

(e) If you wish you can set default value for the combo box. To enter the default value, 

click the mouse on Default Value  text box and enter the value in it. For example, say 

you enter the value "Delhi" in Default Value text box.  

7. If you wish, you can also add heading in the 

form. To do so, click the mouse on Label 

control present in the form toolbox. This 

will change the mouse pointer to cross hair 

band cursor. Now drag the mouse in the 

form detail section. This will create a text 

box. After this, type the desired text in this 

text box. For example, say you type 

"Student Data Entry Form". 

8. To view the form, click the mouse on View 

icon and select "Form View" option from 

the drop down list. When you do so, a form 

as shown in figure 10.26 will appear on the 

screen. 

Note that the form contains only those fields, which you had placed in form detail section 

and has a series of buttons at the bottom. Using these buttons, you can either navigate the 

database or enter new records in it. Which button performs what function is shown in the 

figure 10.27. 

 

Figure 10.26 
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Figure 10.27 

Moving Between Records In Form View 

As mentioned above, form buttons can be used to move around in the database. Refer 

figure 10.27 and note that Navigation buttons are the six controls, which are used for 

moving between the records. Two leftmost buttons helps you to move to the first and 

previous records respectively. The three rightmost buttons help you to move to the next 

record, to the last record or add a new record in the table. The "Record Number" text box 

displays, which records is the current record. 

EXITING FROM MS-ACCESS 

To exit from MS-Access, follow any one of the following methods: 

1. Select "Exit" option from File submenu. 

    or 

2. Click the mouse on "Close" button, present in MS-Access windows title bar. 

 

 

 

 EXERCISES                      CHAPTER 10 

 

Short Type Questions 

A.  Select best possible options for following questions: 

1. What is MS-Access? 

(a)  Word Processor  (b)  Electronic spreadsheet   

(c)  Presentation software (d)  Database Management System 

2. In MS-Access, data is stored in the form of tables. What do you call the row of the 
table? 

(a)  Record    (b)  Fields (c)  Character (d)  Database file 

First Record

Previous Record

Total Record 

New Record 

Last Record 

Next Record 
Record number window
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3. What do you call that attribute, which uniquely identifies a record of MS-Access table? 

(a)  Record (b)  Field (c)  Primary key (d)  Unique field 

4. Which of the following field type will be suitable for maintaining history of a patient 
in MS-Access? 

(a)  Text (b)  Memo (c)  YES/NO   (d)  Lookup Wizard 

5. What is the maximum length of the text field? 

(a)  10  (b)  20  (c)  1024  (d)  255 

B.  Fill in the blanks.  

6. To store date of birth of the students, a field of .................. type should be defined 
in table structure. 

7. Record serial number can be introduced in the table, using .............. type of field. 

8. Mostly MS-Access tables are created in ................. view. 

9. In MS-Access, data entry is mostly done in ................. view. 

10. ............. is the medium, using which selected data is retrieved from the table.  

C.  State, true or false for following statements: 

11. Multiple fields put together constitute a record. 

12. While appending the records in the table, new records are added at the beginning 
of the table. 

13. Dragging and dropping the field at another place can change its current place in the 
table. 

14. When you delete a field from the table, its data gets automatically deleted from the 
database. 

15. The use of * while creating a query, refers all the fields of all the records. 

16. The query, containing a condition, "age>50 or pay <20000" will give you all those  
record in which age>50 and pay >20000. 

D. Answer the following questions in short: 

17. What do you call that field which contains unique values in it? 

18. Name that field type, which you will use in MS-Access for storing the price of the item. 

19. Name any two operations that can be done using Form. 

20. Write a condition for a query, which would make use of OR operator. 

21. Name any five contents that can be included in a form? 
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Detailed Answer Type Questions 

E.  Answer the following questions in details: 

22. What is Database Management system? What is MS-Access?  

23. What types of activities are performed, using MS-Access? Name any two 
applications, for which MS-Access suits well. 

24. Differentiate between text and Memo fields. 

25. Differentiate between number and currency fields. 

26. Explain the role of forms in MS-Access, using a suitable example. 

27. Write the procedure for creating the table in MS-Access. 

28. Explain the concept of record and state its relationship with field. 

29. Explain the concept of Primary key, using a suitable example. 

30. What is query? Explain its role in MS-Access. 

31. Write the procedure for executing a saved query. 

 

PRACTICAL ASSIGNMENTS 

Assignments-1 : Creating A Database 

1. Invoke MS-ACCESS and create a blank database with name Mydb. 

Assignments-2 : Creating A Table  

2. Create a table, with name Student. Its structure is described on page 184 of this book. 

Assignments-3 : Entering Data In Table 

3. To get familiar with data entry process, perform following operations: 

(i) Refer data, which is given on page 181 of this book. 

(ii) Enter first five records in Student table.  

(iii) Close the database. 

(iv) Exit from MS-Access. 

(v) Reload MS-Access. 

(vi) Open Mydb database again and make use of Student table. 

(vii) Enter remaining records of the given data. 

Assignments-4 : Modifying The Database 

4. To get familiar with database modification process, perform following steps: 

(i) Open Mydb database and work with Student table. 

(ii) Add a new field Fname at the end of the structure. Fname field should be 
character field of 50 characters. 
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(iii) Move Fname field next to Name field. 

(iv) Now enter data in Fname field. 

(v) Go back to table structure and delete Fname field and observe its effect on 
corresponding data. 

Assignments-5: Navigating The Database 

5. Open Mydb database and work with Student table. 

6. Make use of navigation toolbar and access following records:  

(i) Last record  

(ii) First record 

(iii) Third record 

(iv) Fifth record 

(v) Tenth record 

7. Add a new record through navigation toolbar. 

8. View first record and then newly created record. 

9. Delete newly created record. 

Assignments-6: Querying The Database 

10. To get familiar with the process of retrieving the record of our choice, perform following 
operations: 

(i) Open Mydb database and work with Student table. 

(ii) Select all the records of all the students. 

(iii) Select all the records  of male students. 

(iv) Select all the record of female students. 

(v) Select roll number and name of those students who are more than 18 years old. 

(vi) Select roll number, name and marks of all those female students who secured 
more than 750 marks. 

(vii) Select roll number and name of those students who are either male or less than 
20 years in age. 

(viii) Select names of all those students who are from Delhi. 

(ix) Select records of all those students who belong to Lucknow and their name is Jyoti. 

(x) Select the record of that student who secured highest marks. 

Assignments-7: Designing A Form 

11. To get familiar with form designing process, perform following operations: 

(i) Open Mydb database and select Student table. 

(ii) Design a form, as shown in figure 10.26. 

(iii) Display the form in Form View mode. 

(iv) Access records through this form. 

(v) Add few more records in the database through this form. 

(vi) Delete all those records that you added in this session. 

**** 



UNIT - VI 

 

 

 

 

Reports  
INTRODUCTION 
A formatted and organized presentation of data is called report. Apart from data, report also 

contains many headings that make the report more meaningful. MS-Access has an inbuilt 

Report Writer that takes the data from the table or query and presents it in the form of 

report. How reports are generated in MS-Access is described in this chapter. 

SAMPLE REPORT 
To get familiar with MS-Access report and its components, consider a report shown in 

figure 11.1. This report is created in MS-Access.  

 

Figure 11.1 
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Refer report format shown in figure 10.1 and note that the report consists of various 

components. Details of these components are as follows: 

Report Header: Report heading is printed only once, at the top of the first page of the 

report. Generally the title of the report is printed as report header. 

Report Footer: Report Footer is printed only once, at the bottom of the last page of the 

report. Report summary or end message etc. are generally printed as report footer. 

Page Header: Page header is that message, which is printed at the beginning of each page. 

If it is the first page then it is printed, below the report heading. 

Group Header: Group is basically a cluster of records, which are clubbed together on the 

basis of some common field. For example, in above illustrated report, the records are 

clubbed together on the basis of sex field. Thus the records of the same sex appear together 

in the report and the report is said to be grouped on sex field. Group header is basically a 

title or remark, which is printed at the beginning of each group. Refer above illustrated 

figure and note that " Gender: <sex >" is the group header in the report. 

Group Footer: Group footer generally comprises of few titles, remarks, totals, statistics 

etc., which are printed at the end of each group. 

Calculated Fields: Calculated fields are the fields that are derived by performing 

calculations on existing fields. For example, in above illustrated report format, Percentage 

is a calculated field, which is derived by multiplying marks by 100 and dividing it by 1000. 

Generated Field: Generated fields are the fields that are self generated at the time of 

printing the report. For example, in above illustrated report, Sr. No. is a generated field. 

Detail :  All those messages and fields that are printed for each record are termed as detail.  

CREATING A REPORT IN DESIGN VIEW 

Although there are various methods of generating reports in MS-Access but creating a 

report in Design View is the most commonly used method because it gives you full control 

over the appearance of the report.  

Perform following steps to create the report 

in Design View:  

1. Open that database, which contains 

the table or query, for which you 

wish to create the report. Say, you 

open "Mydb" database, which was 

created in previous chapter. When 

you do so, MS-Access will display 

database view window as shown in 

figure 10.3. 

2. Now select Report tab and click the 

mouse on "New" icon present in the  

Figure 11.2 
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database view toolbar. When you do so, MS-Access will display New Report dialog 

box, as shown  in figure 11.2. 

3. Select "Design View" option from this dialog box. After this, select the name of the 

table or query, for which you wish to design the report, from the combo box present 

in the dialog box. For example, say you select "Student" table. After this, click the 

mouse on "OK" button. When you do so, MS-Access will display Report Design 

View window as shown in figure 11.3. 

 

 

  

Figure 11.3 

Now the report layout can be designed, using this window. The procedure for adding 

required components in the report layout, is given below.  

Adding Report Header  

Refer figure 11.1 and note that report header consists of heading, 

"Brilliant School of Technology ". Perform following steps to add 

this header in the report:  

1. Right click the mouse on the detail section of the report 

layout window. When you do so, a shortcut menu, as shown 

in figure 11.4 will appear on monitor screen.  

2. Select "Report Header/Footer" option from this shortcut 

menu. When you do so, Report Header and Report Footer 

bands, as shown in figure 11.5, will get added in the report 

layout.   

Tool box 

Page 

Footer

Table 

Report Detail section 
View 

Page 

Header

Field List 

 

Figure 11.4 
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          Figure 11.5 

3. To type the report heading in Report Header band, click the mouse on Label 

control, present in Tool Box. This will change the mouse pointer to cross hair band 

cursor. Now drag the mouse in the report header band. When you do so, a text box 

will get created. Click the mouse in text box and type the heading. Say you type 

"Brilliant School Of Technology". 

Adding Page Header 

Refer figure 11.3 and note that when you open the report, Page Header and Page Footer 

bands already exist in report layout format.  Perform following steps to type the Page 

Header/Footer text:  

1. Click the mouse on label control present in Tool Box. This will change the mouse 

pointer to cross hair band cursor. Now drag the mouse in the Page Header band. 

This will create a text box there.  

2. Now click the mouse in the text box and type the Page heading. Say you type "Sr. 

No." as first label.  

3. Repeat this process for every heading that you wish to include in the page header 

band. Say you add following more headings: Roll No., Name, Marks, and 

Percentage in the page header band. 

Adding Group Header/Footer 

Refer figure 11.1 and note that the report has to be grouped on sex. Perform following steps 

to add group header and group footer in the report:  

1. Right click the mouse on the detail section of the report. When you do so, a shortcut 

menu, as shown in the figure 11.4, will appear on monitor screen.  
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2. Select "Sorting and Grouping" option from this shortcut menu. When you do so, a 

dialog box, as shown in the 

figure11.6 will appear on the 

screen.   

3. The dialog box, shown in 

figure11.6 contains two columns 

i.e. Field/Expression and Sort 

Order. It also contains Group 

Properties pane. Click the mouse 

on Field/Expression column. 

When you do so, it will display a 

combo box. Click the mouse on 

down arrow button. When you do 

so, it will display the list of the field names. Select the field, on which you wish to 

group the report. Say you select sex field. When you do so, above illustrated dialog 

box will take the shape as shown in figure 11.7.  

 Refer dialog box, shown in 

figure 11.7 and note that 

when you select the name 

of the field, Ascending 

automatically appear in the 

Sort Order column and 

various properties appear 

in the Group Properties 

pane of the dialog box. 

• If you wish to 

change the sort 

order, click the 

mouse on Sort Order column. When you do so, it will display a combo box. 

Click the mouse on down arrow button. When you so, it will display two 

options i.e. Ascending and Descending. Select any one of the two options. Say 

you select "Descending" option. 

• After this, click the mouse on Group Header text box present in Group 

Properties pane. When you do so, a combo box will appear there. Click the 

mouse on down arrow button. When you do so, it will display two options i.e. 

Yes and No. Select "Yes" option to add Group Header band in the report 

layout. 

• To include Group footer band click the mouse on Group Footer text box 

present in Group Properties pane. When you do so, a combo box will appear 

there. Click the mouse on down arrow button. When you do so, it will display 

two options i.e. Yes and No. Select "Yes" option to add Group Footer band in 

the report.  

 

Figure 11.6 

 

Figure 11.7 
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4. After this, close the dialog box by clicking the mouse on "Close" button.  

 When you perform above-mentioned steps, Group Header and Group Footer bands 

get included in the report layout. 

5. Now you need to describe the text and the field names, which will appear as Group 

Header. Refer figure 11.1 and note that "  <sex> " is the group header that has to be 

included in the report. To include it as group header, select the name of the field, 

drag it and drop it in the Group Header band. Note that when you drop the name of 

the field, a label for that field also appears along with the field name. Type 

"Gender" in label box. 

Adding Fields In Detail Section 

Now you have to describe all those fields, which you would like to print for all the records. 

Obviously these fields are described in detail band of report layout. Perform following 

steps to include fields in detail section: 

1. Drag the name of the desired field (say roll) from the Table window and drop it in 

the detail section.  When you do so, field labels along with fields will get included 

in the detail band.  

2. Remove the field labels because field names have already been included in page 

heading. To delete the field label from detail section, select the label and press Del key.  

3. Repeat this process for all other fields that have to be included in the detail band.  For our 

report, we will have to repeat above mentioned steps for name and marks fields.  

Adding Generated Field In Detail Section 

Refer report shown in figure 11.1 and note that before every record, serial number is also printed. 

Since serial number is not a field of the table hence a special provision will have to be made in 

the layout. Perform following steps to make provision for serial number in the report: 

1. Click the mouse on Text box control present in the toolbox of the report and make a 

text box by dragging the mouse at appropriate place. This will create a text box. 

2. Now right click the mouse on it. When you do so, 

a shortcut menu, as shown in figure 11.4, will 

appear on the screen. 

3. Select "Properties" option from that menu. When 

you do so, Property dialog box, as shown in 

figure 11.8 will appear on monitor screen. 

4. Click the mouse on "Data" tab and enter =1 in 

"Control source" combo box. 

5. Now click the mouse on "Running Sum" text box. 

When you do so, it will display a down arrow button. Click the mouse on that 

button. This will display a list of options. Select "Over All" option from that list. 

 

Figure 11.8 



 

 

Chapter 11 – Reports   209

6. After setting the properties, select the text label and press Del key. This will 

remove undesired label.  

This process will add a running serial number field in the detail section. 

Adding Calculated Fields In Detail Section 

Refer figure 11.1 and note that in the detail section, last field in the report is Percentage 

field. This is a calculated field and is generated by multiplying marks by 100 and dividing 

by 1000. Perform following steps to make provision for this field in the report: 

1. Click the mouse on Text Box control, present in the tool box. This will change the 

mouse pointer to cross hair band cursor. Now drag the mouse in detail section. This 

will create a text box. Now type the expression =[marks]* 100 / 1000 in this text 

box.  

2. Place the text box at appropriate place in the detail section by dragging it to the 

desired place. Say you place the text box below the Percentage label, present in 

page header band. 

Defining Group Footer Contents           

Refer figure 11.1 and note that group footer consists of the title, "Total Students" and the 

count of the students. Perform following steps to include these items in group footer:  

1. Select Label control from the toolbox. When you do so, this will change the mouse 

pointer to cross hair band cursor. Now drag the mouse in Group Footer band. This 

will create a text box. Now type the heading "Total Students" in this text box.  

2. Click the mouse on Text Box control present in the toolbox. This will change the 

mouse pointer to cross hair band cursor. Now drag the mouse in the group footer 

band. This will create a text box in group footer band. Now type the expression 

=Count(*) in this text box,  to count total number of students in this group.  

3. Delete all undesired labels if there are any.  

Defining Page Footer  

Refer figure 11.1 and note that page footer consists of page number. Perform following 

steps to make provision for printing page numbers (which is not a field of the table) at the 

end of each page:  

1. Select Text Box control from the report toolbox and make a text box by dragging 

the mouse at appropriate place in the page footer.  

2. Enter the expression =[Page] in the text box. 

Defining Report Footer Contents 

Refer figure 11.1 and note that report footer consists of two types of objects i.e. Text 

("Statistics", "Average Marks", "Maximum Marks", "Minimum Marks") and calculation on 

marks field (i.e. average marks, maximum marks, minimum marks) 
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To include text ("Statistics", "Average Marks", "Maximum Marks", "Minimum Marks") in 

report footer make labels in report footer band and type the desired text. This will make 

provision for all the labels. To make provision for including corresponding values, perform 

following steps: 

1. Select Text box control present in toolbox. Now drag the mouse at the location, 

where you want to place the average marks and make text box. Delete unwanted 

label also. 

2. Now click the mouse in the text box and enter =Avg([marks]) in  the text box. 

3. To include maximum and minimum marks, perform same steps which are 

mentioned above and enter =Max([marks]) to calculate maximum marks and 

=Min([marks]) to calculate minimum  marks.  

After performing all the steps mentioned above, your report format will get ready. Now you 

need to run the report and view the output.  

Viewing The Report 

Perform following steps to view the report:  

1. Click the mouse on "View" icon present in Design View toolbar. When you do so, a 

list of option will appear on the screen. 

2. Select "Layout Preview" option from the list.  

When you do so, report, as shown in figure 11.1 will appear on the screen.  

SAVING THE REPORT 

To save the report layout on the disk, perform all those steps, which you had performed for 

saving other objects. Note that the process of saving other objects like table, query etc. has 

already been explained before. 

PRINTING THE REPORT 

After defining the report layout and saving 

it, you can print the report on printer. 

Perform following steps to print the report: 

1. Click the mouse on "File" option 

present in bar menu. When you do so, 

File submenu will appear on the screen.  

2. Select "Print" option from File 

submenu. When you do so, a dialog 

box, as shown in figure 11.9. 

3. Set the properties as per your 

requirements and click the mouse on 

"Ok" button. 

When you do so, currently opened report will get printed on the printer. 

 

Figure 11.9 
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 EXERCISES                      CHAPTER 11 

 

Short Type Questions 

A.  Select most appropriate answer for following questions: 

1. What is report? 

 (a) Formatted information  (b) Printed matter 

 (c) Output of a query   (d) Data of a table 

2. Which of the following is not a part of report? 

 (a) Report header   (b) Group footer 

 (c) Page footer    (d) Header summary 

3. In which of the following, page number should not be included?  

 (a) Page header   (b) Page footer 

 (c) Detail    (d) Name of the above 

4. Which of the following is related to printing of each record? 

 (a) Group header   (b) Page header 

 (c) Report header   (d) Detail 

5. Pay and Tax are two field of the database. A field net=Pay-Tax has been included 
in the report. Which type of field is this? 

 (a) Calculated    (b) Generated 

 (c) Automatic    (d) Manipulated 

B. Fill in the blanks: 

6. The title, which is printed at the top of the first page of the report, is 
called.................................................................................................................... 

7. That band of report layout, where you describe all those items, which are to be 
printed for each record is called ....................................................................... 

8. To count the number of records, expression........................................can be 
included in the report. 

9. Report summary is printed at .......................of the page. 

10. ..........................option of the bar menu need to be selected for printing the report 
on printer. 

C. State, true or false for the following statements: 

11. While generating the report, you can do calculations on the given field values and 
include the result in the field. 

12. You can display page number at the end of every page by specifying =Page 
expression. 
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13. Heading mentioned in report header is printed on every page of the report. 

14. When you include a group header in a report, report gets printed in sorted order. 

15. That field of report, which is generated after doing calculations on some field of the 
table, is called generated field. 

D. Describe the position of following objects in a report: 

16. (a)  Report Header       (b) Report Footer    (c) Page Header (d) Page Footer                
(e)  Group Header           (f) Group Footer. 

 

Detailed Answer Type Questions 

E. Answer the Following Questions in Detail: 

17. What expression do you write to generate serial number in the report, which is not a 
field in selected table? 

18. What expression do you give to print maximum salary? 

19. Say there are two fields viz. "Qty" and "Rate" stored in the table, which is currently 
opened. How will you include third field, "Amount" in detail band, which is nothing 
but Qty * Rate? 

20. How will you modify "DEPT" field to "Department of Employee" so that the heading 
becomes more meaningful? 

(a)  Differentiate between the following: 

(i) Report Header and Page Header 

(ii) Report Footer and Page Footer  

 

 

 

 

PRACTICAL ASSIGNMENTS 

 

Assignment-1 Generating A Report: 

1. To get familiar with MS-Access report printing procedure, perform following operations: 

(i) Open the mydb database, which was created in previous lab sessions? 

(ii) Make use of student table. 

(iii) Generate a report, which is shown at the beginning of this chapter. 

(iv) View the report in print preview mode. 

(v) Print the report on printer.  
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Assignment-2 Generating A Report For The Output Of A Query. 

2. Perform following operation to generate another report: 

(i) Open mydb database, which was created in previous lab sessions. 

(ii) Make use of student table. 

(iii) Generate a report for all those students only who secured more than 790 marks. 
At the end of the report, a summary should also be printed as shown below: 

 

Merit Report 

Sr. No Roll 

Number 

Name Age Marks 

1     

2     

3     

4     

5     

Summary 

Maximum Marks #### 

Minimum Marks #### 

 

**** 



UNIT - VII 

 

 

 

 

 

Internet   

INTRODUCTION 
Internet is the most useful development of computer world. It comprises of millions of 

interconnected computers that are geographically located in every nook and corner of the 

world. Computers of Internet remain connected with each other through telecommunication 

medium. Thus sharing of information and resources becomes possible among them.  

Computers of Internet hold very large volumes of information and offer wide variety of 

services. Any person willing to avail  information or services can get his / her computer 

connected to Internet and acquire them.  

Many useful applications like e-mail, chatting, Internet Telephony, Electronic Shopping, 

Internet Banking, Movie, Music and Gaming etc. are quite popular these days.  Popularity 

of Internet is increasing day by day. Number of Internet users is continuously increasing 

and the size of Internet is growing.   

The way Internet is expanding and its services are getting popular, the day is not far when 

Internet, like water, electricity, telephone etc., will become basic necessity of our life. An 

introduction to Internet and its services is given in this chapter. 

INTRODUCTION TO NETWORKING 

When two or more objects of same kind join 

together to work in co-ordination with each other, 

they form a network. For example, when many 

marketing persons unite together to sell a product, 

they form a marketing network. Network 

marketing team is shown in figure 12.1. 

Similarly, when two or more computers are 

connected together with the objective of 

communicating with each other and sharing their 

resources, they form a computer network. A simple 

computer network is illustrated in figure 12.2. 

12 CCCCHAPTERHAPTERHAPTERHAPTER    

 

Figure 12.1 
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Figure 12.2 

Refer figure 12.2 and note that in this network, four computers are connected together to 

form a computer network. 

In this network, any computer can communicate with any other computer. For example, 

computer-1 can send message to computer-4 and computer-4 can replay back. Similarly, 

computer -2 and computer-4 can exchange data among them. 

In computer network, computers share their resources among them. For example, computer-

3 can print its documents on the printer that is attached to computer-4. Similarly computer-

1, computer -3 and computer-4 can store their data on computer- 2's disk. 

TYPES OF COMPUTER NETWORKS 

Computer networks can be broadly categorized into two categories. One is called Local 

Area Network or LAN in short and other is called Wide Area Network or WAN.  

In Local Area Network, computers are connected within short distance of 1 kilometer or so. 

For example, computers placed within a room or same premises will form Local Area 

Network. 

In Wide Area Network, distantly located computers are connected together. Generally they are 

located over a distance of more than 1 kilometer. For example, when computers of different 

localities, cities, states or countries are connected together, they form Wide Area Network. 

ADVANTAGES OF COMPUTER NETWORK 

There are many advantages of computer network. Few of them are described below: 

1. Distantly located information becomes available in no time. For example, if 

computer-A at Delhi is connected with computer-B at Mumbai over WAN then 

information among them can be exchanged within few seconds. This enables 

efficient working and fast decisions. 
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2. Costly devices such as magnetic tapes, printers etc. can be shared among different 

computers of the network. For example, one printer can be connected in LAN, so 

that all the users make use of same printer. This saves operational cost. 

3. Since in a network, many computers remain available for use hence on-going work 

continues even if few computers are down. Thus in a computer network, time and 

resources are utilized efficiently. 

4. Since distantly located data remains available locally, hence useful applications can 

always be developed. One such application is railway reservation system. For 

example, data of trains leaving Delhi remains accessible from Lucknow so train 

reservations, in those trains are done from Lucknow also.  

5. Fast communication takes place among different users of the network. They can 

exchange words, messages or letters among them. Electronic mail is the best 

example of fast communication. Electronic mail neither gets delayed nor gets lost in 

transit, as usual mail does. 

WHAT IS INTERNET 

When many computer networks of the 

world were connected together, with 

the objective of communicating with 

others and sharing their resources, 

Internet was formed. In other words, 

you can say that Internet is network 

of computer networks, which spreads 

all across the globe. 

Initially the size of Internet was 

small, it was limited to few 

geographical locations only. But 

soon, people become aware of its 

utility and advantages. Within short 

span of time, numerous computers 

and networks got themselves 

connected to Internet. Its size 

increased multi fold within few years of its birth. Today Internet comprises of many million 

computers. There is hardly any country of the world and important city of the country, 

where Internet is not there. A conceptual diagram of Internet is given in figure 12.3.  

Internet is basically a large computer network, which extends all across the globe. In 

Internet, millions of computers remain connected together through well-laid 

communication system. Recall that telephone communication system is well-defined, time 

proven system. Computers of Internet are connected to each other through this system. 

Thus like a telephone, any computer of any city can establish a connection with any other 

computer of any other city and exchange data or messages with it. 
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China
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South Africa
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Figure 12.3 
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CLASSIFICATION OF INTERNET COMPUTERS  

Computers of Internet can be broadly classified into following two categories:  

1. Web Servers 

2. Web Clients 

Role and requirements of both types of computers are explained below. 

Web Servers 

Those computers of Internet, which provide information or services to other computers, are 

called web servers. For example, if a computer in an organization named Hotmail provides 

electronic mail services to Internet users then that computer will be categorized as web 

server. 

Web servers provide services/data to millions of Internet users, so they generally possess 

following characteristics: 

1. They are fast. 

2. They are equipped with large memory and large disk space. 

3. They remain connected to Internet all through the day i.e. seven days a week, 31 

days a month and 365 days a year. 

4. They make use of fast communication lines. 

Web Clients 

Those computers of Internet, which take information or services from web servers, are 

called web clients. For example, if you make use of Hotmail's web server to send electronic 

mail to your friends or relatives then your computer will be termed as web client. 

Since web clients interact with web servers on one-to-one basis and that too when 

service/information is required hence they possess following characteristics: 

1. They need not be very fast computer. 

2. They need not have large memory and disk space as servers have. 

3. They get connected to Internet, when they need information/service from it. After 

taking it, they disconnect from Internet. 

4. They generally make use of slow connection like telephone lines, to get connected 

to Internet. 

IDENTIFICATION OF COMPUTERS ON INTERNET 

Like houses of any city are identified by a unique address, similarly computers of Internet 

are identified by a unique address called IP address. IP address comprises of four numbers 

separated by dots(.). For example, 150, 075,100.085 is a valid IP address. Each number in 

IP address can range from 0 to 255. So IP address can range from 0.0.0.0 to 

255.255.255.255. Thus if IP address of a computer is known, it can be accessed over 

Internet. 
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WEB SITE  

Web site is basically, well-identified location on web server, which holds the information 

of either an individual or an organization or place etc. Each web site of Internet is 

identified by a unique name, called domain name. For example, hotmail.com, yahoo.com, 

indianrail.gov.in, sanchar.net etc. are valid web sites. 

Domain name comprises of two or more strings of characters separated by dots (.). First 

string of characters is called domain name. It identifies the name of the web site, For 

example, in indianrail.gov.in, indianrail identifies the name of the web site. Second string 

of characters identifies the nature of the web site. For example in hotmail.com, com 

indicates that it is commercial web site. Standard strings that are used at second place in 

the domain name are as follows: 

      

      String    Type of web site 

 com    Commercial organizations (profit making) 

 edu    Educational institutes 

 gov    Government organization  

 mil    Military 

 net    Network service providers 

 org    Non profit making organizations 

Third string in the domain name is always indicative of country. For example, "in" is used 

for India. "au" is used for Australia, "uk" is used for United Kingdom, "fr" is used for 

"France" etc.   

If domain name of a web site is known, it can always be accessed and its contents can be 

viewed. 

WEB PAGE 

Information or services on any web site are arranged in the form of web pages. A web page 

may contain elements like text graphics, sound, animation video and hyper links in it. 

A web site may consist of interlinked multiple web pages. When you access a web site, its 

first page gets displayed on you computer. Since web pages of a web site remain 

interlinked through hyperlinks hence you can always access other web pages, after 

accessing the first web page. 

HYPERLINK 

When a link between two objects, is maintained in such a way that when you click the 

mouse on first object, second object gets displayed then such a link is called hyperlink. 

Concept of hyperlink is illustrated in figure 12.4. 
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HYPERTEXT 

The text that remains linked to other 

objects like text, graphics, audio etc. 

through hyperlink is called hypertext. For 

example, the words "Newton" and Apple 

are hypertext. 

WEB BROWSER 

The software, using which you traverse 

over Internet and access web sites, is 

called web browser. Internet Explorer, 

Netscape, Mozila etc. are few famous web 

browsers. Most of the Internet operations 

are done, using web browser. 

WORKING WITH INTERNET EXPLORER 

Internet Explorer is a web browser. Most of the Internet operations are performed through 

Internet Explorer. Perform following steps to invoke Internet Explorer on your computer: 

1. Click the mouse on "Start" button. When you do so, Start menu will appear on the 

screen. 

2. Select "All Programs" option from that menu. When you do so, a submenu 

containing "Internet Explorer" option in it, will appear on the screen. 

3. Select "Internet Explorer" option. 

When you do so, Internet Explorer will get loaded in computer's memory and Internet 

Explorer window, as shown in figure 12.5, will appear on the screen. 

 

Figure 12.5 
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When Internet Explorer window gets displayed for the first time, Home page gets displayed 

in it. Home page is the web page, which by default get displayed, whenever Internet 

Explorer is loaded. Any web page, present on the disk can be set as home page for Internet 

Explorer. 

INTRODUCTION TO INTERNET EXPLORER WINDOW 

Refer figure 12.5 and note that Internet Explorer window comprises of many components. 

Some of the components like System Menu button, Minimize button, Maximize button, 

Close button etc. are usual window components. They need no explanation now. Other 

components are local to Internet Explorer. Their roles and functions are described below. 

Address Bar 

Address bar is used for entering the domain name of the web site that you wish to access. 

Toolbar 

Toolbar comprises of many buttons. Each button performs a specific function, when you 

click the mouse on it. Roles and functions of commonly used buttons are explained below. 

Button Name Action 

 
Back When you click the mouse on Back button, 

the web page, which was accessed, prior to 

the current web page gets displayed. 

 
Forward In normal circumstances, this button remains 

disabled. When you move back to any web 

page, (which was accessed previously) using 

"Back" button, Forward button gets enabled. 

When you click the mouse on it, it displays 

the next page, in the sequence. 

 
Stop When you access a web page, it gets 

transferred from web server to your computer 

(web client). When you click the mouse on it, 

transferring of web page stops. 

 
Refresh When you click the mouse on it, it reloads the 

current web page. 

 
Home When you click the mouse on it, home page 

that has been set for the web browser, gets 

displayed. 

 
Search This button provides means for searching the 

information on any desired topic on Internet. 
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Favorites

 

Favorites Internet Explorer maintains a folder, with the 

name Favorites. If you wish you can maintain 

links to all your favorite web pages/sites in 

this folder. 

When you click the mouse on this button, it 

provides easy access (within the browser) to 

favorite links, so that associated web pages 

could be re accessed. 

History

 

History Internet Explorer maintains a categorized list 

of the web sites that you visit. This list 

remains alive, for the duration set for the 

browser (a tunable parameter). When you 

click the mouse on this button, history list 

appears within the browser window. If you 

wish, you can again access any of the web 

pages, using this list. 

Link Toolbar 

Link toolbar consists of many buttons. Each button remains linked to web site or web page 

on Internet. When you click the mouse on any of the buttons, it takes you to the linked 

object. 

Status Bar 

Status bar is the place where, information related to current object, current web page or 

down loading appears.  

Now you are familiar with Internet and Internet Explorer, so let's make use of Internet 

Explorer to utilize different services of Internet. 

WEB SURFING  

Moving from one web site to another web site is called web surfing or web browsing. 

Perform following steps to access a web site: 

1. Get connected to Internet. 

2. Invoke Internet Explorer (using the process mentioned above) and get Internet 

Explorer window (illustrated in figure 12.5) on the screen. 

3. Enter domain name in address bar and press "Enter" key. 

When you do so, Internet Explorer will search the web site and if it gets it, it will display 

its first page, called opening page in the browser window. For example, if you access 

yahoo.com web site, its opening page, as shown in figure 12.6, will appear in Internet 

Explorer window. 
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Figure 12.6  

Refer figure 12.6 and note that web page contains few icons, a text box with button and 

many text items in it. Truly speaking, each icon and each text message is a link. When you 

click the mouse on any of the links, linked item or service gets displayed.  For example, 

there is a Mail icon in the upper portion of the web page. When you click the mouse on it, a 

web page offering e-mail service appears in Internet Explorer window. Similarly, you can 

click the mouse on other links to avail associated services. 

While traveling through links, if you wish to go to a specific web site, enter the desired 

domain name in address bar and press "Enter" key. If you do so, current service will get 

terminated and you will be taken to the opening web page of the mentioned web site. For 

example, if, while working with yahoo's e-mail service, you enter hotmail.com in the 

address bar and press "Enter" key, e-mail service will get terminated and opening web page 

of hotmail.com will get displayed in Internet Explorer window. 

SEARCHING CONTENTS ON INTERNET 

Internet is an ocean of information. Be it any topic, science, culture, entertainment, 

tourism, medical or aviation, volumes of information can be found on Internet. This 

information remains available on web sites and can be availed by visiting the web site 

Now the questions is, there are millions of web sites on Internet so how do you come to 

know, which information is available on which site and what is its domain name? Well, 

Internet itself provides solution for this problem. There are certain web sites, which provide 

search facility for searching the content on Internet. For example, yahoo.com is a web site, 

which provides search facility. Refer figure 12.6 and note that search facility remains 

available in the form of a text box and a button titled "Search" To get the information on 

any desired topic, perform following steps: 
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1. Enter the search term in text box. For example, if you wish to get the information 

on "Examination Taking Techniques" enter this term (called, search term) in the 

text box and click the mouse on "Search" button. 

2. When you do so, a program called Search Engine will search its information 

database and find the links to the information. Found links will get displayed in the 

form of a list, as shown in figure 12.7. In technical term, this list is called "Hit 

List". 

 

                  

Figure 12.7 

3. To reach the web site that contains the information, click the mouse on any desired 

link of the hit list. 

4. After reaching the web site, you can make use of browser's "Back" button, to get 

back to the hit list. 

5. Now click the mouse on another link to get more information on the same topic, but 

from another web site. 

Important Points Related to Internet Search 

Following are few important points that should be kept in mind, while searching the 

information on Internet: 

1. Different search engines provide different hit lists. Thus if the results of one search 

engine are not satisfactory, different search engines can be tried for better results. 

Hit List

Link (click the 

mouse on it to 

reach the web 

site)
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2. Search term plays an important role in the process of acquiring the information 

from the Internet so search term should be framed carefully. For example, you may 

wish to get information on life style of Gandhi ji. For this, if you use the search 

term Gandhi, you may get lot of irrelevant information, which may not be of any 

use to you. For example, links related to Gandhi park, Gandhi restaurant, Gandhi 

club etc. may appear in the hit list. But if you use the search term, "Gandhi life 

style", it is likely that you may get the desired information. 

 Other search terms, may also relate to same topic so they should also be tried, while 

searching the information. For example, search term "Gandhian Philosophy" may 

also, fetch the desired information. 

3. Two search terms can always be added, using logical operators like AND and OR to 

make the scope of the search more specific. For example, the search term "Flights 

to UK AND Flight to France" will yield wider results. 

4. If you wish to open many links simultaneously in distinct 

Internet Explorer windows then instead of clicking the 

mouse on any link of the hit list, right click the mouse on 

it. When you do so, a short cut menu, as shown in figure 

12.8 will appear on the screen. 

 Now click the mouse on "Open in a New Window" 

option. When you do so, a new Internet explorer window 

will appear on the screen and current web page will get 

loaded in it. 

 After this, you can click the mouse on the window that 

contains the hit list so that it comes in front and you can 

repeat the above mentioned process to display another 

web page in another window. 

INTRODUCTION TO E-MAIL  

E-mail is a service, using which you can send 

letters and documents to your friends and 

relatives. You can also receive reply from 

them over Internet within few seconds. For 

example, if a letter is sent from India to 

America by normal post, it takes around 15 to 

20 days. But if the same letter is sent, using e-

mail, it reaches America within 15 to 20 

seconds. On top of this, there remains no 

possibility of letter getting lost in the way.  

e-mail software remains available in 

different forms. Most of the commercial 

web sites provide the use of this software 

Figure 12.8 

 

Figure 12.9  
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free to their visitors. For example, yahoo.com, hotmail.com, rediffmail.com are the names 

of few web sites, which provide free e-mail services to their visitors. A web page offering 

e-mail service is shown in figure 12.9. If the visitors wish to avail e-mail facility of any 

web site then, once forever, they have to open an e-mail account on that web site. After that 

they are assigned a unique e-mail address. Using this e-mail address they can then send and 

receive letters.  

USING E-MAIL 

Following points should be kept in mind, before you make use of e-mail service:  

1. Your computer should be connected to Internet. 

2. You must have an e-mail account on a web site that provides e-mail facility.  You 

should know your e-mail login name and password. 

3. You should also know e-mail address of the person to whom you wish to send the e-mail.   

How do you create an e-mail account, how do you read the letters that you have received 

and how do you send the letters to others, is explained below. 

Note 

• As mentioned above, each web site provides an e-mail program of its own. E-mail 

program of one web site may differ from the program of other web site. It is not 

possible to explain the procedural details of each famous e-mail program in this 

book. The idea is to make you familiar with the general steps of operating e-mail. 

With this objective in mind, we have taken yahoo e-mail program as base 

program. All the steps for operating e-mail have been explained in relation to this 

program only. If you understand the basic idea, you will be able to operate all 

other programs, as well. 

• Note that the physical appearance of the web pages keeps on changing from time 

to time. It is quite possible that when you access the web sites, mentioned in this 

chapter, you may come across different appearances of the web pages. So it is 

essential that you should mainly focus your attention on procedures rather than 

on the appearance of the web pages. 

Opening An E-mail Account 

Perform following steps to open an e-mail account on yahoo.com: 

1. Connect to Internet and access yahoo.com. When you do so, a web page as shown 

in figure  12.6 will get displayed in browser window. 

2. Now click the mouse on "Mail" link. When you do so, a web page, as shown in 

figure 12.10, will appear in browser window.  

3. Now click the mouse on "Sign Up" link. When you do so, a web page, as shown in 

figure 12.11 will get displayed in the browser window. 
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Figure 12.10      Figure 12.11 

4. Refer web page shown in figure 12.11 and note that this is basically a form, which 

accepts details from the user for 

creating his account. Enter your details 

in each field. 

5. After filling the form, click the mouse 

on "Submit This Form" button (not 

shown in the figure, as it appears at the 

bottom of the web page. It will appear 

when you scroll the page.) When you 

do so, your e-mail account will be 

created and a web page, as shown in 

figure 12.12, will be displayed.  

6. After creating the account, yahoo 

sends a test mail into your account to 

confirm that mail transactions are 

taking place correctly in that account. 

To check your test mail (described 

above), click the mouse on "Continue 

to Yahoo Mail" button. When you do 

so, a web page, as shown in figure 

12.13 will get displayed in your 

browser window, showing you that 

you have one unread message in your 

account.  

7. Now you can either check your test 

mail by clicking the mouse on 

Inbox(1) link or exit from e-mail by 

clicking the mouse on "Sign Out" link. 

 

Figure 12.12 

 
Figure 12.13 
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Reading E-Mail 

Perform following steps for reading e-mail:  

1. Get connected to Internet and access yahoo.com, where you had created your e-mail 

account. When you do so, 

yahoo's first web page, as shown 

in figure 12.6, will get displayed.   

2. Now click the mouse on "Mail" 

link. When you do so, a web 

page, as shown in figure 12.10, 

will appear on the screen. 

3. Now enter your login name in the 

text box titled, "Yahoo ID" and 

password in "Password" text box. 

4. Now click the mouse on "Sign 

In" button. When you do so, a 

web page, as shown in figure 

12.13, will appear on the screen. 

5. If you wish to read the letters 

that you have received, click the 

mouse on "Check Mail" button. When you do so, a list of all the received letters 

will get displayed in the form of a web page, as shown in figure 12.14. 

Refer above-illustrated figure and note that the details of the received letters are displayed 

under different headings. Description and meaning of all the headings are as follows:  

 

    Title     Meaning 

  Sender  It signifies the name of the person who has sent the e-mail. 

  Subject This is the title of the letter, which gives an idea of the contents of the 

letter.   

  Date It specifies the date, on which the e-mail was received. 

  Size It signifies the size of the mail in Kilobytes. 

 

Note that in this list, certain titles are displayed in bold letters, while some of them are 

displayed in the normal. The title displayed in bold letters, signifies that this letter has not 

yet been read. On the other hand, the letters, which have been read, are displayed in the 

normal text. 

6. In order to read any letter, click the mouse on its title. As soon as you do so, the 

letter will get displayed on the screen and you will be able to read it. A sample 

letter that gets displayed in this way, is shown in figure 12.15. 

 

Figure 12.14 
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7. Refer figure 12.15 and note that 

there is a button titled as "Reply". 

This button, when clicked, allows 

you to send the reply of the letter, 

without coming out of the letter.  

8. If, after reading the letter, the letter 

is to be deleted from the inbox, 

select appropriate checkbox and 

click the mouse on "Delete" button.  

9. After reading the letter, if you click 

the mouse on "Back" button, you 

will return back to the Inbox, which 

is shown in figure 12.14  

10. To read any other letter from the 

inbox, click the mouse on the 

desired title and repeat the process described above. 

11. When you have read all the letters, select "Sign out" option.  

When you do so, you will exit from e-mail program. 

Sending E-Mail 

Perform following steps for sending e-mail to any user: 

1. Get connected to Internet and access yahoo.com. When you do so, yahoo's first web 

page gets displayed as shown in figure 12.6. 

2. Now click the mouse on "Mail" link. 

When you do so, a web page, as shown 

in figure 12.10 will appear on the 

screen. 

3. Now enter your login name in the text 

box titled "Yahoo ID" and password in 

"Password" text box. 

4. Click the mouse on "Sign In" button. 

When you do so, browser will display 

a web page, which is shown in figure 

12.13.  

5. Now click the mouse on "Compose" 

option. When you do so, a web page 

that facilitates you to write the letter, 

appears in browser window. This web 

page is shown in figure 12.16. 

6. Now enter e-mail address of the person to whom you want to send the mail in the 

 

Figure 12.15 

 

Figure 12.16 
Letter 

Writing Area 



 

 

Chapter 12 – Internet   229

text box, titled "To". Type the title of the letter in the text box, named "Subject". If 

you wish to send the copy of the same letter to other persons also,  click the mouse 

on "Add CC" link and enter their e-mail address in the text box named "Cc" with 

each address separated by a comma. 

7. If you wish to keep a copy of the letter with you so that you know what was sent to 

whom, select "Save copy" check box.  

8. Now type the contents of the letter in letter writing area. 

9. If you wish to attach any document with your letter (that is present on your disk), 

click the mouse on "Attach Files" button.  When you do so, you will be asked to 

specify the location and name of the document that you wish to attach. Specify the 

details, as per requirement. 

10. After entering the contents of the letter, click the mouse on "Send" button. This will 

transmit the letter to the desired address and you will get a message on your screen 

(in the form of a web page) that your letter has been sent.  

Exiting From E-Mail 

After finishing all e-mail related activities, you should come out of email program. For this, 

make use of "Sign Out" option.  

SENDING MESSAGES THROUGH CHAT 

Chat means talking. Chat service provides means for on-line communication with other 

Internet users. Using this service, two or more Internet users talk to each other, by typing 

their messages on their terminal. Whatever one-user types on his terminal, gets displayed 

on other user's terminal immediately. If other user wishes to react against this message, he 

types his reaction on his terminal. Now, whatever he types on his terminal, gets displayed 

on first person's terminal. Thus talking through typing can continue, till the time both the 

persons want.  

This is the most popular and widely used service of Internet. To make it more interesting 

and realistic, chat service is generally provided in the form of logical rooms. 

All rooms are generally related to a topic. For example, relationship, computers, friendship 

etc. It is possible that there may exist many rooms within a specified topic. For example, 

within computers there could be many rooms such as Hardware, Graphics, Multimedia, 

Virtual Reality, Internet etc. The basic objective of having topic-related rooms is to form a 

collection of people with similar interest so that chat may result into fruitful discussion and 

the number of chatters remain limited in a room.  

Chat is very common service of Internet. It remains available on most of the web sites. For 

example, yahoo.com, rediffmail.com, google.com, etc. are the names of few web sites, 

which provide chat service to their visitors. 

To make use of chat service, you have to first go to the web site of your choice, where you 

would like to chat. Now you have to open your chat account, if you have not yet opened it. 

When you open your chat account, you have to declare your profile (name, age, country e-
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mail address) and choose your chat name. Chat name is the name that you would like to use 

during the chat. The chat name could be different from your real name because you may 

not like to disclose your real name to chatters because of security and personal reasons. 

Generally people use those types of chat names, which qualify their properties or need. For 

example, softman, helpingman, jollyboy etc. are the names, which give an indication of the 

nature of the person. Similarly wanting-jokes, wanting-help, give-me-info are the names 

which clearly state the need of the person.  

After creating your profile, you can choose any chat room of your choice. When you enter 

the room, you will find many persons present there. Chat names of all the persons present 

in the room will be displayed on the screen. 

Now you can type your message or feelings on your terminal. Whatever you type on your 

terminal, will get displayed on the terminals of the persons who are present in the room. If 

someone wishes to talk to you, he will type his message for you on his terminal. That 

message will get displayed on everybody's terminal, including your. Thus you can keep on 

communicating till you or the other person wants.  

A chat session can be invoked through yahoo messenger. When you invoke chat session, a 

chat room, as shown in figure 12.17 gets displayed. 

 
Figure 12.17 

Refer above illustrated figure and note that all important components of chat web page 

have been labeled to give you an idea of chat dynamics and its operations. Using this web 

page, you can read the message sent by other people and you can also send your own 

messages. 

Chat also provides you the facility for sending personal messages to the desired persons. In 

such a case, your message gets displayed only on other person's terminal, not on 

everybody's terminal. Thus you can do some private talks. For this, you have to simply 
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double click the mouse on person's chat-name. When you do so, a message box appears on 

the screen. Whatever you type in this message box, gets transmitted as private message to 

other person. A similar type of message box appears on other person's terminal. The 

message sent by you (to him) gets displayed in his message box. Whatever he types in his 

message box, gets displayed in your message box. Thus chat continues in private mode and 

nobody comes to know what you are talking to other person. 

Some of the chat services provide you the facility to create your own private room. You 

can invite other chatters, in your room to talk privately. This saves you from other people's 

unwanted messages to appear on your screen. Thus you can have dedicated chat in isolated 

environment. 

OTHER SERVICES OF INTERNET 

As mentioned earlier, Internet is an ocean of information and services. Wide variety of 

services remain available on Internet. Whosoever wishes, can avail these services by 

visiting the website. Few popular services of Internet are described below.   

1. Internet telephony is a service that enables its users to communicate with other 

persons. Using this service an Internet user can ring other person's normal 

telephone. If other person picks up his phone, communication path between the two 

gets established and they talk in the same way as two telephone users do. This type 

of telephony is called Net-To-Phone telephony. 

2. News group is very popular service of Internet, in which a person has to become a 

member of a predefined group. Each group relates to a specific topic like wind 

surfing, multimedia, physics, video gaming, vintage cars etc. Members of the group 

exchange information, news, problems, solutions etc. among them. 

 Due to the categorization of group, likeminded people become the member of the 

group. This keeps the discussion inline and helps members in seeking solutions for 

their questions and problem from other group members.  

3. These are various web sites on Internet, which provide electronic greeting cards for 

all occasions and all reasons. These cards are generally very colorful, attractive and 

often animated. People access these web sites and send card to their friends and 

relatives. 

4. There are various web sites on Internet, which provide facility for reading 

newspapers, magazines and articles on Internet. 

5. Astrological web sites of Internet provide horoscope, future predictions and 

suggestions to the visitors, who visit the web site. 

6. There are various web sites on Internet, which provide job opportunities to the 

persons seeking job. They also help employers in searching the right candidate. 

7. Music, songs and radio can also be enjoyed over Internet. 

8. There are various web sites, which sell different kinds of products. These web sites 

can be visited and products can be purchased from there. These web sites are often 
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referred to as e-mall. Payment for the purchased items is made on-line through 

credit cards. 

9. Numerous, free and paid computer games are available on Internet. They can be 

downloaded and played. 

10. Advance booking in hotels, trains, aero planes etc. can be done through Internet. 

 

 

 

 EXERCISES                      CHAPTER 12 

 

Short Type Questions 

A.  Select most appropriate answer for following questions: 

1. In which type of network, computers are placed very near to each other? 

 (a)  LAN (b)  WAN  (c)  Internet  (d)  World Wide Web 

2. Which of the following is not the objective of computer network? 

 (a) Share data     (b) Share devices     

 (c) Exchange messages      (d) Share secret information. 

3. What name is given to those computers of Internet, which provide information and 
services to other computers? 

 (a) Web Client (b) Web Servers (c) Web Browsers (d) Web Sites 

4. Which of the following requires 24 hours connectivity to Internet through fast data 
communication lines? 

 (a) Web Client (b) Web Server (c) Both  (d) None 

5. How many numbers put together, constitute IP address of a web site? 

 (a) 2  (b) 3   (c) 4   (d) Any number  

B.  Fill in the blanks: 

6. LAN is  acronym for .......................   ............................ ........................... 

7. WAN is acronym for .......................... ............................. .................................. 

8. Network of computer networks is known as ........................................ 

9. ............................ is the software, using which Internet related activities are 
performed. 

10. ....................... is the  service of Internet, using which letters are exchanged over 
Internet. 
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C.  State, true or false for following statements: 

11. A computer network, in which its computers are placed in different cities, is an 
example of Internet. 

12. Internet Explorer is a web browser. 

13. The text, which displays another piece of text, when mouse is clicked on it, is called 
hypertext. 

14. Two or more web pages are linked together with the help of super links. 

15. abc.com.au is an example of American web site. 

16. The domain name xyz.com indicates that xyz is a commercial organization. 

17. Web clients get connected to Internet for short durations. They only take 
information from it and get disconnected. 

18. Chat is the service, using which two or more Internet users communicate with each 
other, by typing their messages on their computers. 

19. Users of e-mail service are identified by their login name and password. 

20. yahoo.com is a website, which provides search facility. 

D.  Answer the following questions in short: 

21. What name is given to the activity of visiting web sites? 

22. Which software is used for web surfing? 

23. Write a valid IP address. 

24. Which two words will be essentially there in the domain name of Indian government 
web site. 

25. Using which service of Internet, people seek advice, opinion, information and 
solutions for their problems? 

26. What is yahoo.com? 

27. Name any two famous services of Internet.  

28. What name is given to those computers of Internet, which take information from 
other computers? 

29. Name a website, which provides search facility. 

30. Is Internet an example LAN or WAN? 

E.  Differentiate between following: 

31. LAN and WAN. 

32. Web Server and Web Client. 

33. Chat and e-mail. 

34. Web Surfing and Web Browsing. 

35. Web Site and Web Page. 
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Detailed Answer Type Questions 

F.  Answer the following questions in detail: 

36. Define the term Internet. Name any three services of Internet. 

37. What is IP address? What it is used for? How it is constituted? 

38. What is domain name? Write general format of domain name. 

39. How do you search information on a given topic on Internet?  

40. What is e-mail? Write at least 2 advantages of e-mail. 

41. What is Internet chat? How it is different from news group? 

42. What is Internet Telephony? What advantage it has over normal telephony? 

43. What is web browsing? How do you perform it through Internet Explorer? 

44. Explain the term hypertext, by taking a suitable example. 

45. Write two advantages of Internet. 

  

PRACTICAL ASSIGNMENTS 

 

Assignment-1: Web Surfing 

1. Get connected to Internet 

2. Invoke web browser. 

3. Access yahoo.com web site. 

4. Click the mouse on any link present in the web page. 

5. Click the mouse on "Back" button present in browser window. This button will take 

you back to yahoo.com web site. 

6. Now click the mouse on another link, present in the page. 

7. Now enter excite.com in address bar and press Enter Key. This process will take you to 

another web site.  

8. Now right click the mouse on any link. When you do so, popup menu will appear on the 

screen. 

9. Select "Open in New Window" option. This will display web page in new window. 

10. Repeat above mentioned procedure for few other links present on excite.com web site. 

Assignment-2: Web Searching 

11. Get connected to Internet if you are not connected to it. 

12. Invoke you web browser. 

13. Go to google.com web site. It provides very popular search engine. 

14. Enter "Examination Techniques" in edit box and click the mouse on "Google Search" 

button. 

15. Access at least three links of hit list and compare the contents. 
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16. Go to excite.com web site. 

17. Enter "Examination Technique" in edit box and click the mouse on "Search" button. 

When you do so, another hit list will get displayed. 

18. Compare hit list of google.com with the hit list of excite.com. You will find some 

difference in them. 

19. Access some of the links present in hit list. 

20. Go back to yahoo.com, enter "How computer works" in search edit box and search will 

result into a hit list. 

21. Visit some of the links of this hit list. 

Assignment-3: Creating An E-Mail Account. 

22. Get connected to Internet. 

23. Invoke the web browser. 

24. Go to yahoo.com web site. 

25. Click the mouse on mail link. 

26. Create a new e-mail account for yourself. 

27. Recall that procedure for opening an e-mail account is given in this chapter. 

Assignment-4: Reading e-mail 

28. Get connected to Internet. 

29. Invoke the web browser. 

30. Go to yahoo.com web site. 

31. Click the mouse on mail link. 

32. This will take you to login web page. 

33. Enter your login name and password. 

34. Read the test mail received into your account. 

Assignment-5: Sending e-mail. 

35. Get connected to Internet. 

36. Invoke the web browser. 

37. Go to yahoo.com web site. 

38. Click the mouse on mail link. 

39. Enter your login name and password. 

40. Opt for "Compose" option. 

41. Write a letter to your friend, saying that you are master of Internet now. 

42. Attach a picture with this letter. 

43. Send the letter to your friend. 

 
**** 



UNIT - VIII 

 

 

 

 

 

Concept Of Programming   

INTRODUCTION 

You know that computer requires program for everything that it does. Program is basically 

a group of instructions written in computer language for performing a specific task. For 

example, instructions written in computer language to swap the two given numbers will be 

a program. Similarly instructions written in computer language to find out the roots of a 

quadratic equation will be another program. Likewise you can have program for other 

problems. 

Now the question is how do you write program?  Do you simply translate spoken English 

sentences into computer languages to build a program? Will, the sentence, "Swap the two 

numbers" translated into computer language, form number swapping program? Well, the 

answer is no. This is not programming. Programming is a process, in which the solution of 

the problem is framed, in light of all those activities, which computer can perform. For 

example, computer cannot perform the command "print largest number out of given two 

numbers". But it can certainly read numbers, compare them and print the given number. 

Thus to print the largest number, out of given two numbers, following steps will have to be 

performed: 

1. Read first number. 

2. Read second number.  

3. Compare the two numbers. 

4. If first number is greater, print it else print second number. 

Now the question is are these four steps a program for printing the largest number out of 

given two numbers? No, these steps are not program. They are basically framework of 

program. This framework is often called algorithm. When each step of algorithm is 

translated into a computer language, it is called program. The process of writing 

instructions in computer language, to solve a problem, is called coding. The person, who 

does coding, is called computer programmer. 

13 CCCCHAPTERHAPTERHAPTERHAPTER    
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ALGORITHM 

Algorithm is basically a step-by-step solution for solving a given problem. When solution 

is sought for solving the problem through computer, all the steps are framed in the light of 

basic operations that computer can perform. What computer can do is described below. 

WHAT COMPUTER CAN DO 

Basic operations that computers can perform are very limited. These operations are: 

1. Read data 

2. Write data 

3. Make comparison 

4. Create variables and assign values to them 

5. Do processing 

6. Loop formation 

An introduction of all these activities is given below. 

Read Data 

Computer can read the data from three sources i.e. either from program itself or from the 

keyboard or from data file. It totally remains on the discretion of the programmers to select 

the source from where the data will be fetched in the program. All the programming 

languages provide commands for reading the data from all the three sources. 

Write Data 

Computer can display data and print it too. Data can either be printed on printer or in a file. 

All the programming languages provide commands for all these activities. 

Make Comparison 

Computer can compare only two given values at a time. For example, if A and B are two 

given values then it can make comparisons like "IS A>B", "IS A<B", "IS A=B" etc. 

The result of comparison is either true or false. If the given condition holds good, the result 

of comparison is true. On the other hand, if the condition doesn't hold good, result is false. 

For building the conditions, following types of operators are used: 

Conditional Operators 

Sign Meaning  Sign  Meaning 

= Equal to >= Greater than or equal to 

> Greater than <= Less than or equal to 

< Less than <> Not equal to 
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Relational Operators 

OR Joins two conditions and gives true if either of the condition is 

true or both of them are true. In all other cases it gives false. 

AND Joins two conditions and gives false if either of the condition is 

false or both of them are false. In all other cases it gives true. 

NOT If the condition is true, it gives false. If it is false, it gives true. 

 

Create Variables And Assign Values 

Variables can be defined as memory locations, which are assigned a name for reference. 

For example, Number1=0 means Number1 is a variable whose value is 0. Similarly 

Pay=10000 means Pay is a variable, which holds 10000 in it. 

Note that in   computers, statements like Pay=Pay+1000 are used. Statements of such type 

are algebraically wrong but in reference to computer, they are correct. This statement 

simply increases current values of Pay variables by 1000. For example, if its value was 

10000 then after execution of this statement, it will become 11000. 

Do Processing 

Computers can do calculations. Calculations that they do are called processing. For 

processing, computer languages provide following operators: 

Operator  Meaning Operator  Meaning 

+  Addition        /       Division 

-  Subtraction        *       Multiplication 

^  Raised to the power of       ()       Brackets 

(Exponentiation)    

 

Loop 

Computer can process a single or more steps repeatedly. When it does so, it is said that a 

loop has been formed. Following is an example of loop: 

1. A=0 

2. B=A+10 

3. Display B 

4. Repeat Step 2 and 3, 4 more times. 

Here step 4 forms a loop and makes a provision that the value of B gets increased and 

displayed five times. 
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CHARACTERISTICS OF AN ALGORITHM 

Following are the characteristics of algorithm: 

1. Algorithms always have a definite starting point and an end point. These points are 

generally marked with the words like Start, Begin, End, Stop etc. 

2. They consist of finite number of steps. 

3. They always relate to a specific problem or you can say that they are written for a 

given problem. 

4. They serve as foundation stone for programming. 

5. They are written in easy language. Their sentences are always unambiguous and are 

easy to understand. 

WRITING ALGORITHMS 

You are now familiar with algorithm and their characteristics, so let's write few algorithms 

for following problems: 

Problem-1 

Let's write algorithm for swapping contents of two variables. 

Algorithm-1 

1. Start 

2. Read value of A 

3. Read value of B 

4. C=A 

5. A=B 

6. B=C 

7. Print A 

8. Print B 

9. End 

This algorithm makes use of intermediate variable C. It holds value of A in it, temporarily 

and later assigns it to B variable. Thus values of variable A and B get interchanged. 

There is another way of interchanging the values i.e. without making use of intermediate 

variable. Algorithm for it is given below. 

1. Start 

2. Read value of A and B 

3. A=A+B 

4. B=A-B 

5. A=A-B 

6. Print A, B 

7. End 
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Problem-2 

Let's write an algorithm to find the largest of given three numbers. 

Algorithm-2 

1. Start 

2. Read three numbers A, B and C 

3. Let Big=0 

4. IF A>B Then Big=A Else Big=B 

5. IF C>Big Then Big=C 

6. Print Big 

7. End 

Problem-3 

Let's write an algorithm for calculating and printing factorial of a given number. 

Algorithm-3 

1. Start 

2. Read a number, A 

3. Let I=1 

4. Let Sum=1 

5. Sum=Sum*I 

6. I=I+1 

7. If I is not > A perform step 5, 6 and 7 

8. Print Sum 

9. End 

Problem-4 

Let's write an algorithm for solving a given quadratic equation, ax
2
+bx+c=0. Note that 

roots are determined by following formula: 

a

acbb
x

2

42
−±−

=  

Algorithm-4 

1. Start 

2. Read value of a, b and c 

3. If a=0    Stop 

4. Calculate values of discriminant D=b
2
-4ac 

5. If D=0 then there is one root p=-b/2a 
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6. If D>0 then there are two real roots 

      b+√D and        -b-√D  

        2a        2a 

7. If D<0 then there are two complex roots 

     -b+i√-D and         -b-i√-D 

        2a        2a  

8. Print p and q 

9. Stop 

PROBLEMS WITH ALGORITHMS 

As mentioned earlier, algorithms are written in English like sentences. Sentences are 

always subject to misinterpretation. 

If the sentence is complex, different readers may interpret it differently. This definitely 

leads to problems at the time of coding. 

To overcome this problem, often the solution of the problem is provided in pictorial form. 

Pictures carry more meaning and don't lead to ambiguity. Such type of step-by-step solution, 

provided in pictorial form is called flowchart. Details of flowchart are given below. 

FLOWCHARTS 

When a step-by-step solution of a given problem is illustrated in the form of graphical chart 

that chart is called flowchart. 

FLOWCHARTS SYMBOLS 

Flowchart is a universal tool, using which solution providers communicate the solution of a 

given problem to the programmers so that they can translate the steps (of flowchart) into 

computer language and transform it into a computer program. To make the process 

universal and unambiguous, symbols of flowcharts have been standardized. These symbols 

and their meaning are explained below. 

Read 

A parallelogram is used 

to depict reading process 

in the flowchart. To 

make the process more 

illustrative, the word "Read" is written along with variable names, within the 

parallelogram. For example, the word "Read Pay", written within the parallelogram states 

that value of Pay has to be read and stored in Pay variable. Similarly "Read Number" states 

that a number has to be read and the value has to be stored in a variable named, Number. 

Use of read symbol is illustrated in figure 13.1. 

Read Pay Read Pay, Da, Ada
 

Figure 13.1 

p = q = 

p = q = 
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Often multiple values have to be read one after the other. In such cases, instead of making use of 

multiple read symbols and making the flowchart lengthy, one read symbol is used and names of 

all the variables are written in it. This is illustrated in last symbol of figure 13.1. 

Write 

In flowcharts, 

parallelogram is also 

used to depict writing / 

displaying process. To 

make the writing process more illustrative, the word Write, along with names of the variables 

(whose values have to be printed / displayed) are written within the parallelogram. Use of write 

symbol is illustrated in figure 13.2. 

Values of multiple variables can also be displayed / printed, using single symbol, as 

illustrated in figure 13.2. 

Condition Checking / Decision 

Symbol shown in figure 13.3 is used for depicting comparison of two values or condition 

checking or decision-making etc. The condition that is to be checked is written within the figure. 

It is quite obvious that whenever a condition will be checked there will be two outcomes 

i.e. either the condition will be true (condition holds good) or it will be false (condition 

doesn't hold good). 

These two outcomes are 

shown as two branches 

coming out of the symbol. To 

clearly illustrate, which 

branch relates to true and 

which branch relates to false, the words Yes (or Y or True or T) and No (or N or False or F) 

are written near the branches. This process is illustrated in figure 13.3. 

Processing 

In flowcharts, processing or calculation 

activities are depicted, using a rectangle. To 

make the process more illustrative, 

calculations that are being done are written within the rectangle. The use of processing 

symbol is illustrated in figure 13.4. 

Start 

Like algorithm, flowchart must have a definite starting point. Starting 

point of the flowchart is depicted through a flat oval shape symbol, as 

shown in figure 13.5. To make the symbol more illustrative, the word 

"Start" is written within the symbol, as shown in figure 13.5. 

Is
Age > 187

?

Is
Religion=”h”

?

No

Decision Symbol

NoYes Yes

 
Figure 13.3 

Print Pay Print Pay, Da, Ada
 

Figure 13.2 

A = 10
B = 20
C = A + B

Area = L * W

 
Figure 13.4 

Start

Figure 13.5 
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End 

Like algorithm, flowchart must have a definite end point. End point of 

the flowchart is depicted through a flat oval shape symbol, as shown in 

figure 13.6. To make the symbol more illustrative, the word "End" is 

written within the symbol, as shown in figure 13.6. 

Flow Lines 

Joining many symbols together makes a flowchart. As you know, each symbol of the chart 

represents an activity. Which activity will be conducted after which activity, is depicted 

with help of flow lines. A flow line is a simple line with an arrow at its front end. The head 

of the arrow depicts the direction of flow. Flow lines are illustrated in figure 13.7. 

For example, if the third step is connected to seventh 

symbol, using a flow line, it will indicate that after 

executing third step seventh step is to be executed. Step 

four, five and six are not to be executed in this case. 

An up arrow is used for depicting a loop in the 

flowcharts. For example, if fifth step is connected to 

the third step, using an up arrow flow line, it will 

mean that after executing fifth step, third step is to be executed again. Note that this is 

nothing but a loop. 

Connectors 

Some of the flowcharts may turnout to be quite 

long. They may extend over many pages. Now the 

question is, how do you connect the processes, which are either far apart or are off the 

pages? For such type of requirements, two types of connectors are used. One is called same 

page connector and another is called "Off Page Connector". Both the connectors are shown 

in figure 13.8. 

Predefined Process 

If the problem to be solved is long then by 

showing all the steps in the same 

flowchart may make the chart complex. 

To avoid the complexity and keep the flowchart simple, you have to decompose the problem. In 

decomposition, you identify the group of mundane routines, such as initialization of variables 

etc. and the routines, which are repeatedly required. For example, printing the header lines, 

calculating a value based on certain formula etc. are the tasks that have to be performed 

repeatedly. You draw a flowchart for these processes separately and declare them as predefined 

processes and assign them name for reference. In the main flowchart, instead of writing all the 

steps, you simply include the symbol of predefined process along with the name. Whenever one 

wants to go into the details of predefined process, he refers corresponding chart separately. The 

symbol and use of predefined process is illustrated in figure 13.9.  

Predefined 
process
symble

Print head
Initilize 
variablels

Ph IV

 

Figure 13.9 
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Figure 13.7 

A B

Same Page Connector Off Page Connector  

Figure 13.8 

End
 

Figure 13.6 



 

 

244    Computer Application For Engineering 

Note that each process has a unique name. With the help of name you identify the process 

and refer it in the flowchart. In figure 13.9, we 

have shown two predefined processes with the 

name “PH” and “IV”. 

From the description of flowchart, given above, it 

is quite clear that flowchart is nothing but a 

graphical representation of the solution for a given 

problem, in which you make use of standard 

graphical symbols and within the symbol, you write 

the details of the operation. For communicating the 

details of the activities of a particular step, you 

have to include some text within the symbol. For 

this, you have to often make use of different types 

of operators. A list of arithmetic, relational and 

conditional operators is given in algorithm section. 

DRAWING THE FLOWCHART 

Now you are familiar with flowchart definition 

and flowchart symbols, so let's draw few 

flowcharts for given problems. 

PROBLEM-1 

Let's draw a flowchart for swapping the contents of two 

variables. 

Flowchart for this problem is illustrated in figure 

10.10(a). Note that this flowchart makes use of 

intermediate variable, C to interchange the values of 

two variables A and B.  

This flowchart can be redrawn to depict the method, 

which doesn't make use of intermediate variable. Such a 

flowchart is illustrated in figure 13.10(b). 

PROBLEM-2 

Let's draw a flowchart to find the larger of the three 

given numbers. Flowchart for this problem is illustrated 

in figure 13.11. 

PROBLEM-3 

Let's draw a flowchart for calculating and printing 

factorial of a given number. Flowchart for this problem 

is illustrated in figure 13.12. 

 

Start

Input A, B

C = A

B = C

A = B

Print A, B

End

Start

Input A, B

A = A + B

A =  A - B

B =  A - B

Print  A, B

End
 

(a)   (b) 
Figure 13.10 

Start

Input A, B, C

L = A

Print L

L = B

L=  C

Is
A>B
?

Is
C  > L
?

End

No

No

Yes

Yes

 

Figure 13.11  
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Start

Input  N

I = 1

X = X * I

I = I +1

X = 1

Print X

Is
I = N
?

End

No

Yes

                 

Start

Input A, B, C

Input P

Input Q

D = B^2 - 4ac

Q = -b /2a

P = -b+   D  /2a

P = -b+i   -d  /2a

Q = -b-i   -d  /2a

Q = -b-   D   /2a

Is
A= 0
?

Is
D= 0
?

Is
D= 0
?

End

No

No

No

Yes

Yes

Yes

 

 

      Figure 13.12                 Figure 13.13 

Problem-4 

Let's draw a flowchart for solving a given quadratic equation ax
2
+bx+c=0. Flowchart for 

this problem is illustrated in figure 13.13. 
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DIVIDE AND CONQUER STRATEGY 

Divide and conquer strategy suggests that a large or complex problem, should always be 

broken down into multiple smaller problems and each problem should be dealt individually. 

It is always easier to handle many smaller problems rather than one large problem. In 

addition to this, if suggested solution has some errors then finding errors and fixing them is 

also easy in case of smaller problems. In short, the thumb rule is, "Small Is Manageable, so 

Make Many Smalls and Manage Them". 

To understand the concept, let's take an example of a large and complex problem and 

handle it, using divide and conquer strategy. 

Say we have to calculate the net pay of the employee. Rules for calculating the pay are as 

follows: 

1. Employee is given some amount of basic salary. 

2. In addition to his basic salary, he also gets DA. DA is calculated @150% of his 

basic salary. 

3. Employee also gets few other benefits, as follows: 

(a) CCA (City Compensatory Allowance) @ 20% of basic pay. 

(b) LTC (Leave Travel Concession) @ 15% of basic pay. 

(c) CA (Conveyance Allowance) @ 7% of basic pay. 

(d) HMA (House Maintenance Allowance) @ 5% of basic pay. 

4. Apart from above mentioned earnings, some deductions are also made from 

employee's salary. Deductions are made as per following rules: 

5. WA (Welfare Amount) is deducted @2% of basic pay. 

6. IT (Income Tax) is deducted @5% of the total earning i.e. 5% of (basic pay + DA + 

Sum of all benefits – WA) 

7. Net salary is calculated by adding all the earnings and deducting all deductions 

from it (i.e. Basic salary + DA +benefits - WA- IT). 

Note that this problem is lengthy and bit complex also. If it is treated as single large 

problem, there may be difficulty in handling the problem. On the other hand, if divide and 

conquer strategy is applied and the whole problem is fragmented into small units, it can be 

handled easily. 

To handle this problem in divide and conquer manner, we will have three modules. First 

module will be the main module, which will take care of primary activities. Other two 

modules will handle benefit calculation and income tax calculations. This strategy is 

applied in the given flowchart, show in figure 13.14. 
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Start

Input  BPAY

DA  = BPAY * 1.5

NETPAY =  GROSSPAY - (WA - ITAX)

Do Benefits 

Itax Calculation

GROSSPAY =  BPAY + DA + BENEFITS

WA  =  BPAY  * 0.02

BNF

ITX

Print NETPAY

End
           

CCA = BPAY * 0.2

CA = BPAY * 0.07

LTC = BPAY * 0.15

HMA = BPAY * 0.05

BENEFITS = CCA + LTC +  CA + HMA 

BNF

Retur

TEARN = (BPAY + DA + BENEFITS) - WA

ITAX = TEARN * 0.05

ITX

Retur
 

Figure 13.14 

 

EXERCISES                      CHAPTER 13 

 

Short Type Questions 

A.  Select most appropriate answer for following questions: 

1. Which of the following describes algorithm in best possible way? 

 (a) Solution of a problem          (b) Best solution of a problem 

 (c) Solution of a problem in simple sentences     

(d) Solution of a problem in simple and unambiguous sentences 
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2. Which of the following doesn't hold good for algorithm? 
(a) Should have a definite starts point 
(b) Should always present the most efficient solution 

 (c) Should be written in simple sentence  
(d) Should have a definite end point 

3. Which of the following cannot be included in an algorithm? 

 (a) Reading data            (b) Selecting one choice among may available 
 (c) Comparison of two numbers         (d) Processing 

4. Which of the following is an example of variable creation? 

 (a) a=100 (b) a<100  (c) a=<100    (d)  a>=100 

5. If A is true and B is false then what will be the result of A and B? 

 (a) True    (b) False 

 (c) Depends upon other things (d) None of the above 

6. If A is true and B is false then what will be the result of A OR B? 

 (a) True    (b) False 

 (c) Depends upon other things (d) None of the above 

7. What is graphical representation of the solution of a given problem, called? 

(a) Algorithm    (b) Flowchart (c) Icon (d) Wizard 

8. What does a parallelogram in flowchart represent? 

 (a) Read    (b) Process  (c) Start (d) Condition evaluation 

9. What does an oval sign represent in a flowchart? 

 (a) Start    (b) End 

 (c) Both of the above   (d) None of the above 

10. To show a=100  *No + RT in flowchart, which symbol will be used? 

 (a) Rectangle    (b) Parallelogram 

 (c) Diamond shape   (d) Oval shape 

B.  Fill in the blanks: 

11. Getting the value of age will be depicted as ....................... activity in algorithm. 
12. Is a>b will be shown as ................ in flowchart. 
13. First line of an algorithm always starts with ..................... 
14. Last line of algorithm is always,  .......................... 
15. If A=10 then A=A+10 will make the value of A, ......................... 

C.  State, true or false for following statements: 

16. Before writing an algorithm, the problem has to be studied in detail. 
17. Algorithm is always related to a problem. 
18. Algorithm is always written in terms of basic activities that computer can perform. 
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19. Three outcomes of a given condition can be shown in a flowchart. 

20. OR operator gives false only if all the associated conditions are false. 

21. Flowchart is a pictorial representation of algorithm. 

22. Read and write activities in flowchart are depicted using same symbol. 

23. Processing activity in flowchart is depicted, using a square shape. 

24. Loop in a flowchart is depicted using up arrow line. 

25. Divide and conquer strategy fragments the complete flowcharts into many 
predefined processes.  

D.  Answer the following questions in short: 

26. Name the basic activities of computer, using which algorithms are written. 

27. How will the condition, "Is A>B and B<C" be depicted in flowchart? Draw the symbol. 

28. What will be written in algorithm, if the three steps 6, 7 and 8 are to be performed 10 times? 

29. What will be the outcome of NOT A if A is false? 

30. In which condition OR operator gives false? 

31. In which condition AND operator gives false? 

32. Draw the symbol, which will illustrated a=b+c statement. 

33. Draw the symbols that are used for on page and off page connectors, in flowcharts. 

34. Draw the symbol that is used for illustrating predefined process in flowcharts. 

35. How loops are depicted in flowcharts? 
 

Detailed Answer Type Questions 

E.  Answer the following questions in detail: 

36. What is algorithm? Write at least three characteristics of algorithm. 

37. Write an algorithm for checking if the given number is an even number or odd number. 

38. What are the similarities between algorithm and flowcharts? 

39. Write an algorithm for converting feet into centimeters. 

40. Write an algorithm to generate the sum of all even numbers starting from 1 to 100. 

41. What is flowchart? How it is different from algorithm? 

42. What is the use of predefined process symbol that is used in flowcharting? Explain 
with example. 

43. Draw a flowchart to accept a number and print "Even" if it is an even number and 
"Odd" if it is an odd number.  

44. Draw a flowchart to calculate and print the sum of following series: 

12+22+42+162 

45. What is divide and conquer strategy? Explain using a suitable example. 

  **** 
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